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1.0 Introduction 

The technology-triggered paradigm shift in the delivering of 

goods in the libraries is a phenomenon of the past one to two decades. 

These developments are principally digitization and related issues like 

online journals and their management; communication skills 

including technical writing, e-publishing, Web page hosting; 

institutional repositories, metadata standards, copyright issues; 

consortia approach and cooperation/sharing; networking, storage 

solutions, knowledge management, automation and standardization, 

and the like. 

The Web has been playing a very crucial role in communication 

and delivery of information.  The latest in this filed has been 

application of Web 2.0 and Web3.0.  Web 2.0, also known as Library 

2.0, is user-centred Web, where blogs, wikis, social networks, 

multimedia applications, dynamic programming scripts are being used 

for collection, contribution and collaboration on the Web. The 

underlying principle is ‗share the resources collectively‘. Emergence 

of Web 2.0  has placed in the hands of Librarians new  tools in 

modernizing library services.  

Web 3.0 is knocking at the door! Web 3.0, also known as semantic 

Web, is smarter and can understand what you want. The searcher no 

longer needs to wade through a plethora of information  or filter out 

search results but gets the target information straight by working on a 

combination of information based on his requirement as he 

understands and preferences he wants i.e. one needs to be less specific 

and more natural with his queries. This technology should aid the 

users obtain answers faster and accurately.  

 
  

  

 

1.1  Objectives 

After reading this Unit you will be able to:  



 have a grasp of various purposes /reasons for creation  Web 

sites    

 gain good knowledge of what a Web site is, including the latest 

developments in the field 

 learn the ‗how‘s‘ and ‗ways‘ of creating a functional Web site   

 

1.2 Web: An Overview  

      The Web is another very powerful communication mode of recent 

origin. It has turned out to be an increasingly important resource of 

encompassing all conceivable aspects of human life like business, 

education, entertainment, governance, personal life, health and what 

not.     

      Web sites are hosted by anyone including individuals, 

organisations, business enterprises, and voluntary organisations etc. 

who have an interest in telling the world about themselves or about 

their products/services.  

While most Web sites are free, some are fee-based 

(subscription-based). In case of the latter, the accesses to some or all 

of the contents are restricted by pass -word. Such include business, 

academic journal, and entertainment Web sites. 

     Considering the vast range of entities involved, Web sites can be 

generally categorized as: 

 Personal Web sites  

 Commercial Web sites  

 Organisational including government and non-profit 

organization Web sites, and   

 Entertainment Web sites  

      1.2.1 Personal Web sites 

An individual can keep in touch with his close ones, seeks jobs 

or  expresses himself  through a Web site. Web pages are also means 



of not only sharing but also finding out about other individuals, their 

culture, interests and life. 

 

      1.2. 2  Business Web sites 

Business / commercial enterprises make good use of the Web to 

promote their business. They publish their products /services to 

millions of potential customers globally and at no extra cost for the 

additional target audience that emerge from time to time. It is done 24 

hours a day, seven days a week in various languages as they choose. 

Unlike print materials the Web pages put into use multimedia and that 

too  in colour at no extra cost.  They can update prices, and the latest 

news, faster, easier and at much cheaper rate compared to brochures/ 

leaflets traditionally used.  Web pages of other/ similar products or 

advertisers or advertising campaigns can be linked to their pages.  The 

Web is also used as an extra outlet for sales.  Web sites place all, big 

or small, on equal footing as the reach of one‘s Web is as good as that 

of any competitor.  

The business/commercial Web sites are freely accessible to all. 

However, they needn‘t be so, if so wished. They can be restricted by 

use pass-word. Those that are on private networks are invariably 

inaccessible to outsiders.  

 

 

1.2.3 Organisational including Government and Non-profit 

Organization Web Sites 



Organizations, including governmental or volunteer groups, use 

the Web to promote their causes like education, social issues, health 

or for that matter any filed conceivable. For instance, let us take the 

case of the M. P. Bhoj (Open) University whose objective is 

promotion of education.  It  uses its Web site to reach out to the 

students, their parents, and teaching and staff community. The Web 

page functions as a much superior and cheaper alternative to the 

brochure informing about the university, location, organizational 

structure, centres/departments, and programmes.  The latest news 

pertaining to exam results, time-table, admissions, convocations, and 

circulars to staff are made available on its Web site. Advertisements 

and tender notices find the Web as the most favourite location which, 

at times, provides for applying online.  

The public relations activities are also carried out through the 

Web. The V. C‘ message, photo galleries, contact detials, Frequently 

Asked Questions (FAQs), information on collaboration  with other 

organizations are some instances of public relations activities that 

appear on the site.  Links provided useful or allied sites lead a user to 

similar  or related services provided by other organisations. It has also 

provided access to University‘s  digital library, classroom teaching, 

video lectures, audio lectures and  study materials. Besides, the 

information on the site  can be  browsed in more than one   

language.  Thus the advantages of  Web site vis-a-vis the traditional 

print system is tremendous.   

      1.2.4 Entertainment Web sites 

 Entertainment sites are heralding an important development in 

the Web field as it is very often seen as the only reason for  people, 

especially the youth,  to use the Web. These may be cinemas, games, 

music, humour pages and the like. For this reason entrainment sites 

are deemed as the most demanding ones.  

1.3 What is a Web Site?   

      According to Wikipedia a Web site is a collection of related Web 

pages, images, videos or other digital assets that are addressed 

relative to a common Uniform Resource Locator (URL), often 



consisting of only the domain name, or the IP address, and the root 

path ('/') in an Internet Protocol-based network. A Web site is hosted 

on at least one Web server, accessible via a network such as the 

Internet or a private local area network.  

Web site is a site or set of files stored on the World Wide Web. 

It is viewed with a browser like Microsoft Internet Explorer, Firefox, 

Safari or  Netscape. Each Web site contains a home page (the main 

page which users see when they enter the site) and additional 

documents and files. The sites are owned and managed by individuals 

or organisations or companies to promote their interests. 

 

The pages of a Web site can usually be accessed from the 

homepage or otherwise called Uniform Resource Locator (URL). The 

browser (the user‘s application to access homepage)    

with help of HTTP (the communication mode/programme to access 

files that are stored in the Web page) transfers  and displays  the page 

content according to its HTML markup instructions ( on how the 

structured data/text should be presented)  onto a display terminal. The 

user, thus, gets  the view of the web content/pages.   

        All publicly accessible Web sites collectively constitute the 

World Wide Web, commonly known as the Web (and abbreviated as 

WWW or W3) 

1.3.1 Internet and Web 

      Many tend to use the terms ‗Internet‘ and ‗Web‘ interchangeably.  

The Web (like e-mail and ftp) is but one way of making use of 

Internet.  Internet is the connecting means to Web, and Web site is 

store of information which is connected to and shared through the 

means of Internet.  

In other words, the www is one way information can be shared. 

The main difference between Web, e-mail, and ftp is that they all 

have their own protocols (Protocols mean a set of programmes/mode 

of communication). What makes Web stand out vis -a -vis other 



protocols is that it can easily link one document to another  and their 

links form a huge ‗Web of connected information‘. 

The  Web is  capable of  linking  texts and materials stored 

elsewhere in the Internet.  For example, let us take the Web page of 

IGNOU. While clicking on ‗Schools‘ in the main page  you are taken 

to another page in the same Web site listing different schools and 

again by clicking on a particular school, you are led to the page of the 

school in question.  Click on ‗Regional Web sites‘ and you are led to 

Web servers  (thereby Web sites) of regional centres located in 

various parts of India. Thus the links connect you to innumerable 

texts, audio and visuals, and multimedia. (It would appear like a huge 

spider‘s Web. From this simile the Web has derived its name). 

1.3.2 Fundamentals of Web 

      The fundamentals of working of a Web are knowledge of HTML, 

role of server and importance of the browser 

      HTML (Hypertext Markup Language) is a computer language 

that describes how a page/text should be formatted/presented in the 

Web site. It provides a means to create structured documents by 

denoting structural semantics for text such as headings, paragraphs, 

lists, links, quotes and other items.  

Many ‗languages‘ with varying complicities have evolved later to 

HTML for creation of Web sites. However, HTML will suffice to 

creation of good Web sites.  The knowledge of others will be required 

when you intend to create more complex web designs. 

      We access the Web pages from the Web server(s) using a 

programme called Web browser (like Microsoft Internet Explorer, 

Firefox, Safari or  Netscape). On your making a request (search), the 

Web browser (with help of HTTP: the  communication 

mode/programmes  to access any files that are stored in the 

Webpage) collects and assembles  files from one or more  Web 

servers (could be hundreds at times) into one page in your machine. 

(And this is how you see many pages of sites on any search you make 

on any subject).  



To illustrate, let us take the case of collecting information about 

location of Madhya Pradesh Bhoj (Open) University. There are two 

situations: one is when  you do not know the Web site name (url) -  

you make a search on a browser and will be provided with a list of  

servers from which you select the right one (by double clicking) to get 

the pages opened for information. The other is when you know the url 

- you enter it: 

http://www.bhojvirtualuniversity.com/univ/location.html or click on 

the link. The browser contacts the MOBU Web server indicated by 

the name (bhojvirtualuniversity.com) in the url requesting for the 

specific file. 

On executing the search for location, the Web server {of the MP 

Bhoj (Open) University} searches for the file  (univ/location.html) 

and returns it to the  browser. The browser, in turn, displays the 

document in its window  (according to the  formatting specified in the 

documents‘ HTML tags).  The browser will contact the server again 

for each graphic (identified by <img>) separately. (In the present 

example there are  two graphics, one of the building and the other a  

sketch of the building). Each graphic stored in different files are sent 

individually and assembled into the final page by the browser. All 

these activities (transfers and assembling) take seconds to accomplish 

and you will not feel a difference. (Of course, in case of slow 

connection, large graphic files lag behind the rest of the pages  and 

takes time to fully display)  

      The Web Server is a computer that holds and serves a Web site. 

The Web server includes the hardware, operating system, Web server 

software, TCP/IP protocols and site content (Web pages, images and 

other files). Using the HTTP protocol, the Web server delivers Web 

pages to browsers. If the Web server is used internally within an 

organization and is not exposed to the public, it is an ‗intranet 

server‘ and if it serves to external machines (outside the organization) 

it will be called an ‗Internet (Web) server‘. 

 

1.3.3 Static and Dynamic Web Sites 



      In static Web site the information is displayed in the same format 

as they are stored in the server. Such information is primarily coded in 

HTML (and the address ends in .htm). Most of the Web sites are static 

as they present pre-defined, static information, in the sense the pages 

retrieved by different users at different times remain the same. To 

make a change to the content, the files need to be manually opened, 

data  changed and the new version should be  uploading to the Web.  

      Dynamic Web site pages are ones that retrieves fresh information 

each time you view (like the latest news you see or various games you 

play on the Web). How one retrieves examination at MPBOU site 

may cited as an example. The ‗Examination Results‘ button at 

www.bhojvirtual university.com/ can be described as dynamically 

built because it supplies different information (marks) to different 

students when the candidates search by entering their enroll numbers.  

The information, in fact,  doesn‘t come from html pages but from 

databases (which may be updated minute by minute, day  or week).  

Another example familiar to all is the ‗seat availability‘ facility 

in the Indian Railways Web site. The information on seat availability 

is likely to change every second on fresh reservation or cancellation 

of reservations.  Here, the data in the railway reservation database are 

updated in real time and the site /browser retrieves the latest status as 

a response to your search. Hence the information is called dynamic. 

And at times the dynamic Web sites are called ‗data driven‗ Web 

sites. In short, dynamic Web sites are the ones that retrieve fresh 

information for each individual and on each viewing. The address of 

the site normally ends in .asp (Microsoft Active Server Pages) or .cfm 

(Cold Fusion). Dynamic Web sites are used increasingly for e-

business and commercial purposes.  

 

1.3.4 Types of Web Sites 

There are many types of Web sites, each catering to a particular 

type of content or use. Identifying and classifying all of them may 

appear arbitrary. Hence, few illustrative but not exhaustive cases are 

given below: 



1) Blog (Web Log): site generally used to post online diaries which 

may include discussion forums, 2) Forum: a site where people discuss 

various topics, 3) Mirror Site: a complete reproduction of a Web site, 

4) Social Networking Site: where users could communicate with one 

another and share media, such as pictures, videos, music, blogs, etc. 

with other users. These may include games and Web applications, 5) 

Wiki Site: which users collaboratively edit (such as Wikipedia and 

Wikihow), 6) Web Portal: that provides a starting point or a gateway 

to other resources on the Internet or an intranet, 7) Search Engine 

Site: a site that provides general information and is intended as a 

gateway or lookup for other sites like Google, Yahoo, Bing search 

engines, 8) School Site: where teachers, students, or administrators 

can post information about current events at or involving their school, 

9) Community Site: a site where persons with similar interests 

communicate with each other, usually by chat or message boards, 

such as MySpace or Facebook, and 10) Corporate Web Site: used to 

provide background information about a business, organization, or 

service. 

  

1.3.5 The Web: History and Development 

Tim Berners-Lee, a computer specialist, working at CERN (The 

European Union for Nuclear Research) in Geneva, Switzerland  

proposed a system of information management in 1989 that used a  

‗hypertext‘ process to link related documents over a network. This 

invention heralded the birth of the Web. For several years since Web 

pages remained text only, confining itself to scientific labs. The break 

through came in 1992 (till then there were only 50 Web servers!) 

when the first graphical browser (NCSA Mosaic) was introduced. 

With this the Web entered the realm of mass media. The later 

developments has been application of Web 2.0 and Web 3.0 

(described under Section 1.2 in the Unit).  

The development of the Web is overseen by the World Wide 

Web consortium (W3C) [www.w3.org], a consortium of many 

companies and organisations that ‗exists to develop common 



standards for the evolution of the World Wide Web‘. The group was 

founded by Tim Berners –Lee in 1994 at the Massachusetts Institute 

of Technology (MIT). The W3C  has contributed much to the 

development of Web technologies.    

 

1.4 Where and How to host your Web Site 

1.4.1 Web Hosting: Free and Fee-based 

      Web hosting can be free or paid.  There are many agencies 

(Internet Service Providers) that provide you with free hosting 

facility. The drawbacks of free hosting are that the traffic/visibility of 

the site could be poor as the natural search engines won‘t place/rank 

you well. Besides, the ISPs tend to  place advertisements on your 

Web site to cover their expenses which may not be to your liking. 

Another alternative is to host the Web site on your own server. 

Organisations that have steady IT set-up resort to this. The third 

option is to share a multiple Web hosting package against payment 

(which is not much expensive now-a-days).[Multiple domain hosting 

packages can be viewed and selected  from the Internet to choose the 

one that suits you). 

 

1.4.2 Steps in Web Hosting 

This section is discussed in the background of the third option i.e Web 

hosting on payment basis. 

1.4.2.1 Buy an URL: The first step is to buy a URL (Uniform 

Resource Locator). Find a domain name registrar to select and register 

a domain name. There are many online Web sites that offer domain 

purchasing service. You need to search the Web sites and choose the 

one of your liking. The minimum time period for registration is one 

year. The charges vary between $10 to $15 a year. 

1.4.2.2 Upload the Site: The next step is to upload the Web site to a 

Web-hosting company that will display the site on the Internet, 24 



hours a day, all days of the year. Refer to Web-hosting directories 

(and they are aplenty on the Web. Search by the term ‗Web-hosting 

Directories‘) which will help you select one that suits you by cost and 

facilities. Once you choose the Web-hosting company and pay the 

fee, the Web site can be uploaded to their server. This company will 

provide you with necessary software and instructions in uploading, 

updating and maintaining the Web site.  

1.4.2.3 Modify the Site: Once hosted you can update/modify the Web 

site as you require. You may display the information, add e-mail link 

for feed back, or provide chat-rooms /bulletin boards you as you 

please.  

1.4.2.4 Choice to earn Money: You can make your site pay, if you so 

wish. One way is to place Google AdSense advertisements on the site. 

It‘s free. Conditions that apply are simple that there must be 20+ site 

pages and 50-100 visitors/day. (Google AdSense is a free  programme 

that empowers online publishers to earn revenue by displaying 

relevant ads on a wide variety of online content including Web sites, 

mobile Webpages and apps, feeds and site search results) Another is 

to sell your products (e. g, books). Payment can be arranged through 

PayPal {PayPal makes it easy to pay (send) or get paid (receive) 

online payments, for personal or business reasons. While payment is 

free, getting paid attracts a fee} or any one of the PSPs (Payment 

Service Providers). Still another way of earning income  is to charge 

for the content. Create a ‗password-protected members only‘ area and 

take payment as explained earlier i.e by utilising PayPal or PSPs. 

    

1.5 Important Web Issues 

      There are many points one should keep in mind while designing 

and hosting a Web site. Adherence to these will help evolving sites 

which are liked by users and, thereby,  attract  more visits. 

 

 1.5.1 Usability Issues 



A Web site can be rated as usable if the users return to the site 

again and again.  If a visitor has to work hard to find 

information /details of a product, he is not going to do that. 

Hence reaching the information should be made easier for the 

user. What are the parameters that make a site usable/ easily 

accessible to the users?  They are discussed below: 

a) Information Availability-- All the information that helps a 

visitor make informed decisions should be in the Web site. The 

general benchmark  of a good Web site is that it should be 

providing 80-90 % of what a user/visitor is looking for. To 

illustrate, take the  case of sale of a product like ‗pen drives‘, a 

brief one line summary  with a further link to a page detailing 

the features and price and arrangement for the purchase should  

attract the buyers.  b) Page layout:  How the content is displayed 

on the page -- The page should be laid  in such a way people 

should be able to find relevant content quickly. Else they lose 

interest and leave the site. Page should be clean and simple. 

Keep only those elements that enhance the usability of the page. 

c) Colours -- Standard colours should be used as colours can 

affect the usability of the site. For example, the standard colours 

used for links (blue for links; violet for visited links; and red for 

active links) should be maintained as one runs the risk of 

confusing the visitors, d) Download Speed --  The speed of the 

download is very important as delays can weary away the 

visitors. As you, as a Web designer, can‘t determine the speed, 

do what you can that will not slow down the download. Some 

considerations are  optimizing the graphics (images not larger 

than 10 kb), making smaller pages (say, not more than 30 kb), 

and avoiding  nested tables though they improve the layout 

enormously. It is also to be noted that advertisements served 

from different servers may slow down your site.   Also check 

the condition of the Web server periodically as to whether it 

needs upgradation which should include the bandwidth too. 

1.5.2Web Accessibility  



Web accessibility means  accessibility to all including people 

with disabilities (like visual, audio, physical, speech, cognitive, 

neurological, including  people with waning abilities due to 

advanced  age) can interact and /or contribute to the Web. As 

more and more accessible Web sites and software are made 

available, people with disabilities should be  able to use and 

contribute the Web more effectively. Web accessibility   

providing   equal access and  opportunity to all   enable people 

to participate more actively in society. 

 1.5.3 Appearance is Secondary 

Do not focus too much on appearance. It‘s often found that 

people exhaust all their energy at the beginning itself in getting 

the appearance of the Webpage  to their entire satisfaction and 

in the process are left with less time and patience on the content 

part. Hence start with the basic appearance and improve, if so 

felt, later. In short, appearance is important but the excess 

importance placed on appearance at the beginning my be 

avoided as it may be at the cost of more important elements of a 

Web page. 

1.5.4 User-friendly Site.  

Your audience is the key. You must know the pulse of the 

audience when it comes to gauging their 

information requirements.  Create content of what they require. 

Also make the content of your site easily reachable.  Easy 

access or reachability presupposes creation of intelligent/logical 

navigational system. Some general rules are given below: a) 

make navigational bar/panel in all pages, b) provide short cuts to 

pages/contents where visitors are likely to want to go. Do not 

force them to go to main page or the Site Map if they need to 

visit another page in the site i.e put direct links to the logical 

places., c) make sure your site is visible to all visitors i. e your 

menu is not confined to a particular browser but to as many as 

possible like Microsoft Internet Explorer, Firefox  Netscape and 

Safari. d) Use Site Map: Site Map is one page where you list all 



the contents of your  site and the visitor can easily navigate to 

the  one he wants i. e it provides another route to other pages. e) 

Provision of search box (implying provision of a  search engine 

on your site)  -  where the site has a large number of pages the 

search box  will be much helpful in finding relevant information 

faster. You could find most of all these facilities provided in the 

Web site of IGNOU, which‘s quite a large site in itself. 

 

1.5.5 Search Engine Visibility  

If your site cannot be  found through search engines, you do not 

exist to the world. How to make the site visible to search 

engines is the biggest issue you will encounter. Hence find more 

information on the topic  from the net or from books on how to  

get listed in the search engines. (It‘s not discussed as it is a large 

topic and not in the scope of this Unit) 

  

1.6 Summary 

This unit is divided into four parts viz., 1) introduction to 

Web and Web sites, 2) what a Web site is and what is it all 

about, 3) the basics of  hosting the Web and 4) the factors to be 

kept in mind while designing and hosting the Web site.  

The introduction describes who the Web site creators are 

and for what reasons they design and host Web sites. It covers 

individuals, business enterprises, organisations (including 

government, NGOs) and entertainment entities. The second part 

on the concept of Web site deals with the fundamental elements 

of  Web (besides he concept itself) and various types of Web 

sites. It also strives to distinguish between static and dynamic 

Web sites and also between Internet and Web. A brief insight 

into the development and history of Web site is also attempted 

at. 



The third part on the basics in the hosting the Web 

delineates various options in hosting the Web like free and fee-

based Web hosting. On the second option, this unit further 

dwells on various steps to go through before hosting a Web.   

The final part deals with matters that should be kept in 

mind while designing a Web, with a view to creating more 

functional and sought after Web pages. 

  

1.7 Self-check Exercise 

1) In what ways commercial organizations make good use Web for 

promotion of business? 

2) What is a Web site? 

 3) Distinguish Internet from Web 

4) What are static and dynamic Web sites? Explain with examples. 

5) What are various steps in Web hosting? Explain each. 

6) Explain briefly the important issues one should keep in mind while 

designing  and hosting a Web site. 
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2.0 Introduction 

 

      Designing and creation of a Web page is like production of a book. It’s a 

creative work, involving many a task like writing, maintenance of style, 

designing, adding of pictures and graphs, and shaping up the appearance.  

In the same line, the Web page offers scope for conveying and 

communicating information using a variety of options including text, 

graphics, photos, video, sound, animation, and link to other sites.  In this 

Unit, we shall, however, confine to discussion on composing and shaping of 

Web text.  

      Like production of a book, Web page creation also is not a step-by--step 

process. What elements (text, graphics, multimedia etc) to be included or 

what steps to be followed is decided by the Web designer by himself. 



However, normally every one prefers to start with creation of text file that 

may be considered as foundation lying of the Web page. Text file is created 

by using HTML codes, which turns a normal word processing file into a Web 

file. We are not, however, going to discuss HTML codes, as it will be done in 

a separate Unit. We shall confine text matter and text elements of Web 

pages in this unit.  

 

2. 1 Objectives 

 

After reading this Unit you will be able to:  

 learn how and why reading of Web pages is different from that of 

print;    

 get a good insight into why writing  of Web text is  different from that 

of print, and  

 gain a fair grasp of  guidelines on writing texts for Web pages.    

 

 

 

2.2 Readers’ Approach to Online Pages  

 

      Reading habit of Web users should be kept in mind while writing the 

text. Before reading a book in full, a reader would have already made a 

cursory look   and determined to go ahead. However, the case of Web 

reading is different. He is not sure whether any among the plethora of sites 

he visits and documents therein will be relevant to his requirement.   

Hence, he will not spend time going through every document in Web sites. 

As a result, strategies have been evolved in quickly assessing the Web 

sites as to whether the Web in question serves his purpose. If anyone is 

found  useful/relevant, he will settle down to read the item page by page. 

We shall discuss in this section some of the strategies.  

      One reads every day for various purposes like enjoyment, information 

or for doing a job. Newspapers, magazines, fictions, textbooks, mails, 

journals, online documents, Web pages etc constitute the reading 



materials. People adopt different strategies of reading without being really 

aware of them. The important techniques followed are word-by-word 

reading, skimming and scanning. In Web reading it’s the last two that are 

followed. You resort to scanning if you are searching for information. 

Skimming is done when one is exploring/reviewing a matter. However, 

people often mistake skimming and scanning as search techniques. They 

are, in fact,  reading techniques only.  

 

2.2.1 Skimming   

      Skimming is the process of reading only main ideas within a document 

to get an overall impression of the content. It is applied when you are 

confronted with a lot to read within a limited time.  In the same vein 

skimming can be used to assess whether a resource document would be of 

any use for you research /further close study.   

There are many techniques applied in skimming. One is reading the first 

and last paragraphs, or the  headings and summaries. Another way is to 

read the title, sub-title, sub-heading and illustrations. Noticing pictures, 

charts, or graphs, italicized or boldface words or phrases, words in the blurb 

of a book or the preface or table of contents can also pass as skimming for 

information. Another strategy may be to read the first sentence of each 

paragraph.   

  

      In other words, skimming can quickly identify the major ideas of a text. 

The high speed is possible because skimming is estimated to have   three 

to four times the speed of normal reading. Thus skimming is not reading 

for comprehension of the content but for getting an impression about the 

text. For the same reason skimming is practiced in Web reading  as one is 

not sure about the utility of the content at the outset. On realizing the utility 

of a  material after skimming, one may resort to word- by- word reading, as 

done with textbooks or serious documents or research outputs   

2.2.2 Scanning  

      Scanning is a reading technique that is used when you want to find 

specific information quickly. If I am interested in finding the number of 

public libraries in the state of Kerala, I read a passage or item only for the 

purpose of finding that answer, ignoring unrelated information. It’s like 

scanning to locate your friend in a crowd, ignoring all other faces.  



      Scanning is quickly moving your eyes through the text to locate specific 

word or a phrase or ideas. It’s similar to looking up the dictionary for a 

specific word or looking for information in reference book.   

      In Web reading people resort to scanning as a strategy for the same 

reason as explained earlier on skimming. You  are not sure whether the 

Web under consideration will meet your requirement and also you need to 

do it fast as many such pages/resource documents need to be assessed.   

      Once you find the information you were looking for, and thereby 

establish the resource document as useful in answering your requirement, 

you may resort to skimming to get an over all impression about the 

document or go for  full-text reading. While skimming it, if you find a 

particular one as the right document, you may go for a thorough reading to 

meet the purpose, which may be for enjoyment, information or for getting 

a job done.   

  

2.3  Textual Elements of Web Page: Guidelines   

 

   It is an accepted fact that reading online takes more time than 

otherwise. According to a study conducted by Jakob Nielsen of the Nielsen 

Norman Group, reading a book on any electronic devices whether it’s 

Kindle or iPad, takes longer time than reading the standard paper version 

of the same book. Also one is not sure what he reads will be of use at the 

end. Hence most online readers are compulsory scanners or skimmers who 

skim Web pages rather than the read word-by-word. Even systematic 

readers also would love to have special online reading structures in the text 

so that they do not have to slow down picking their way through the pages.    

 Writing for Web, so, is different from that for print. Hence, the Web 

designer should have in depth knowledge on how to compose and shape 

web text. Following are guidelines for creation of textual elements for the 

Web: 

 

      2.3.1 Chunk the Information 

 



      Web readers dislike long pages and irrelevant segments of information. 

They prefer to have the pages structured in order to access information 

direct and easily. One way is to provide information in short chunks to 

facilitate location and scanning. 

      Chunking is the method of presenting information which splits concepts 

into small pieces or chunks  so that they can be understood faster and 

easier. Opposite of chunking is reading consequently, where all the 

information is given in continuity and one reads from one end to another. 

In research and administrative documents reading consequently may not 

be required and, hence, the demand for chunks of information in Web 

pages. 

      Chunking of information goes well with Web for many a reason. 

Concise chunks of information are better suited for computer screens as 

they (screens) provide limited view of long documents. Scrolling through 

pages is not liked generally as readers tend to forget the scrolled screen 

leading to their disorientation. In case of long text they prefer to take print 

or save on to disk for comfortable reading later. 

  Instead of providing all information on a topic on a page, it is advised to 

break up the body of the information to logical parts, provide each with its 

own page and connect them with links. In this situation the  reader can 

skip from one chunk to another easily without having to read sequentially. 

However, on the flip side of it one should take care not to break long 

documents arbitrarily. It should be done intelligently so that each page will 

contain comprehensive information. The  users should  have   direct access 

to topics that are interested in and do not have to wade through irrelevant 

materials.  

  

2.3.2 Make Texts easily Scannable 

 

      One golden rule in Web style is that the text should be done in an easily 

scannable form. 

      Jacob Neilsen research on how users read on the Web showed that 

people scan the Web pages, picking out individual words and sentences. 

He found that 75 percent of the test users always scanned any new page 

they came across and only 16 per cent read word-by-word. 



      In other words, Web users want actionable contents that meet his 

requirements immediately. The search is not casual/random but specific. It 

is a solution - hunting approach. It is entirely different from expectations 

from print publications like newspaper or magazines where words    may 

be spiced up with narratives and anecdotes and examples. In the case of 

Web such approach is not appreciated as it comes in way of getting to the 

information fast.  

   In this context, it should be concluded that Web pages should focus on 

scannable text and employ following style/rules; 

a. Highlight keywords (hypertext, use differing type face or colour)  

b. Use meaningful sub-headings  

c. Utilise bulleted lists  

d. Employ one idea per paragraph (first few words of the paragraph are 

important)  

e. Apply the inverted pyramid style. The inverted style starts with the 

conclusion. It is akin to style of the journalists who start their article 

by stating the conclusions and then provide the background 

information. It is all the more applicable in Web as users are 

reluctant to scroll and, hence, tend to read only top part of the article.  

f. Use fragments of sentences with information-carrying key words (in 

place of full sentences) because it is estimated that Web users read 

only 18 per cent  of the verbiage.  

  

 

2.3.3 The F-shaped Pattern for Reading  

 

      Jacob Nielsen studies show that users read Web contents in an F-

shaped pattern. Users usually read the upper part of the content area in a 

horizontal movement. Next, the eyes move down the page a bit and read 

across horizontally (a second time) and finally the eyes hover over the 

document’s left side in a vertical movement. The implications are: a) the 

first two paragraphs should state the most important information, and b) 

the latter part may employ sub-heads to paragraphs and also  bullets with 

information carrying words as users tend to scan down the left side i. e the 

3rd part of the F-behaviour.   

         



 

2.3.4 Creditability 

 

      Credibility is important in Web as to who is behind the page and 

whether the information provided can be trusted. This is a complex topic 

and may not be in the scope of this Unit. However, the thumb rules should 

be good writing (grammatically, in spelling, choice of words), utilization of 

higher quality graphic, and providing links to other sites implying thereby 

that the authors are not scared of information given elsewhere on the 

same subject. Exaggeration of facts is detested and considered as less 

trustful. People, in fact, want straight facts than exaggerated qualifications. 

  

2.3.5 Use of Passive Voice 

      Use of passive voice in Web writing provides an edge over active voice. 

Passive voice directly represents action which enhances scanability. To 

illustrate this point, take the  example of M/s Godrej Company that 

supplies library stacks. Let us frame the statement in the following ways: 

‘M/s Godrej supplies library stacks’ (active voice) and ‘Library stacks are 

supplied by M/s Godrej’ (passive voice). You will notice that the latter 

(passive voice) focuses on the library stacks and readers can arrive at 

‘library stacks’  (the library is  interested in the stacks than the supplier) 

easily.  

      For the same reason, a Web writer is advised to use positive 

statements (e. g: M/s Informatics deals in journal subscription) rather 

negative sentences (e. g: M/s Informatics does not deal in journal 

subscription) as the user has to make an effort to grasp the implication of 

the sentence or at times misses it altogether.  

  

 

 

 

2.3.6 Write Numbers in Numerals 



 

      Writing numbers in numerals will function as eye catchers. Users tend 

to fixate on numerals. Hence, it will be advantageous to use ‘43’ in place of 

‘forty three’ as Web readers notice the numerals easily.  

  

 

2.3.7 Beware of Users’ Searching Ways 

 

      Try to identify key words that the users are likely to apply. It helps users 

find the site as well as the information fast. Success of the Web lies on the 

fact as to how many visit the site.  Familiar key words enhance the chances 

of findability of your Web. Hence, use of commonly used key words or 

familiar search queries increases the value of your Web page.  

  

2. 3. 8 No Bond, Only Business  

 

      Users are in a hurry to get their problems solved as quickly, and leave 

the site in the same haste. Unlike in the case of newspapers or magazines, 

there is hardly any emotional attachment or bond to a Web. Hence layout 

and writing should have superb usability to survive a high pressure 

environment.  

  

2. 3. 9 Online Titles  

      The online (Web page)  titles are very different from print headlines. 

Unless the titles are very clear about what the contents are, the users will 

never open it. (It is similar to your deleting e-mail messages without 

opening if the titles of the messages did not make much sense to you). 

  Online titles/headlines are unlike printed matters. In printed 

material the title/headlines are surrounded with sub-headings, photos, 

boxes etc and, hence, the message is grasped in one glance. On the other 

hand, online headlines should stand by their own without assistance of any 

surrounding data.  



      The best strategy to be followed may be to describe the matter from 

the point of view of the users so that the chances of rejection are reduced. 

Use plain language to avoid confusion of any sort when a matter is 

scanned in seconds. It may be better to skip articles like ‘the’, ‘a’ and ‘an’ 

in the page titles. More information carrying words may be used in the 

beginning, especially the first word as it enhances scanning.  

  

2.3. 10 Sites for Special Groups 

      2.3.10.1 Teenagers 

      It can be stated that teen-agers today are entwined in Internet. They 

use it all the time for various purposes like school assignments, 

information, hobbies/special interests, entertainment (music games),  

news, e-commerce, health matters etc. Research shows that despite the 

high utilization of the Internet, teenagers have a lower success rate on Web 

for reasons of lack of knowledge and impatience. Hence, Web sites for 

teenagers should be designed to be simple and should have plenty of 

interactive features. 

      2.3.10.2 Less Literate and Illiterates 

      While writing for less literate it should be borne in mind that they are 

different from the rest. They do not scan but prefer to read word-by-word 

and line-by-line. If they cannot do that they resort to skipping over large 

junk of information which is detrimental to the interest of the Web site you 

try to promote. As they have narrow field of view they end to miss 

information or objects outside the main frame of the text. Besides,   

scrolling is avoided as it affects  their visual concentration.  Hence the best 

strategy may be to place all important points at the top of the page. Also 

prefer static text against moving text or animations. These will do away 

with necessity for scrolling as well as disturbances of any kind. 

  

2. 4 Conclusion  

 

The text and writing for Web pages should be  concise, scannable and 

objective.  According to a study conducted by John Mokers and Jakob 

Nielsen in 1977  a sample Web site scored 58 per cent  higher in 

measured usability when it was written concisely, 47 per cent  higher when 



the text was scannable, and 27 per cent  higher when it was written in an 

objective style instead of the promotional style used in the control 

condition and many current Web pages. Combining these three changes 

into a single site that was concise, scannable, and objective at the same 

time resulted in 124 per cent  higher measured usability. 

  

  

      2. 5 Summary 

 

This unit is divided into two parts:  

1) Readers’ Approach to Online Pages - Skimming and Scanning. As a Web 

reader is not sure whether the site he searches will be relevant to his 

requirement, he resorts to various strategies in reading the Web and 

checking whether the Web in question serves his purpose. Skimming and 

scanning are two strategies followed by Web readers.  

2) Textual Elements of Web Page: Guidelines 

As most online readers are compulsory scanners or skimmers who skim 

Web pages rather than  read word-by-word, the Web text writer should 

adopt styles that will correspond with these habits.  They are: chunking of 

the Information; adopting means to make text amenable to scanning; 

using of techniques like passive voice and numerals, appreciating the 

users’ attitude to information available at the Web sites.  

  

  

2.6 Self-check Answer 

 

      1. What are the strategies followed in reading Web pages? Describe 

them briefly. 

      2. What do you mean by chunking the information? Explain why is it 

significant in Web text writing? 



      3. What is the significance of making Web texts scannable.? Provide 

some important guidelines on them.  

4. Why should one prefer passive voice in Web pages? Justify your 

argument with examples. 

      5. What are the that should be kept in mind while preparing texts for 

the special groups like teenagers and less literate people?  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Unit-1 Creating and Using Art on the Web 

 

 



1.0 Introduction 

 

1.1 Objectives 

 

1.2 Web Graphics Issues 

 1.2.1 Pixels 

 1.2.2 Palette 

 

1.3 Graphics File Format 

 1.3.1 GIFs 

 1.3.2 JPEGs 

 1.3.3 PNG 

 

1.4 Resizing Graphics 

 

1.5 Wed Design Fundamentals 

 

1.6 Summary 

 

1.7 Self-check Exercise 



1.0 Introduction: 

 

In this unit, we simplify the topic of Web graphics. In a perfect world, we‘d dedicate 

pages and pages to the nuances of using graphics on the Web (mostly because we like 

graphics), but then you‘d never get to the rest of the lessons. We also don‘t want you to feel 

overwhelmed when it comes to using Web graphics. As you might have discovered, you can 

easily find an overabundance of information about advanced graphics by looking on the 

Internet and in bookstores everywhere. 

Fortunately, you can use Web graphics effectively without immersing yourself in 

gamma theory and rasterizing. Therefore, we‘ve opted to take the practical approach of 

presenting what we deem to be the most significant and fundamental information about Web 

page graphics. Think of this lesson as your personal crash course in Web art. By the time you 

reach the ―Key Points‖ section at the end of the lesson, you‘ll have plenty to think about, a 

few tricks up your sleeve, a cocktail party quip or two, and a number of places to turn to 

during your search, acquisition, creation, and preparation of Web art. 

 

 

1.1 Objectives 

 

This lesson will help you to learn the: 

 Comprehend the basics of Web graphics. 

 View and manipulate Web graphics in a graphics program. 

 Describe the different types of graphics file formats 

 Choose ―safe‖ colors for the Web. 

 Crop a graphics image. 

 

 

 

 

 

 

 

1.2  Web Graphics Issues 
 



This section is making you understand a few key Web graphics issues. As you know, 

Web graphics look fairly similar to printed graphics, but some Web-specific factors come 

into play when you‘re creating and using graphics on the Web. Specifically, online graphics 

require you to consider color limitations, file formats, and file sizes as well as possible 

transparency, downloading, and animation issues. Acquiring an awareness of three main 

factors—colors, file types, and file sizes—enables you 

to begin using graphics on your Web pages and provides a jumping-off point for further 

graphics study. Therefore, the overall plan of attack here is to tuck some Web graphics 

fundamentals into a cranial corner or two before opening your mind to the more creative (and 

fun) prospects of using, gathering, and creating Web graphics. Let‘s get started by looking at 

how graphics display color.  

 

Before understand the concept of color we should know the two major parts of color i.e. pixel 

and palettes.   
 

1.2.1 Pixels  

 
. 

Definition of pixel: A pixel is one square on a grid of thousands of squares that are 

individually colored to create a image. 

 
First and foremost, every online graphic consists of a bunch of tiny colored squares working 

together to form an image. In a way, online graphics emulate a painting technique called. 

Pointillism . Pointillism, introduced by French painter Georges Seurat (1859–1891), is the art 

of painting pictures one dot (or tiny brush stroke) at a time. Through pointillism, Seurat broke 

each image on his canvas down into tiny dots of color. When you look closely at a pointillist 

painting, you can see each dot. As you move away from the painting, the dots blend together 

to create a picture. Computers display pictures using a technique similar to pointillism, except 

that instead of painted dots, computers divide pictures into colored squares, called pixels. For 

example, take a look at the cherries in Figure 1. 

Figure 1 could be any graphic displayed on your screen. As you can see, the graphic looks 

like most other pictures online (or in printed material, for that matter), and there are no 

blatant signs of dots, squares, or pixels. 

 

 

 

 



 
Fig1. A couple cherries stand in as a typical graphic. 

 

 

 

 

Now let‘s look at the graphic a little more closely. In this Lesson you can edit this image 

through application such as Jasc Paint Shop Pro, Adobe Photoshop, or Microsoft Paint. If you 

then dramatically magnify the image, you‘ll be able to see the actual squares (pixels) that 

make up the picture, as shown in Figure 2.. If you magnify the cherries on your monitor, 

you‘ll see that the picture‘s colors and shades vary from pixel to pixel, or square to square.If 

you don‘t have a graphics editing application on your system or if you want to test-drive a 

popular ―full-service‖ graphics editing application, visit www.jasc.com and download a free 

trial version of Paint Shop Pro. We have more to say about graphics editing applications later 

in this lesson 

 



 
 

Fig2.When you magnify an online image, you can see the image‟s pixels 

 

 

Try This ! 
With cherries_photo.jpg still open in your graphics program, enlarge the picture by using 

your graphics program‘s Zoom Tool or Magnifying Glass. To further illustrate how pixels 

work, incrementally decrease the image‘s view (or ―zoom out‖) to a slightly more viewable 

size, as shown here: 

If 

you zoom out slowly, you can see how the pixels start to blend to create a clear image. 

 

 

 

 

1.3.2 Palette: 

 
Definition: A palette holds the set of colors used in a graphic. In some Web graphics 



applications and documentation, a palette is also referred to as a color look-up table(CLUT) or 

simply a color table 
 

Now that you know about pixels, we can talk a little about palettes. A palette is simply the table of 

colors used in a graphic. Some Web graphics (namely, graphics saved using the GIF file format, as 

described in the next section) use a limited collection of colors. You can assign a palette to an image, 

or you can let your graphics program generate a palette automatically as you create and edit an 

Image . A GIF palette can hold up to 256 colors, but many images use fewer colors than that. For 

example , looking at Figure 3, the cherries graphic uses 8colors and the hot pepper graphic uses 128 

colors. Notice the pictures‘ sizes—the cherries graphic is 3 KB (very small), and the hot pepper 

graphic is 7 KB(almost as small as the cherry GIF graphic). 

 
Fig.3 

 

The cherries graphic‘s palette contains 8 colors, and the hot pepper graphic‘s palette contains 128 

colors. 

 

Generally, most graphics applications enable you to view the colors included in a GIF graphic‘s 

palette. Furthermore, you can reduce the size of a GIF image by reducing or limiting the number of 



colors in the picture‘s palette. And, as you probably know, smaller file sizes equate to quicker 

download times on the Web 

 

Try This! 

Locate cherries.gif or fire breath.gif and open either graphic in a graphics editing application such as 

Jasc Paint Shop Pro, Adobe Photoshop, or Microsoft Paint. To display the image‘s palette in Paint 

Shop Pro, select Edit Palette from the Colors menu. In Photoshop, select Mode from the Image menu, 

and then select Color Table. (We realize that every graphics package has its own menu options; we 

provide the preceding two commands to give you an idea of the type of command you should 

look for in your graphics application.) 

 

As we just mentioned, palettes come into play when you use GIF images. We realize we haven‘t 

defined GIFs yet—or any Web-friendly image formats for that matter. Now that you have a feel for 

the nature of pixels and palettes, however, let‘s move on and discuss graphics file formats that you 

can use on the Web. We‘ll talk more about palettes when we discuss GIFs later in this lesson. 

 

1.3 Graphics File Formats 

 

Graphic on a Web page is stored as a separate file. The title of any figure‘s file name ends with a .gif 

file extension (afs_title.gif), and the other figure‘s file name ends with a .jpg file extension 

(4members.jpg). Graphics file extensions work on the same principles as other file formats. For 

example, if you see a file on your desktop named holiday_gift_list.doc, you know by the .doc 

extension that the file is probably a Microsoft Word document, and you‘ll want to open the document 

in Word (especially if you suspect that you‘re one of the people listed on the holiday gift list!). 

Similarly, if you see a file on your desktop named bills.xls, you know the .xls indicates a Microsoft 

Excel document, so you could open the file in Excel (although you might want to avoid files named 

bills). In relation to Web graphics, your Web pages can include graphics images that use the .gif and 

.jpeg (or .jpg) file extensions because most popular Web browsers can display GIF and JPEG 

(pronounced ―jay-peg‖) files. 

 

 

1.3.1 GIFs 

 

Definition: GIF (Graphics Interchange Format) is a graphics file format used to create images for 

use on the Internet. GIF images can contain up to 256 colors. 

 

 

GIFs are the most widely supported graphics type on the Web (which means that almost all 

browsers—old, new, and in-between—can display GIF images). GIF stands for Graphics Interchange 

Format. CompuServe created this format in the1980s as an efficient means to transmit images across 



data networks. The GIF format‘s main strength is that GIF images are usually small, which means that 

they download and display quickly. 

As we mentioned earlier in this lesson, GIF images use palettes and support up to 256 colors (which 

makes them 8-bit graphics). Because GIFs support a limited number of colors, you should use GIFs 

for flat color areas, logos, line art, icons, cartoon like illustrations, buttons, horizontal rules, bullets, 

backgrounds, and other graphical elements that require few colors. Figure 4 shows some examples of 

typical uses of GIF images. 

 

 
Fig4. Line art, horizontal rules, buttons, bullets, and graphical text are typical uses 

of GIF files. 

 

 

 

 

In addition to being palette-reliant, small, and efficient, GIFs perform three 

Special tricks—interlacing , transparency, and animation. 

 Interlaced GIFs Normally, a GIF image appears on screen row by row, from top to bottom of the 

image, like pulling down a window shade. If you want to, you (as a Web page designer) can change 

how a GIF downloads onto viewers‘ monitors by saving your GIF file as an interlaced GIF file. An 

interlaced GIF graphic displays on users‘ screens as blurred or jagged at first and then gradually 

becomes clearer. Figure 5 shows an interlaced GIF in the midst of downloading. 

The figure on the left shows the image before it‘s fully downloaded, and the figure on the right shows 

the fully downloaded image. 

 



 
Fig5 On slower Internet connections, you can see how an interlaced GIF displays blurred before 

downloading completes. 

 

Interlaced GIFs are good to use when you want to transmit an image‘s main idea to readers while they 

wait for the complete download. The drawback of interlaced GIFs is that they have slightly larger file 

sizes than conventional (non interlaced) GIF images. Therefore, for buttons, icons, and small 

graphics, you‘re better off sticking to the conventional GIF file format. 

 Transparent GIFs: Transparent GIFs (GIFs that use the GIF89aformat) enable you to design icons, 

logos, and other elements that appear to be cut out, thereby allowing the Web page‘s back ground to 

show through areas of the image. For example, as you can see in the right side of Figure 6, the 

background shows through in the transparent GIF to create the illusion of a                                                 

nonrectangular image 

 



Fig6. Comparing a standard GIF with a transparent GIF shows how transparency allows a Web 

page‟s background color (or pattern) to show through. 

 

When you create a transparent GIF, you essentially specify a unique color in your image to serve as 

your transparent color. For example, you could color the background of your picture hot pink and then 

assign hot pink to be the picture‘s transparent color—just make sure hot pink doesn‘t show up 

elsewhere in your image or you‘ll create unwanted transparent spots. When a browser encounters the 

transparent color, the browser doesn‘t show any graphics information in the color‘s area, which 

enables the Web page‘s background to show through. 

Note: If a GIF’s background color matches your Web page’s background color—such as an 

image with a white background on a Web page with a white background—you automatically 

achieve the illusion of transparency. 

 

 

 

 Animated GIFs : The last GIF ―trick‖ involves animation. Using GIF animation tools an graphics 

editing programs, you can layer GIFs and save the layers in a ―stack‖ to create simple animations. 

When a browser displays the stacked GIF images, it displays each image one after the other. This 

technique is similar to the old flip-card ―movies‖ that were popular long before most of us came into 

existence. Moving icons, rollover buttons, and some banner ads areprime examples of animated GIFs. 

Figure 7 illustrates the theory behind animated GIFs. As you‘ll see later in this lesson, you can 

download free animated GIFs and GIF animation tools from the Web. 

 
Fig7. 

Tip 

The Clip Art in Microsoft Office XP includes animated GIFs as well as transparent GIFs that you can 

use on your Web pages. To identify a Clip Art item that‘s an animated GIF, look for a gold star in the 

lower-right corner of the thumbnail image in the Clip Organizer. To identify a Clip Art item that has a 

transparent background, look for items that appear to be ―cut out‖ in the Clip Organizer. You can test 

an image‘s transparency by inserting the image into a Word document that has a color background. 

 

 ―Safe‖ Colors for the Web 

As you know, all computer systems are not created equal. Many people have a heck of a time keeping 

up with the computer industry‘s rapid pace of hardware development. Therefore, when you design 

Web pages, you should keep in mind that not all people will be able to access your pages if your 

pages require the latest and greatest display hardware. In fact, approximately 10 percent of all Web 

surfers are restricted to viewing Web pages in 256 colors (although most new systems display 

millions of colors, so the 256-color design issue will probably soon be a design consideration of the 

past). Therefore, for the next couple years, when you design your Web pages and create GIF images, 



you might consider relying on colors that 256-color monitors can display without a hitch. The 

universal colors are referred to as the Web-safe or browser-safe colors. If your Web page uses colors 

other than Web-safe colors, systems that support only 256 colors will resort to dithering the 

nonstandard colors. 

To avoid dither, stick to the 216 Web-safe colors. (The other 40 colors out of the 256 are reserved for 

the computer system‘s use.) To see the Web-safe color palette, open palette216.gif in your graphics 

program. To see the colors in color chart format, visit www.creationguide.com/colorchart. Graphics 

editing programs usually provide a Web-safe palette that you can load when working with GIF 

images. 

Definition : Dither refers to the random dot pattern that results when colors are approximated 

by mixing similar and available colors from a limited palette 

 

 

 

1.3.2 JPEGs 

 

In addition to GIF graphics, your Web pages will probably include JPEG images. The JPEG image 

file format was created by and named after the Joint Photographic Experts Group. This image format 

supports millions of colors, and JPEGs are almost universally supported by browsers. (Technically 

speaking, JPEGs support 24-bit color, which is also referred to as full color or true color.) 

Because JPEGs can contain millions of colors, JPEG graphics frequently display photographic images 

online. When you‘re working with JPEGs for your Web pages, you can specify whether you want to 

save your JPEGs as standard or progressive: 

 Standard When you save an image as a standard JPEG file, the image loads line by line from the top 

of the screen down, similar to how GIFs download by default. 

 Progressive When you save an image as a progressive JPEG file, the image first appears blurry and 

then becomes more focused as the image data is downloaded (similar to interlaced GIFs). With fast 

Internet connection speeds, the progressive rendering might not be readily apparent to viewers; 

instead, after a delay, the image will seem to ―pop up‖ onto the page. In our experience, progressive 

JPEGs seem to create smaller file sizes and download slightly quicker than standard JPEG files. 

Another JPEG configuration parameter that you can use to your advantage is compression. 

Compression is a process that reduces an image‘s file size by throwing out some color information. 

JPEG compression is called a ―lossy‖ compression scheme because once you compress an image the 

deleted information is lost. Fortunately, if you‘re careful, people viewing the image online can‘t easily 

discern the information loss. 

Note: When a JPEG image displays on a system that supports only 8-bit color (256 colors), the 

browser reduces the colors in the image to the Web palette and some dithering will occur. 

 



 

Tip 
When increasing a JPEG image‘s compression, always save a copy of the original image first. Then,  

use the Save As command whenever you further compress the file to create a new file. Once an image 

is compressed using JPEG‘s compression scheme, the information that‘s removed is lost. Keep in 

mind that the more you compress an image, the smaller the image‘s file size becomes, but the 

resulting image won‘t be as sharp as a less compressed image. Therefore, you should experiment with 

various compression settings when configuring JPEG images for your Web pages. 

At this point, you should be comfortable with the idea of progressive and compressed 

JPEG files, but we haven‘t yet explained how to configure these types of settings for a JPEG image. 

Fortunately, most image editing programs make specifying JPEG file parameters fairly easy. To 

access JPEG file settings in Paint Shop Pro, follow these steps: 

1 Open your JPEG image in Paint Shop Pro. (Feel free to practice with any of the fruit.jpg images 

provided for this course and located in the Lesson03 folder on your hard drive.) 

2 Choose Save As from the File menu to display the Save As dialog box. 

3 Enter a new filename, and then click Options to access the Save 

Options dialog box, shown in Figure 7.. 

When a JPEG image displays 

 

Fig7. The Save Options dialog box enables you to configure JPEG compression and 

render settings in Paint Shop Pro. 

 

4 Specify an encoding option (Standard or Progressive), select a 

compression setting, click OK, and then click Save. 

 

To configure JPEG settings in Photoshop, follow these steps: 

1 Open your JPEG image in Photoshop. 

2 Choose Save from the File menu. 

3 Enter a file name, and click Save. The JPEG Options dialog box 

opens. Specify compression settings by moving the Quality slider 

in the JPEG Options dialog box, and then click OK. 



 

1.3.3 PNG 

 

 

Definition: PNG (Portable Network Graphics) is a graphics file format designed to replace GIF 

images on the Internet 

 

 

The third (and final) graphic type we address in this lesson is the PNG file format. PNG (pronounced 

―ping‖) stands for Portable Network Graphics. Similar to GIFs, PNG files are small, they load 

quickly, and they support transparency. PNG files transmit faster than GIFs, but only the newer 

browsers support them. Initially, the PNG file format was devised because Unisys, the makers of the 

GIF compression algorithm, decided to enforce the patents for that algorithm—meaning that software 

vendors had to pay to use it. But you really don‘t need to know the details about the PNG vs. GIF 

debate. Just know that newer major browsers (including Microsoft Internet Explorer 5 and later) can 

display PNG images, but most Web designers don‘t use PNGs in deference to users who surf 

the Web with older or less technologically advanced browsers. At this point, your Web pages 

probably shouldn‘t use PNGs either. 

 

 

Note: 

Internet Explorer for Microsoft Windows began to incorporate some PNG support in 1997 and began 

providing PNG support in Macintosh versions of Internet Explorer in 2000. Therefore, the PNG file 

format is slowly starting to catch on as developers watch the percentage of users who have access to 

the most up-to date or most technologically advanced browsers. From a developer‘s perspective 

,there‘s currently no reason to risk losing viewers by using a PNG file format when the GIF file 

format is readily available, just as easy to use, and widely recognized in almost all browsers 

(regardless of version). 

 

Size Matters 

 

 

The last major ―technical‖ Web graphics consideration that we cover in this lesson 

is file size, which is directly related to download speeds. As a Web surfer, you‘ve probably caught 

yourself drumming your mouse impatiently while waiting for pages that take longer than 10 seconds 

to display (or, even more likely, clicking away before the slow page ever fully displays). As a Web 

designer, you need to hold on to that impatient feeling. When you design Web pages and use Web art, 

you should always keep one eye on your design and another eye on the user‘s perspective. (That 

almost sounds painful!)When you use Web art, you can take advantage of a few techniques that will 

help keep your file sizes manageable. We already covered a few key topics earlier in this unit that can 

help to reduce file sizes and speed download times, 

Including these: 



 Avoid dither in GIF images by using Web-safe colors whenever possible, especially in large, flat 

color areas. (Just think—before reading this lesson, that sentence wouldn‘t have made a bit of sense to 

you.) 

 Configure JPEG images to render progressively.  

 Compress JPEG images to reduce file sizes. In addition to using the three preceding graphics file 

techniques, you can control download speeds by resizing your images, cropping images, and using 

thumbnails. We briefly describe each technique in the following sections. Please keep in mind that the 

actual mechanics of accomplishing certain tasks vary among graphics editing tools. 

1.4 Resizing Graphics 

 

One of the best ways to conserve download time is to physically resize your images in a graphics 

editor. Note that we‘re talking about resizing the image, not simply changing your view. Zooming in 

and out changes your view of an image, but it doesn‘t affect the file‘s actual size or dimensions. Try 

to size your images to the approximate size you want to display them on your Web page. Figure 8 

shows the Resize dialog box you use in Paint Shop Pro to resize an image. To access the Resize 

dialog box, open the image and then select Resize from the Image menu. Keep in mind that smaller 

images result in smaller file sizes, which result in quicker download times. 

 

Fig8.Resizing images to actual sizes in Paint Shop Pro helps to minimize download Times 

Tip 

Usually, you‘ll want to ensure that the Maintain Aspect Ratio option (or its equivalent in your 

graphics program) is selected when you resize graphics; otherwise, you could distort your images. 



 

 

===================================================================== 

 

Try This! 

To experiment with resizing images, open a JPEG image in your graphics editor and then 

change the image’s width or height setting. Save the JPEG image, and then repeat the 

process a number of times using various measurements, renaming each version with a 

unique, meaningful name (such as apples400w.jpg for a picture that’s resized to 400 pixels 

wide). After you’ve created a few variously sized images, view the images locally in your 

browser window—that is, either navigate to the figures by using your browser’s Address 

toolbar or drag the JPEG images’ file name icons into your browser window. 

 

 

Sizing Images Just Right—A Quick Trick 

When you first start to design Web pages, you might not know what sizes your graphics should be. To 

help you resize a graphic to the size you want it to appear on your Web page, you can use a Web 

editing program, such as Microsoft FrontPage. 

To determine the optimal size for a Web graphic, follow these steps: 

1. Insert the graphic into a blank Web page in FrontPage (for example)and resize the picture by 

dragging the image‘s selection handles. 

2. After the image is sized to your liking, display the image‘s properties (in FrontPage, right-click the 

graphic and select Picture Properties on the pop-up menu), and note (and then write down) the 

image‘s height and width parameters. 

3. Reopen the image in your graphic‘s editing program and then resize the graphic by entering the 

numbers you copied from Front- Page (or other Web editing program) into the appropriate dialog box. 

For instance, in Paint Shop Pro, you open the Resize dialog box by choosing Resize on the Image 

menu, and, in MS Paint, you open the Attributes dialog box by choosing Attributes on the Image 

menu. 

 

 

 

 Cropping Images 

 

Definition: Cropping refers to cutting off a part of an image, such as unnecessary portions of a 

graphic 

 

In addition to resizing an image, you can crop an image to reduce its size. When you crop an image, 

you cut out the portion of the image that you don‘t want to use. Cropping is frequently used to remove 



any unwanted or unneeded portions of your photograph. For example, you might want to crop the 

apples.jpg image shown in Figure 9 to show a close up of the green apple amidst the red apples in the 

colander. Figure 10 shows crop lines (the dashed lines that surround the portion of the image you 

want to retain) in the apples.jpg image, which is 50 KB, and the result of cropping apples.jpg. The 

cropped version is only 6 KB 

 
. 

fig9-10 The crop marks indicate the portion of an image that will be used as a Web 

graphic. The cropped image contains only the information you bounded by the 

crop marks 

 

 

Try This! 

To crop an image, follow these steps: 

1 Open an image in your graphics editor. 

2 Click the selection tool (which usually looks like a dashed rectangle 

or square in the application‘s toolbar). 

3 Click and drag in your image to outline the area of the image you 

want to retain. (If you outline the wrong area, press Esc and try again.) 

4 After you have an area selected, choose Crop To Selection (in 

Paint Shop Pro) or Crop (in Photoshop) from the Image menu, or 

select a similar command in your graphics editing program 

  Thumbnails 

Definition: A thumbnail is a miniature version or small portion of a graphic. Frequently, on Web 

pages, thumbnail graphics are hyperlinked to larger versions of the graphic. 

After you master the art of resizing and cropping images, you‘re ready to use thumbnails. A 

thumbnail is a small picture that links to a larger image. (The larger image is usually the same as the 

thumbnail, but we‘ve seen some creative uses of thumbnails in our day.) When you use thumbnails, 

viewers can choose to view the small image and be done with it or they can click the thumbnail to 

view the larger image. In other words, when you use thumbnails, you grant viewers the option to 

download large images if they‘re willing to endure the longer download times. The trick to using 

thumbnails is to create two graphics with different names. Usually, you use the same image for both 



graphics, and you make one image small with a quick download time and the other image (while 

optimized to the best of your ability, of course) larger with a longer download time. Then you display 

the small image on your Web page, and you link the small image to the larger image. Figure 11 shows 

two thumbnails. The left thumbnail displays the entire linked image, and the right thumbnail shows a 

cropped portion of the linked graphic. Figure 11 also shows the larger graphic that‘s linked to the 

thumbnails. By clicking either thumbnail shown in Figure 11, you can open a window displaying a 

large view of the apples.jpg image. 

 

 

fig11. Both thumbnails of the apples link to a sizable rendition of the apples.jpg image. 

 

Using Photographs 

 

You probably have at least one boxful of prime Web art resources lying around your home 

photographs. You can use new and old photographs to add art to your Web pages. The trick is getting 

the hard-copy picture turned into information your computer can understand. To do that, you can use 

any of the following options: 

 Scanners Basically, a scanner takes a picture of your photograph and saves the 

Picture information as a file on your computer. After you have a scanned picture, you can manipulate 

the file just as you manipulate other graphics files. You can use any flatbed scanner on the market to 

create Web graphics. You don‘t need to get a top of- the-line machine, either. We use moderately priced 

scanners to scan most of our pictures. If you don‘t have a scanner and you aren‘t planning to purchase 



one, you can pay others to scan your pictures for you. For example, many copy centers also scan 

pictures for a small fee. 

 Film developers and online photo services The next time you drop off a roll of film  for 

development, 

check  out the services that the film developer offers. Many film developers can develop your film on 

CD, post your pictures to the Web, send your pictures this lesson  Creating and Using Art on the Web 

3.17 through e-mail, create quality prints from digital pictures, and provide numerous other digitizing 

services. 

 Digital cameras A third option for obtaining photographic images is to use a digital camera. Digital 

cameras enable you to snap a photo and then instantly send the picture into your computer.  

 

1.5 Wed Design Fundamentals 

  

 Online graphics are made up of pixels. 

 Most browsers support GIF and JPEG images. 

 GIF images are small, limited to a 256-color palette, and quick to download. 

 GIFs can be interlaced, transparent, or animated. 

 JPEG images can contain millions of colors and are frequently used to display photographs. 

 By default, GIFs and JPEGs display line by line from the top down, but you can change the 

default by creating interlaced GIFs or progressive JPEGs. 

 JPEG‘s compression scheme enables you to reduce the size of JPEG images, but the 

compression is ― lossy ,‖ so compress with care (remember, the more you compress, the 

lower your picture quality). 

 Size graphics in your graphics editing program to help make your Web page‘s graphics files 

as small as possible. 

 Cropping images reduces file sizes. 

 Consider using thumbnails to link to large online graphics. 

 Graphic Web page elements include photographs, illustrations ,buttons, logos, icons, bullets, 

horizontal rules, graphical text, and backgrounds. 

 You can acquire Web graphics from clip art collections on CD ROMs ,online freeware, 

online art vendors, and graphic designers. 

 You can create custom art by using various software programs as well as by scanning hand-

drawn art. 

 Photographs can be converted to image files by means of scanners ,film developers, and 

digital cameras. 

 

1.6 Summary 



 

Finally, as the last bit of advice in this lesson, regardless of how and where you obtain 

your Web page graphics, remember to optimize your images and save them as GIF and JPEG 

files. Make sure your images‘ file sizes are as small as possible without compromising quality. 

Furthermore, store your images in a central location on your hard disk, and don‘t forget to give 

every graphic a unique and meaningful name. 

 

1.7 Self-check Exercise   

 1. Discuss Web Graphics Issues. 

 2. What are the Graphics File Format. Explain with examples. 

 3. Explain briefly the important size matters of Graphics. 

 4. Write short note on:- 

  i) Cropping 

  ii) Thumbnails 

  iii) JPEGs 

  iv) GIFs 
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2.0 INTRODUCTION 

A formatting or markup language used to create documents for the World Wide Web 

(WWW). Hypertext Markup Language (HTML) in its simplest form uses tags to format 

ASCII (American Standard Code for Information Interchange) text documents by indicating 

text that should be displayed as boldface, italic, bulleted, hyperlinked, centered and so on. 

These tags usually come in pairs can be nested, can contain additional attributes and are used 

to ―mark up‖ the text. For example the text ―MANMOHAN‖ can be displayed on Web 

browsers in boldface by marking it up using the <STRONG> MANMOHAN</STRONG> 

HTML pages are saved as files with the extension .htm or .html in the appropriate directory 

on Web server such as Microsoft Internet Information Services (IIS). When a Web browser 

such as Microsoft Internet Explorer downloads an HTML page from a Web server, it 

interprets tags and displays the document with the appropriate formatting. 

HTML has gone through several versions since it was created in the early 1990s. at the time 

of this writing, the most current version is HTML 4.  The original HTML did not provide 

much control over how documents were formatted-that is, how objects such as text and 

graphics were laid out on a page. Its original set of tags was quite limited and was intended 

primarily for linking documents using hyperlinks to form hypertext. As the Web grew in 

popularity, however, first Netscape and then Microsoft introduced their own proprietary 

HTML tags to provide Web developers with more control over document formatting, thus 

increasing the pace at which the World Wide Web Consortium (W3C) developed the HTML 

standard. HTML 4 includes standards for creating cascading style sheets, which provides 

powerful formatting capabilities for precise placement of objects on a Web page.  

 

2.1 OBJECTIVES 

 This unit will help you to learn the: 

  World Wide Wide. 

  Hypertext Markup Language. 

  General HTML Page Layout Tags. 

  File Transfer Protocol. 

 

1.2 HISTORY OF HTML 

 

The first publicly available description of Hypertext Markup Language was a document 

called HTML Tags, first mentioned on the Internet by Berners-Lee in late 1991. It describes 



20 elements comprising the initial, relatively simple design of HTML. HTML is a text and 

image formatting language used by web browsers to dynamically format web pages. Many of 

the text elements are found in the 1988 and Berners-Lee considered HTML to be an 

application of SGML. It was formally defined as such by the Internet Engineering Task Force 

(IETF) with the mid-1993 publication of the first proposal for an HTML specification, 

"Hypertext Markup Language (HTML)". Further development under the auspices of the IETF 

was stalled by competing interests. Since 1996, the HTML specifications have been 

maintained, with input from commercial software vendors, by the World Wide Web 

Consortium (W3C). However, in 2000, HTML also became an international standard 

(ISO/IEC 15445:2000).  

 

2.3 VERSION OF HTML 

 

The history of HTML has gone through five basic interactions over the past several years. 

They are:  

 HTML 2.0: The early standards for HTML contained many of the core features still 

seen in today‘s version of the language. First published in 1995. 

 HTML 3.2: The first W3C recommendation (1997) for HTML, this version added 

popular features such as support for superscript, subscript, tables, and so on. It also 

provided backward compatibility for HTML 2.0. 

  HTML 4.0: This was an early gold standard for HTML and it is the version to which 

most early HTML programmers took hold. However, HTML 4.01 has since 

superseded HTML 4.0. The HTML 4.0 published in December 1997 and HTML 4.1 

in 1999.  

 HTML 5: HTML 5 was published as a working draft by the W3C in January 2008. 

A web page (also called a document) consists of objects. An object may be a HTML file, an 

image, a Java applet, a video clip, etc. that is addressable by a single URL. Most web pages 

consist of HTML files and several referenced objects or links. HTTP defines how browsers 

request web pages from servers and how servers transfer web pages to clients i.e., in essence 

it defines the interaction between the web client and the web server. When a user requests a 

web page (for example, clicks on a hyperlink), the browser sends HTTP request messages for 

the objects in the page to the server. The server receives the requests and responds with 

HTTP response messages that contain the objects. 



 

2.4 MARKUP LANGUAGES 

 

The most common method of creating a web documents is through the use of Markup 

Languages. Most of these are created by adding a set of formatting code to ASCII text to 

show fonts, justifications, links, etc. on the web. A markup language is a language that uses 

tags to indicate a change in presentation style or a change in content type. A mark up 

language describes explicitly. In sum, HTML describes explicitly the parts of the hypertext 

multimedia document, and the web client uses this information to construct the document on 

the user‘s screen. 

There are several types of markup elements used in HTML. 

 Structural Markup: Structural Markup describes the purpose of text. For example, 

<h2>Golf</h2> establishes "Golf" as a second-level heading, which would be 

rendered in a browser in a manner similar to the "HTML markup" title at the start of 

this section. Structural markup does not denote any specific rendering, but most web 

browsers have default styles for element formatting. Text may be further styled with 

Cascading Style Sheets (CSS). 

 Presentational Markup: Describes the appearance of the text, regardless of its 

purpose. For example <b>boldface</b> indicates that visual output devices should 

render "boldface" in bold text, but gives little indication what devices which are 

unable to do this (such as aural devices that read the text aloud) should do. In the case 

of both <b>bold</b> and <i>italic</i>, there are other elements that may have 

equivalent visual renderings but which are more semantic in nature, such as 

<strong>strong emphasis</strong> and <em>emphasis</em> respectively. It is 

easier to see how an aural user agent should interpret the latter two elements. 

However, they are not equivalent to their presentational counterparts: it would be 

undesirable for a screen-reader to emphasize the name of a book, for instance, but on 

a screen such a name would be italicized. Most presentational markup elements have 

become deprecated under the HTML 4.0 specification, in favor of CSS based styling. 

 Hypertext Markup: Its makes parts of a document into links to other documents. An 

anchor element creates a hyperlink in the document with the href attribute set to the 

link URL. For example, the HTML markup, 

<a href="http://en.wikipedia.org/">Wikipedia</a>, will render the word 



"Wikipedia" as a hyperlink. To render an image as a hyperlink, an 'img' element is 

inserted as content into the 'a' element. Like 'br', 'img' is an empty element with 

attributes but no content or closing tag. <a href="http://example.org"><img 

src="image.gif" alt="descriptive text" width="50" height="50"></a>. 

2.5 HYPERTEXT MARKUP LANGUAGE 

 

Documents on the web are generally coded in a markup language called Hypertext Markup 

Language, or HTML. HTML is derived from Standardized Markup Language (SGML)-a 

standard for adding tags that identify elements in a document such as headings, subheadings, 

chapters, paragraphs, and appendices. Like SGML, HTML is also used to describe the 

structure of a document. A number of HTML codes embedded in the document text explicitly 

describe the text, providing information to the web client about how to interpret it. For 

example, if the text has a heading code surrounding it, as in <hl>This is a title</hl>, then the 

web client knows that it should display this text by itself on one line in a large, bold face font. 

Other types of information that HTML code provides the web client include: 

 whether text is bolded or italicized 

 where line breaks and paragraph breaks are 

 whether a picture or graphic should be inserted, and where 

 whether a certain word or phrase on the page is a link to other documents 

HTML is based on SGML (Standard Generalized Markup Language), a much bigger 

document-processing system. You can think of HTML as being a sub-set of SGML. The 

primary focus of HTML is the content of the document, not its appearance. It is a language 

for describing structured documents. Most documents have common elements, for example, 

titles, paragraphs, lists. If you define the set of elements before you start writing, you can 

label the parts of the document with the appropriate name. These elements are labeled 

through the use of HTML tags. 

HTML does not describe the appearance or layout of the document the reason being that 

different browsers (Netscape, Mosaic, etc.) will ―read‖ the HTML information differently. 

The same document may appear differently in each browser. The number one prevailing rule 

of designing documents for the web is: Don‘t design your documents based on what they 

look like in one browser. Focus on providing clear, well-structured content that is easy to 

read and understand. 

LIST OF SPECIAL TAGS/COMMAND IN HTML 



Tags or Commands Use 

<html> Starting tag 

</html> Closing tag 

<title>…………..</title> For the title of web page 

<body>…………</body> Body text 

<h1>…………….</h1> Heading size 

<h2>…………….</h2> Heading size 

<b>…………..</b> Bold font 

<i>……………</i> Italic font 

<u>…………..</u> Underline font 

<body bgcolor=―red‖> Back Ground Color 

<font color=―white‖>…….</font> Font color 

<font size=―20‖>…….. </font> Font size 

<font face=―arial‖>……. </font> Font type 

<br>………</br> Line break 

<p>……….</p> Paragraph 

&nbsp; Space between word 

<h3 align=―left‖>……</h3> Left alignment 

<h3 align=―right‖>……</h3> Right alignment 

<h3 align=―center‖>……</h3> Center alignment 

<body background=tlss.bmp> Back ground 

<marquee><h1>……….</h1></marquee> Running letter 

<marquee 

behavior=―alternate‖scrolldelay>……………</marquee> 

Return running letter 

<img src=davvlogo.gif> Insert image  

<img src=davvlogo.gif width=500 height=400> Image size 

<hr width=50%> Lining 

<hr width=50% size=5> Lining with size 

 

2.6 DYNAMIC HTML 

 

The Dynamic HTML is a collective term for a combination of new Hypertext Markup 

Language (HTML) tags and options that will let you create web pages more animated and 



more responsive to user interaction than previous versions of HTML. Much of dynamic 

HTML is specified in HTML 4.0. Simple examples of dynamic HTML pages would include 

(1) having the color of a text heading change when a user passes a mouse over it or (2) 

allowing a user to ―drag and drop‖ an image to another place on a web page. Dynamic HTML 

can allow web documents to look and act like desktop applications or multimedia 

productions. The features that constitute dynamic HTML are included in Netscape 

Communications‘ latest Web browser, Navigator 4.0 (part of Netscape‘s Communicator 

suite), and by Microsoft‘s browser, Internet Explorer 4.0. While HTML 4.0 is supported by 

both Netscape and Microsoft browsers, some additional capabilities are supported by only 

one of the browsers. The biggest obstacle to the use of dynamic HTML is that, since many 

users are still using older browsers, a web site must create two versions of each site and serve 

the pages appropriate to each user's browser version. 

 

2.7 SEMANTIC HTML 

 

Semantic HTML is a way of writing HTML that emphasizes the meaning of the encoded 

information over its presentation. HTML has included semantic markup from its inception, 

but has also included presentational markup such as <font>, <i> and <center> tags. There 

are also the semantically neutral span and div tags. Since the late 1990s when Cascading 

Style Sheets were beginning to work in most browsers, web authors have been encouraged to 

avoid the use of presentational HTML markup with a view to the separation of presentation 

and content.  

In a 2001 discussion of the Semantic Web, Tim Berners-Lee and others gave examples of 

ways in which intelligent software 'agents' may one day automatically trawl the Web and 

find, filter and correlate previously unrelated, published facts for the benefit of human users. 

Such agents are not commonplace even now, but some of the ideas of Web 2.0, mashups, and 

price comparison websites may be coming close. The main difference between these web 

application hybrids and Berners-Lee's semantic agents lies in the fact that the current 

aggregation and hybridization of information is usually designed in by web developers, who 

already know the web locations and the API semantics of the specific data they wish to mash, 

compare and combine. 

An important type of web agent that does trawl and read web pages automatically, without 

prior knowledge of what it might find, is the Web crawler or search-engine spider. These 

software agents are dependent on the semantic clarity of web pages they find as they use 



various techniques and algorithms to read and index millions of web pages a day and provide 

web users with search facilities without which the World Wide Web would be only a fraction 

of its current usefulness. 

In order for search-engine spiders to be able to rate the significance of pieces of text they find 

in HTML documents, and also for those creating mashups and other hybrids as well as for 

more automated agents as they are developed, the semantic structures that exist in HTML 

need to be widely and uniformly applied to bring out the meaning of published text. 

Presentational markup tags are deprecated in current HTML and XHTML recommendations 

and are illegal in HTML 5. 

 

2.8 ATTRIBUTES 

 

Most of the attributes of an element are name-value pairs, separated by "=" and written within 

the start tag of an element after the element's name. The value may be enclosed in single or 

double quotes, although values consisting of certain characters can be left unquoted in HTML 

(but not XHTML).
 
Leaving attribute values unquoted is considered unsafe. In contrast with 

name-value pair attributes, there are some attributes that affect the element simply by their 

presence in the start tag of the element, like the ismap attribute for the img element. 

There are several common attributes that may appear in many elements: 

 The id attribute provides a document-wide unique identifier for an element. This is 

used to identify the element so that stylesheets can alter its presentational properties, 

and scripts may alter, animate or delete its contents or presentation. Appended to the 

URL of the page, it provides a globally unique identifier for the element, typically a 

sub-section of the page. For example, the ID "Attributes" in 

http://en.wikipedia.org/wiki/HTML#Attributes 

 The class attribute provides a way of classifying similar elements. This can be used 

for semantic or presentation purposes. For example, an HTML document might 

semantically use the designation class="notation" to indicate that all elements with 

this class value are subordinate to the main text of the document. In presentation, such 

elements might be gathered together and presented as footnotes on a page instead of 

appearing in the place where they occur in the HTML source. Class attributes are used 

semantically in microformats. Multiple class values may be specified; for example 

class="notation important" puts the element into both the 'notation' and the 

'important' classes. 



 An author may use the style attribute to assign presentational properties to a 

particular element. It is considered better practice to use an element‘s id or class 

attributes to select the element from within a stylesheet, though sometimes this can be 

too cumbersome for a simple, specific, or ad hoc styling. 

 The title attribute is used to attach subtextual explanation to an element. In most 

browsers this attribute is displayed as a tooltip. 

 The lang attribute identifies the natural language of the element's contents, which 

may be different from that of the rest of the document. For example, in an English-

language document:  <p>hi, <span lang="fr">c'est la vie</span>, as they say in 

France.</p> 

The abbreviation element, abbr, can be used to demonstrate some of these attributes: 

<abbr id="anId" class="jargon" style="color:purple;" title="Hypertext Markup 

Language">HTML</abbr> 

This example displays as HTML; in most browsers, pointing the cursor at the abbreviation 

should display the title text "Hypertext Markup Language." Most elements also take the 

language-related attribute dir to specify text direction, such as with "rtl" for right-to-left text 

in, for example, Arabic, Persian, or Hebrew. 

 

2.9 TAGS AND ATTRIBUTES 

 

An HTML tag is indicated by opening (<) and closing (>) brackets. Each tag contains various 

attributes, depending on the tag used. Look at the following sample HTML code: 

<font face="Arial‖ size="5"> This is an example of simple text. </font> 

The general form of an HTML element is therefore: <tag attribute1="value1" 

attribute2="value2">content to be rendered</tag> The name of the HTML element 

is also the name of the tag. Note that the end tag's name is preceded by a slash character, "/". 

If attributes are not assigned, default values are used. 

Element examples; 

Header of the HTML document:<head>...</head>. Usually the title should be included in the 

head, for example: 

<head> 

<title>The title</title> 

</head> 



 

 

 

 

Tags and attributes in HTML 

 The tag in this example is the <font> tag. Notice the closing </font> tag as well. This 

tag will affect everything between the operating and closing <font> tags. (In this case, 

the text ―This is an example of simple text‖ would be affected.) 

 The attributes of the <font> tag are, in this case, the font face (which is set to Arial) 

and the font size (5, or 12-point text). Note that in many instances in HTML there is a 

numerical reference-especially with text formatting-to usual ―point‖ reference in text.   

Another example: 

<font face="Arial‖ size="5"> <a href=" http://rediffmail.com">Click here to go to 

Rediffmail! </a></font> 

 This example uses two different tags. The first as you saw just a moment ago, is the 

<font> tag. The second is the <a href> tags, which is used to set a hyperlink. 

 The attributes of the two tags should be apparent. In the case of the <font> tag, the 

attributes are the same as in the previous example (Arial font size 5). For the <a href> 

tag, the attribute is the URL of the hyperlink (in this case, http://rediffmail.com). Note 

that with the <a href> tag, the inclusion of the actual URL (in this case 

http://rediffmail.com) all text that subsequently follows up until the closing </a> tag is 

what will be presented on the Web page as actual hyperlink. 

This code listing as also an example of nested tags ot the process of placing more than one 

tag within another tag. While you can‘t nest all tags (as you will see when you work with 

HTML tables), the important thing is to keep an eye on the order in which you open and close 

your tags. For example look at the following two lines of code: 

 

<a href =" http://rediffmail.com">Click here to go to Rediffmail.com</a>----------------You 

may find useful links. 

<a href =" http://rediffmail.com">Click here to go to Rediffmail.com----------------You may 

find useful links. </a> 

Although the two lines of code appear very similar, note that in the first one, the closing </a> 

tag is placed in different location than in the second example. As you can see in Figure 1 this 



has a major effect-the text that comprises the hyperlink is different due to the placement of 

the closing </a> tag.  

 

Figure 1: Text formatting and HTML Effect 

 

2.10 GENERAL HTML PAGE LAYOUT TAGS 

 

Every  HTML page should have some basic tags. 

 <HEAD>: Think of this tag as the container for all of the general layout information 

for your page. Within the <HEAD> and </HEAD> tags you will find general 

information about page.  

 <TITLE>: This is where you assign the all important title to your Web page. It‘s easy 

to overlook this tag, so you should be careful that you don‘t the title of a page will 

appear at the top of the browser window and is thus an important navigation element 

to let visitors to your Web site know where they are. 

 <Body>: This is where most of your HTML code is placed as such; it corresponds to 

the body of your Web page content.  



In the following code you can see a document template that is often produced by default in 

HTML editors. This template outlines the use of the primary HTML tags. 

<html> 

 

<head> 

<meta http-equiv="Content-Type" content="text/html; charset=windows-1252"> 

<meta name="GENERATOR" content="Microsoft FrontPage 4.0"> 

<meta name="ProgId" content="FrontPage.Editor.Document"> 

<title> New Page 1</title> 

</head> 

 

<body> 

</body> 

 

</html> 

 

Headings 

HTML headings are defined with the <h1> to <h6> tags: 

<h1>Heading1</h1> 

<h2>Heading2</h2> 

<h3>Heading3</h3> 

<h4>Heading4</h4> 

<h5>Heading5</h5> 

<h6>Heading6</h6> 



 

Figure 2: View of HTML Headings 

Paragraphs 

One can make paragraphs using the following syntax.  

<p>Paragraph 1</p>  <p>Paragraph 2</p> 

 

Line breaks 

<br>. The difference between <br> and <p> is that 'br' breaks a line without altering the 

semantic structure of the page, whereas 'p' sections the page into paragraphs. Note also that 

'br' is an empty element in that, while it may have attributes, it can take no content or end tag. 

For example; <code><p>This <br> is a paragraph <br> with <br> line breaks</p></code> 

Comments: <You can give explanation here > 

Comments can help understanding of the markup and do not display in the webpage. 

 

 

 

Utilizing the <META> Tag 

<META> tags are quite useful in providing information about the contents of your page so it 

can be picked up and properly indexed by various search engines.  

 



<meta name="keyword" CONTENT="rock music, 1990s, popular culture, steely Dan"> 

<meta name="description" CONTENT="A retrospective analysis of the rock group Steely 

Dan"> 

<meta name="author" CONTENT="Bill Lee"> 

<meta name="generator" CONTENT="Microsoft FrontPage 4.0"> 

 

The Text Alignment Attribute 

HTML include an align attribute that allows you do some basic text alignment in your Web 

pages. As with everything else the best way to see this attribute in action is to look at a code 

example. 

<p align="left"> This text is left aligned.</p> 

<p align="center"> This text is center aligned.</p> 

<p align="right"> This text is right aligned.</p> 

 

Figure 3: Text Alignment on Web Page 

 

Nested Lists 

Lists can be nested. You can also have a number of paragraphs, each containing a nested list, 

in a single list item. 



Here is a sample nested list: 

<UL> 

<LI> A list of single person games: 

<UL> 

<LI> Tenis  

<LI> Chess 

<LI> Kusti 

<LI> Shooting 

</UL> 

<LI> A list of team games: 

<UL> 

<LI> Cricket 

<LI> Hocky 

<LI> Footbal 

<LI> Kabaddi 

</UL> 

</UL>  



 

Figure 4: Display of Lists Tags 

 

Numbered and Bulleted Lists 

Numbered and bulleted lists are probably the most common advanced text for matting that 

you will find on a Web page. Although they are a bit more complicated to use than some of 

the other tags. For bulleted list you use the opening <ul> and closing </ul> tags. Then you 

surround each item you want to individually bullet with opening <li> and closing </li> tags. 

Numbered lists are very similar except that you use opening <ol> and closing </ol> tags to 

denote them. However just like the bulleted list, you use opening <li> and closing </li> tags 

to individually number each item.   

Take a look at the following code, which illustrates the use of both numbered and bulleted list 

formatting.  

<p> The following are the good place for shopping in India:</p> 

<ul> 

<li> New Delhi </li> 

<li> Mumbai </li> 



<li> Kolkata </li> 

<li> Chennai </li> 

<li> Pune </li> 

</ul> 

 

<p> The following are the most tourist place in Summer:</p> 

<ol> 

<li> Shimla </li> 

<li> Rohtang </li> 

<li> Kullu </li> 

<li> Manali </li> 

<li> Jammu and Kashmir </li> 

</ol> 

 

Figure 5: View of Numbered and Bulleted Lists Tags 

 

Definition Lists 



A definition list (coded as <DL>) usually consists of alternating a definition term (coded as 

<DT>) and a definition description (coded as <DD>). Web browsers generally format the 

definition on a new line and indent it. 

The following is an example of a definition list: 

<DL> 

<DT> M.P. Bhoj  

<DD> M.P. Bhoj, Madhya Pradesh Open Bhoj University is located in Bhopal. 

<DT> NISCAIR 

<DD> NISCAIR, the National Institute of Science Communication and Information 

Resources is located in New Delhi.  

</DL> 

 

Figure 6: Output of Definition Lists Tags  

The <DT> and <DD> entries can contain multiple paragraphs (indicated by <P> paragraph 

tags), lists, or other definition information. 

 

Mailto Attribute 



You can make it easy for a reader to send E-mail to a specific person or mail alias by 

including the mailto attribute in a hyperlink. To create a mail window that is already 

configured to open a mail window for the Emerald Group Publications alias. The syntax is: 

<A HREF=‖mailto:infompbhoj@host‖>Name</a> 

For example; <A HREF=‖mailto:pubs@emerald.com‖>Emerald Group Publications</a> 

 

 

 

Absolute and Relative URLs 

The URL (Uniform Recourse Locator) is a major building block of the Web. First you need 

to be aware of the difference absolute and relative URLs and how each one can affect your 

HTML coding. In an absolute URL, the address includes the entire file location (including the 

server name). A relative URL only shows the file name relative to the current location. For 

example: 

http://www.smsweb.com/smsfolder/smsfolder_2smsfile.html 

smsfile.html 

/smsfolder_2/smsfile.html 

../smsfolder_2smsfile.html 

The first line here is an absolute URL, it shows the entire path to the file (smsfile.html) 

The second, third and fourth listings are all relative URLs; they show a URL that is relative to 

a current location. What exactly does that mean? Put simply, depending on where your file is 

stored in a relative URL you can assume that the location of the file will vary depending on 

the full file path. (In the third line of code the ―../‖ represent the complete file path). 

Relative URLs come in handy if you are moving your file around because you don‘t have to 

worry about coding the full path, which might change anyway. For example, if you have a 

URL that points to http://www.serverA.com/folder_A/file.html and you move it to a new 

server, so that the path is now http://www.serverB.com/folder_A/file.html, you could use a 

relative URL when making the initial link. Instead of typing the full URL, you could use the 

relative URL ../file.html; in this case when you move from server A to server B the link to 

your file remain active. 

However if you had typed the absolute URL (the full path name) you would have to retype it 

for the link to your file.html file to remain the same.    

 



2.11 TABLE STRUCTURE 

 

A table is market at its beginning with a <table> tag and at its end with a </table> tag. A table 

can contain a variety of row and column definitions within. However there are few things to 

note. First only the <table> tag needs to closed with </table/>; otherwise the browser doesn‘t 

know when to stop table formatting. Second, the table row (<tr>) and table data (<td>) cell 

can accept their respective closing tags, but they are not required. A new row or data cell 

automatically marks the end of the previous roe or data, except in legacy versions of some 

browsers. Following are the steps to create table. 

 Create a new folder called Table. 

 Open your Inetpub folder and create a new page called FirstTable.html. Save this 

page in your newly created Table folder. 

 On your FirstTable.html page, enter the following HTML exactly as it appears 

below: 

<html> 

<head> 

<title>working with Table</title> 

</head> 

<body> 

<table border="2" bordercolor="#ff0000" width="100%" cellpadding="2" 

bordercolorlight="#008000" bordercolordark="#008000"> 

  <tr> 

     <td width="50%">1</td> 

     <td width="50%">2</td> 

  </tr> 

  <tr> 

   <td width="50%">3</td> 

   <td width="50%">4</td> 

  </tr> 

  <tr> 

   <td width="50%">5</td> 

   <td width="50%">6</td> 

</table> 



</body> 

</html> 

 Save the page again and open it in your Web browser. Your screen should appear 

similar to Figure 7.  

 

 

Figure 7: Structure of Table Using HTML Tags  

 

In addition to the core, International and event attributes, a table has the following options: 

 Summary: This is one of the few attributes for tables that haven‘t been deprecated, 

because it has nothing to do with a table‘s appearance. The summary attribute defines 

a text string that gives a brief description of what the table contains. 

 Align: This is the standard alignment attribute, now deprecated, which accepts values 

of left, right or center to control placement on the page. Most browsers default to a 

left or center alignment. 

 Width: The width of the table, expresses in pixels or as a percentage of the browser 

window width. For example, a table tat occupies half of the available window is 



marked with width="50%", and a table 500 pixels wide is expressed as width="500". 

The default is just wide enough to handle the longest content in each column. For 

browsers that support progressive table display, setting the width attribute allows the 

browser to display the table as its retrieved, rather than waiting for the entire table.  

 Cols: This attribute is new in HTML 4. It tells the browser how many columns are 

included in the table. In the past, the browser had to wait until the entire table was 

loaded to begin rendering it. 

 Frame: This attribute, a companion to the border attribute, determines where a frame 

surrounding the table should display. Its possible values are void (none), above (top 

side), below (bottom side), hsides (horizontal sides), lhs (left-hand side), rhs (right-

hand sides), vsides (vertical sides), and box or border (all sides).  

 Border: The attribute sets the width of a border around the table in pixels. The default 

varies with each browser but is typically two or three pixels. If you don‘t want a 

border, use a value of 0.  

 Rules: This attribute determines where lines are used to separate cells within the table 

itself. Its possible values are none, groups (between logical groups such as TBODY 

and THEAD), rows (between each roe), col (between each column), and all (between 

all cells).  

 Cellspacing: Identified in pixels, this attribute determines the amount of space 

between cells. As a side effect, it sometimes determines the width of the rules 

between cells, too. 

 Cellpadding: Similar to cellspacing and also identified in pixels, this attribute sets the 

amount of space between the edge of the cell and the actual cell content.   

 

 

2.12 FILE TRANSFER PROTOCOL (FTP) 

 

FTP is a standard Internet protocol. It is the simplest way to exchange files between 

computers on the Internet. Like the Hypertext Transfer Protocol (HTTP), which transfers 

displayable web pages and related files, and the Simple Mail Transfer Protocol (SMTP), 

which transfers e-mail, FTP is an application protocol that uses the Internet's TCP/IP 

protocols. FTP is commonly used to transfer web page files from their creator to the 



computer that acts as their server for everyone on the Internet. It‘s also commonly used to 

download programmes and other files to your computer from other servers. 

As a user, you can use FTP with a simple command line interface (for example, from the 

windows MS-DOS Prompt window) or with a commercial programme that offers a graphical 

user interface. Your web browser can also make FTP requests to download the programmes 

you select from a web page. Using FTP, you can also update (delete, rename, move, and 

copy) files at a server. You need to log on to an FTP server. However, publicly available files 

are easily accessed using anonymous FTP. Basic FTP support is usually provided as part of a 

suite of programmes that come with TCP/IP. However, any FTP client programme with a 

graphical user interface usually must be downloaded from the company that makes it. 

File transfer between machines running TCP/IP; these machines may or may not be running 

the same operating system. Many FTP Servers allow one to download files without having an 

account on the machine by having anonymous or FTP for a user name and the e-mail address 

for the password. This is a major means of distributing software and information on the 

Internet. 

FTP ip address, i.e., FTP 202.141.130.67 

FTP>PUT ―filename‖ 

FTP>GET ―filename‖ 

FTP>BYE 

 

 

 

 

2.13  SUMMARY 

 

The libraries and information centres can develop and design their own Web pages and host 

them on the Internet to gain visibility as well as provide access to their local OPAC. 

Technologies like HTML, DHTML, and XML help in creating and designing Web pages.  

Uniform Resource Locator, know by a variety of similar names are techniques for 

establishing Internet address where files and other resources can be located. A through 

understanding of the different URLs and their proper use is essential for good Web design. It 

is necessary one should know at least basic HTML tags to put the information on Internet. 

Though HTML has certain problems associated with it for example, inability to handle 

efficient search, but still it is widely used for web page design. The XML preserves the 



context of the term as well as its semantics. An XML file also like HTML is a plain ASCII 

file, where one can define his/her own tags. 

 

2.14 Self-check Exercise 

 1. Write an essay on HTML. 

 2. What do you understand by general HTML page layout tags? 

 3. What is File Transfer Protocol (FTP)? 

 4. Write short note on:- 

  a. Tags         b. Attributes 
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1.0 INTRODUCTION 
The development of digital computing and of the Internet represents two of 

mankind‘s greatest technological achievements and though they are thoroughly 

modern, their development can be traced back over decades and even centuries.  

Computing captured the public imagination in the late 1950s and early 1960s 

with the image of the mainframe computer attended by white-coated technicians 

pointing the way to a future of corporate and social efficiency focused around 

―Oraganisation Man‖. Later in 1960s, computer becomes associated with militarism, 

and particularly the Vietnam War. In the United States computers were also 

associated with a faceless, grey corporatism that constricted the human spirit and 

robotic production lines that did workers out of jobs. By the mid-1970s, however the 

younger siblings of the anti-War protesters were using their wits to master 

information technology and subvert the system. 

As the rebellions of the 1960s lost their idealistic edge, computers came to be 

seen as alternative tool for human advancement. Steve Jobs, with whom Woznial 

teamed up to found Apple, summed up this change when he noted that ―I‘m one of 

those people who think that Thomas Edison and the light bulb changed the world a lot 

more than Karl Marx ever did‖. 

Over a century before computers came to the attention of the public, Charles 

Babbage devised a mechanical computer, precisely a calculator, known as “The 

Difference Engine” and thereafter inventions grown up.  

Web design is a broad term used to encompass the way that content (usually 

hypertext or hypermedia) that are delivered to an end-user through the World Wide 

Web, using a web browser or other web-enabled software is displayed. The intent of 

web design is to create a website—a collection of online content including documents 

and applications that reside on a web server/servers. The website may include text, 

images, sounds and other content, and may be interactive. 

Designing for the web is the most significant new area of design for the last 20 

years. The fluidity in this new area allows design to assume a more prominent role in 

business and society. In fact, design for the web shares with other disciplines a view 

of design as a way of thinking, a service provided to a client for the benefit of others, 

an understanding of constraints, a series of problem-solving methods and processes, 

and an activity whose success is to some degree, measurable. 

http://en.wikipedia.org/wiki/Web_content
http://en.wikipedia.org/wiki/Hypertext
http://en.wikipedia.org/wiki/Hypermedia
http://en.wikipedia.org/wiki/End_user_(computer_science)
http://en.wikipedia.org/wiki/World_Wide_Web
http://en.wikipedia.org/wiki/World_Wide_Web
http://en.wikipedia.org/wiki/Web_browser
http://en.wikipedia.org/wiki/Website
http://en.wikipedia.org/wiki/Document
http://en.wikipedia.org/wiki/Web_application
http://en.wikipedia.org/wiki/Server_(computing)
http://en.wikipedia.org/wiki/Server_(computing)


The concept of hypertext took hold in academia and research circles and even 

saw the commercial light in products such as Apple‘s HyperCard information 

organizing software developed by Bill Atkinson in the mid-1980s. However, the 

factor that would help hypertext come of age, most notably a universal network 

weren‘t yet in place. 

By the mid-1970s, Vinton Cerf and Bob Kahn had created a set of protocols 

(TCP/IP) that managed the structuring and movement of data between computers, and 

as early as 1982 the newly formed Sun Microsystems, whose catchphrase was ― The 

network is the computer‖, was building TCP/IP into its Unix-based workstations. In 

1972, Ray Tomlinson, working at BBN, created an email application, which went on 

to become the ―killer application‖ of the internet (as ARPANET came to be known) 

and the following year a connection was made to University College London, and the 

network continued to spread via cable and satellite.  By the late 1980s, the ground has 

been laid for the commercial use of the internet, and services such as MCI Mai, 

Prodigy, Compuserve and AOL were offering access to email and online information, 

albeit using their own proprietary protocols and networks. In the md-1990s the US 

Government funding for the internet ceased. 

The concept of hypertext hadn‘t gone away, and in 1990 an Oxford physics 

graduate, Tim Berners-Lee, working at the European Nuclear Research Oraganisation 

, CERN, in Geneva, invented the World Wide Web ( with considerable support from 

his colleague Robert Cailliau). The first Web browser was created on NeXT, the 

computer  Steve Jobs created when he was forced out of Apple (and to which he 

subsequently returned when Apple acquired NeXT), and it was able to both view and 

edit Web pages. 

The first Web browser were ‗text-only‘, prompting students at the University 

of Illinois, Center for Supercomputing Application (NCSA), led by Marc Andreesen, 

to create a graphic browser known as „Mosaic‟ and the  research work was funded by 

Apple and was taken up by Ex-Stanford Professor and silicon Graphics co-founder 

Jim Clark who with Andreesen and few of his colleagues, founded Netscape 

Communication Corporation in Silicon Valley. The ability to download its navigator 

browser led to its rapid establishment as the browsers of choice for internet users, and 

in 1995 the company launched and the Web was born.  

 



1.1 OBJECTIVES 

 
After going through this unit you will be able to: 

 Perceive the need of web designing. 

 Identify the history of Web Designing. 

 Assess the importance of various critical issues during Web Design. 

 Examine the importance, types and process of linking of web sites. 

 

 

 

1.2 HISTORY OF WEB DESIGNING 

Believe it or not but website design does not have such a long history. That's 

basically because the Internet has not been around that long and it is only in the past 

decade that the Internet has exploded and become part of people's everyday lives. So, 

website design is still new in the grand scheme of things, but it has certainly 

undergone many changes over the years. 

The History of Web Designing has evolved over a matter of one and a half 

decades as of now. By the late 1980s, the Internet was being introduced as a means of 

communication for anyone with a computer, modem and telephone line. In 1993, a 

new freeware browser program called Mosaic was developed. The success of the 

program amazed everyone. Within one year, about two million people used the 

program to view documents they could access via the Internet. The documents were 

designed to be viewed using hypertext markup language, or HTML. The first 

websites, now called "first generation sites," had limited graphics, a lot of text and a 

linear layout. Their function was to deliver information, not to entertain or amaze 

viewers. During that time, the websites were delivered via dial-up modems over 

telephone lines. Modems had a very slow transfer rate, so web pages had to have 

small file sizes for easier accessibility. 

Website designing was previously a matter of debate as to whether it was the 

job of a programmer or a designer. After the initial hype over the website media and a 

confused phase of both developers and clients, web communication today has evolved 



as one of the most diversified and successful medium of  advertisement and 

knowledge outsourcing. However, the history of web designing germinated from 

CERN, a renowned physics institute, where Tim Berners Lee was working. The credit 

of development of the WWW goes o this man.  

While design for the web is a new area of practice. The most aspect of design- 

communication-based problem solving for the client – exist logically prior to the 

choice of media in which the problem might be solved.  

As markup language and HTML became more and more complex, you started 

seeing images and graphics on many of the web pages.  CSS or Cascading Style 

Sheets created a table layout that was easily arranged. 

 

1.3 CONCEPT OF DESIGNING 

1.3.1 Purpose  

The purpose of web design is to facilitate communication between user and 

content. It is essential to define the purpose of the website as one of the first steps in 

the planning process. A purpose statement should show focus based on what the 

website will accomplish and what the users will get from it. A clearly defined purpose 

will help the rest of the planning process as the audience is identified and the content 

of the site is developed. Setting short and long term goals for the website will help 

make the purpose clear and plan for the future when expansion, modification, and 

improvement will take place. Measurable objectives should be identified to track the 

progress of the site and determine success.  

Web design is primarily a design to create a website. The website is collection 

of e-documents and multiple applications which, when shaped up according to the 

design, stay at a web server to provide contents and interface to the end user, when 

requested through the internet browser. In simple words web design is a blueprint to 

create a web page or a web site for that matter.  

A web design when being designed by a designer is called web designing. 

Web site or the web page mainly depends upon the web design. The design is required 

to be such which can keep the main page less heavy so that it can load at the low 



speed also and the links and the sub pages be designed in a way that the end user does 

not have to wait for much time to see the page. A web design is required to cater for 

the aim of the web site on which the website is planned. The aim here means the 

target for which the design is being made, who all do you want to attract through this 

website, what all provisions you going to promise to your target viewers and what do 

you want your target viewers to do when they enter your site. 

Creative designs can attract a web visitor, but it cannot cast any major 

influence on the buying decision of the web visitor because the website has failed to 

address the target audience. So before a website designer decides to start working on a 

particular website design they need to analyze about the potential target audience are 

and to whom they are trying to communicate through this website. 

It is obvious that you are creating a website to register your web presence and 

you intend to attract web visitors to know about your services. So it becomes your 

responsibility to make the visitor understand what your website design is trying to 

convey to them and what is it all about? After finding the group of people who are 

likely to visit your website the next important phase for the web designer is to define 

the remaining part of your website development. Like who will read your contents? 

Which graphics and sounds will be appreciated? What keywords will bring you more 

visitors and all? Once you identify your target audience it is really important to 

understand that you cannot communicate with everyone around, which means if you 

are targeting a woman then it will not be useful for the men to read through your web 

pages. 

So web designer should wait to analyze the pros and cons of particular web 

design initiative. It does not matter what kind of website a website designer envisions 

but they can determine their audience. So it‘s important to design a website which 

communicates with the beginners. 

Website design gains momentum if it is interactive. Interactivity is possible 

only when you reach out to your target audience in reality to understand their views 

and their needs. So interviews or surveys some of your target audience will help you 

to pick the insights. This lessens the issues or errors in the final project. Remember 



the end user to finally approves your web design is the person with whom you are 

trying to communicate, not the person who is paying you. 

1.3.2 Audience 

The audience is the group of people who are expected to visit your website – 

the market being targeted. These people will be viewing the website for a specific 

reason and it is important to know exactly what they are looking for when they visit 

the site. A clearly defined purpose or goal of the site as well as an understanding of 

what visitors want to do or feel when they come to your site will help to identify the 

target audience. The webmaster should analyze his prospective audience in light of 

the message he is attempting to convey. You must be concerned with the range of 

ages represented in your visitors, the education and experience of this audience and 

their knowledge and opinions on your main theme. 

Probably the most important decision about your site will decide what people 

you want to attract, i.e. your target audience. Your site can't do everything for 

everybody.  You will have to focus on the people who are most important. Everything 

about your site should be designed to bring those people to your site and to keep them 

coming back. As you characterize the visitors to your site, consider the following: 

 Age 

 Sex 

 Religious aspects  

 Ethnic backgrounds  

 Economic situations  

 Computer and modem equipment they will likely have 

 Applicable jargon or buzz words that your visitors will likely (or won't) know 

 Geographic locations 

 Interests and hobbies 

 Their needs and reasons for coming to your site 

According to the Netcraft Web Server Survey, as of December 2009 there are 

around 233,848,493 websites are available on World Wide Web. There has been an 

increase of 47 million hostnames and 7 million active websites over the last 12 



months. In the month of December 2009 netcraft has received responses from 

233,848,493 sites, which is an increase of 212000 since last month. This means that 

more than 2 lakh websites got added on internet in last one month. Netcraft is an 

Internet services company based in Bath, England. It provides web server and web 

hosting market-share analysis. However, the company is famous for its free anti-

phishing toolbar for the Firefox and Internet Explorer browsers. 

1.3.3 Sketching On Paper Through Designs In Photoshop 

Sketching is one of the many ways humans have adapted to, to express and 

expand on ideas. A sketch is more like bringing an idea to a three dimensional view 

rather than imagining it in the head, which causes our idea to evolve over time as we 

forget certain elements of our ideas, and replace them with things we thought were 

part of the idea or ideas. Sketching helps us change our ideas to make them more 

reasonable where they can become a reality, and gives us a general outline when we 

bring our design ideas to say, Photoshop.  

Great design ideas should always be sketched out to be better formulated and 

somewhat finalized before brought to the digital world. This helps us develop on our 

design idea, which actually helps us provide a better end result or product, than that of 

whom did not sketch the idea.  

It may be further explained as under: 

 Eliminates Time Wasted 

One obvious factor or benefit of sketching your design ideas is that it 

eliminates time you could have wasted; however, even the greatest ideas need 

refining. Sketching enables you to plan before actually starting to design. It allows 

you to get a better overlook on how it will turn out, and if you do not like how the 

design idea is turning out on paper, or the idea may not be reachable or feasible, you 

have not spent the time actually bringing it to life in Photoshop, but rather just a half 

hour throwing it on paper for achieving the purpose. 

 Helps Expand On Our Ideas 



Whenever we imagine ideas, they are usually the skeleton of what the end 

result can be. However, when you take an idea directly to Photoshop, you do not quite 

have the brainstorming you would if you brought it to paper to expand on it, and thus 

great ideas are often suppressed and lost, making your great idea turn into an 

exceptional idea or design , by bringing your designs from mind directly to paper, it 

gives you a completely new and different level of how you visualized it, allowing you 

to expand on your ideas for the design often bringing it from exceptional, to a 

mesmerizing drool-worthy design. Therefore, it is definitely worth the time and effort 

to sketch your ideas out before making them a reality. 

 Helps With Group Feedback 

When we spend hours and days and weeks bringing an idea to life in 

Photoshop, we are generally not open to major feedback that will attempt to overhaul 

all the work, effort, and time we have put into it to bring it to life already. We would 

just reject credible and excellent feedback if it means we need to change a huge chunk 

of our design such as a structural change, or we would be forced to perform these 

major changes by a design firm, which causes delays in the completion of the design 

project. However, when you sketch your ideas on paper or on a whiteboard, your 

group can provide feedback allowing you to bring changes to the sketch in seconds 

helping make your design an excellent piece of work in the end. Many new great 

ideas whether design or not are structured by brainstorming on paper first with their 

group before going forth and bringing some sort of prototype to life. 

 Increases Creativity 

A sketch on paper acts like your design prototype for your idea or ideas. This 

allows you to quickly expand on it by using your creativity before actually bringing it 

into Photoshop or to the browser for a graphical preview. This also happens to save 

you time from manipulating your prototype in a graphic editing program rather than 

on paper which tends to only take several seconds rather than several hours. 

 Design Evolution 



One great thing about sketching out your design ideas is that later on you can 

look back and see how your design has evolved, from sketch, to prototype, to the final 

product. This not only is just for personal satisfactory, but it actually helps you 

improve on your final product months down the line. When we design websites, we 

tend to design them specifically for the content we need for that website at that 

current point in time, however, our sketches often contain different content containers 

before we scratched them out. By going back and looking at our sketches when we are 

looking for ideas or how our design or designs evolved, it will actually help us bring 

the containers we eliminated into our current design if we decided we needed such 

containers or elements later on. 

1.4 CONTENT OF DESIGN    

Content evaluation and organization requires that the purpose of the website 

be clearly defined. Collecting a list of the necessary content then organizing it 

according to the audience‘s/viewer‘s needs is a key step in website planning. In the 

process of gathering the content being offered, any items that do not support the 

defined purpose or accomplish target audience objectives should be removed. It is a 

good idea to test the content and purpose on a focus group and compare the offerings 

to the audience needs. 

The next step is to organize the basic information structure by categorizing the 

content and organizing it according to user needs. Each category should be named 

with a concise and descriptive title that will become a link on the website. Planning 

for the site's content ensures that the wants or needs of the target audience and the 

purpose of the site will be fulfilled. 

1.5 LINKING OF WEBSITES 

In computing, a hyperlink (or link) is a reference to a document that the reader 

can directly follow, or that is followed automatically. A hyperlink points to a whole 

document or to a specific element within a document. Hypertext is text with 

hyperlinks, and is commonly viewed with a computer. A software system for viewing 

and creating hypertext is a hypertext system, and to create a hyperlink is to hyperlink 

(or simply to link). A user following hyperlinks is said to navigate or browse the 
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hypertext. Hyperlink has an anchor, which is the location within a document from 

which the hyperlink can be followed; the document containing a hyperlink is known 

as its source document. The target of a hyperlink is the document, or location within a 

document, to which the hyperlink leads.  

Users can activate and follow the link when its anchor is shown, usually by 

touching or clicking on the anchor with a pointing device. Following the link has the 

effect of displaying its target, often with its context. The most common example of 

hypertext today is the World Wide Web: WebPages contain hyperlinks to WebPages. 

For example, in an online reference work such as Wikipedia, many words and terms 

in the text are hyperlinked to definitions of those terms. Hyperlinks are often used to 

implement reference mechanisms, such as tables of contents, footnotes, 

bibliographies, indexes and glossaries. 

 TYPES OF LINKING 

1.5.1 Internal Linking  

One major search engine company will purge pages that you have indexed. 

One month you'll have 100 pages in the indexes, and the next month it purges all but 

three or four of your web pages. Now you either have to scramble and resubmit the 

indexed pages with links to all your other pages. 

To get around this, cross link your web site (internal linking) where every 

single page has links to all your other pages. Then, even if only one page remains in 

the index, when the spider comes crawling to update, all your other pages will be 

found again, automatically. 

If the engine is a spider it will crawl and add your other pages to its index. 

Being cross linked gives your pages a greater chance of being catalogued and having 

your pages ―stick‖ in the index. Some search engines even prefer this method of 

―finding‖ your pages rather than having you announce them to their submission areas. 

When you are designing your own site, it is essential to understand that people 

will be book marking and linking to any and every page that you have got. Thus, your 

navigation and overall design must allow visitors to move around freely on your site 
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regardless of which page they land upon. This can be accomplished by having the 

main navigation appearing on every page. Within the body of your content, also have 

links to other pages within your site. 

 

 

 

1.5.2 Reciprocal Links (External Links) 

Reciprocal links are links with other sites, which are generally related to the 

theme of your web site. In such cases you link to the site, and that site‘s webmaster 

returns the favour and links back to your site. For some reason or another you always 

receive a lot more traffic from other sites, and then you give out. 

This method of traffic building is very important and its free, its simply a 

matter of contacting the right webmasters and getting the right links. However a full 

blown 'link-hunt' can be time consuming but the benefits it can bring are huge. 

 

1.6 NEED OF CROSS LINKING 

For popularizing the website it is always essential to follow some tactics. One 

of such issue is cross linking. The basic requirements of cross linking are as follows: 

1.6.1 Highly targeted visitors 

 The visitors that come from related web sites are highly targeted. You have a 

much better chance of attracting them for showing your activity or service, because 

they have come to your site through a link on a related web site. They will be 

interested in your sites theme, otherwise they wouldn‘t click through if they weren‘t 

interested. So these are prime prospects for your activity or service and best of all you 

don‘t have to pay for a single one. 

1.6.2 Better search engine rankings 



  Some major search engines (like Google) are using the number of links to a 

site as an important factor in establishing a site‘s ―relevancy‖, ―link popularity‖ or 

―link density‖. They all have slightly different meanings, but what they all mean is 

that the links leading to and from your web site, are being analyzed, assessed, 

evaluated and then ranked, to determine where your site should come up in search 

results. The more links a site has to more valuable it must be. 

1.6.3 Repeat traffic 

  Reciprocal links will assist in drawing repeat traffic back to your web site. If 

you offer a high-quality list of relevant links, visitors will return often because they 

know that they can quickly find what they‘re looking for. 

1.6.4 Added Value for the visitors 

  A high-quality links directory benefits your visitors by saving them from 

searching the web.  

 

1.7 METHODS OF LINKING 

There are two prominent methods for linking your web site with the other sites. These 

methods are: 

1.7.1 Proactive: Here you actively search out web sites that would complement your own, 

and send a note to the owner asking to swap links.   

1.7.2 Passive: While with this method you wait for others to approach or link to you. This 

passive approach gives you an obvious time advantage. Some ways to encourage 

passive links include: 

 Tell Visitors how to link to you: Put a link on your site that says, "How to 

Link to Us". Provide the text, banners, buttons, and HTML to make it as easy 

as possible for someone to think to you.  

 Offer a content-rich site: You'll be pleasantly surprised at how many web 

sites link to you just because they like what you have to offer. 



 

 

1.8 LEGALITIES OF LINKING 

Almost all web sites have a page of links to ‗favorite‘, ―featured‖ or ―special‖ 

places to visit. This is almost never done with permission, nor does it need to be. Only 

HTML-style pages are acceptable for cross-linking. Linking to other types of media 

files (e.g. graphics, zip files, sound files) is called bandwidth stealing and is highly 

unethical.  

One way to think of linking is to associate it with the ―fair use‖ laws. These 

laws, which allow people to include short quotes from published and copyrighted 

works in their own materials. This is not illegal or unethical - in fact it is absolutely 

necessary. It would be difficult for a university student to write an assignment if he or 

she could not quote authors, or how impossible it would be for a critic to do his/her 

job if he/she could not include a few lines from the work he/she was writing about. 

 

1.9 GUIDELINES WHEN LINKING 

For linking with other sites, essential guidelines are as follows: 

 Keep your links simple 

Fair use allows small quotes, and as long as you keep things short you should be fine. 

 Know What Kind of Web sites Will Compliment Yours 

Look for web sites that compliments yours but does not directly compete with you. 

This is actually a very time-consuming task. It does not mean blasting out requests for 

swapping links to every site you see. A web site full of links with little content doesn't 

"make sense" because what benefit is it to you or your visitors? Link to sites that are 

of interest to or help your visitors. You are adding value to your own web site in this 

manner. 

 



 Get permission where possible or feasible 

Request a Link with web site's Webmaster. Keep in mind that web site owners may 

get several link requests every day. Make your request stand out by personalizing 

your request. Include the site owner's name. Comment on something you've seen on 

their web site. This shows that you have actually visited the site and taken the time 

and effort to look around. 

 No control over content of links 

Include a section of your own which explains to your visitors that you have no control 

over external links. You think they might be of interest, but you don't have any 

responsibility for their content. 

 Link only to HTML and text style pages 

Do not link to multimedia files (images, sounds and videos). Linking to these types of 

media files is called bandwidth stealing and is highly unethical.  

 

1.10 DESIGNING A SITE MAP 

When people think of site maps, they often think of XML sitemaps that contain a link 

to every page on your website. But for the purposes of planning a site, a visual site map can 

be very helpful. By drawing even a simple sketch of your site and the sections you would like 

to have on it, you can be sure that you capture everything about your website that you need to 

be successful. 

How to Draw a Site Map 

When using a site map to plan your site you can be as simple or as complex as you 

need to be. In fact, some of the most useful site maps are those that are done quickly and 

without a lot of conscious thought. 

1. Grab a piece of paper and a pen or pencil. 

2. Draw a box near the top and label it "home page". 



3. Under the home page box create a box for every major section of your site, such as: 

about us, products, FAQ, search, and contact, or whatever you want. 

4. Draw lines between them and the home page to indicate that they should be linked 

from the home page. 

5. Then under each section, add boxes for additional pages you would like in that section 

and draw lines from those boxes to the section box. 

6. Continue creating boxes to represent Web pages and drawing lines to connect them to 

the other pages until you have every page you want on your website listed. 

 

1.11 WRITING FOR THE WEB 

Writing and preparing content for the Web requires a different approach from writing 

and preparing content for print documents and publications. In addition, writing copy for the 

Web that grabs attention and gets the results you want takes special skill and attention, 

whether you're trying to sell products or services at a business or commercial site or if you 

just want to let people know the latest at your personal site. 

The art of content writing is not 'rocket science' and you don't have to be Einstein to 

master it. Writing a good content is very easy and anybody who is proficient in English can 

become a good content writer. It is a simple procedure but it involves intricate details. 

There is a fixed set of rules and regulations, which are meant entirely for the purpose 

of content writing: 

1. Title: 

The title of any content speaks volumes about what the content is going to be about. A 

good title must be catchy as well as informative. It should give the readers a fair idea about 

the topic of the content. It should be attractive enough to grab the attention of the readers. 

 

2. Inverted Pyramid: 



Now you must be wondering what an 'inverted pyramid' is. It is a simple technique 

where, the most important information is placed first. This technique must be kept in mind 

while writing for any web resources, because your readers have a very short attention span. 

3. Language: 

Any content must be written in simple language which can be easily understood by all 

the readers. Using jargons or verbosities is a bad idea and it should be avoided once and for 

all. Simple sentences made up of familiar words, is the best way to go about it. Your 

sentences should have a flow in them. Each paragraph should lead to another. 

4. Originality: 

Writing original content is the most important part of being a good content writer. 

You must write authentic content. Copy and paste will not get you anywhere in the field of 

web-writing. Your web articles or web blogs should be an extension to your personality. You 

must write as you speak. 

5. Connect With The Readers: 

Good content writers must connect with their readers. The readers should get a feeling 

that they are talking out their queries to a reliable person. Stating personal experiences and 

speaking in direct speech is the correct way to do so. 

 

1.12  SUMMARY 

 In this unit we have identified the need of web site and further web design. We have 

gone through the historical background of web designing. We have assessed the basic aspects 

of relevance while designing an ideal web site of any institution. We have also identifies the 

need of site links and site linking, their types and other important issues of web linking. 

Finally traced various issues for developing site map.  

1.13 Self-check Exercise 

1. Explain the significance of Web design. 

2. What to link up a website and types of linking? 
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3. Elaborate the role of content writing in websites? 

4. What is the need of cross linking? 
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2.0 INTRODUCTION  

The principles of Web design are the same as the principles for design in general. 

With these principles you can create Web pages that are put together in an effective and 

aesthetic way. If you learn the principles of design, you'll have Web pages that look better 

and work towards their goals in a clear and efficient way. 

These elements are components or parts which can be isolated and defined in any 

visual design or work of art. They are the structure of the work, and can carry a wide variety 

of messages. They are the objects to be arranged, the constituent parts used to create the 

composition itself. In majority of cases the elements of design build upon one another, the 

former element helping to create the latter, and the elements described in this column are 

arranged as such. 

2.1 OBJECTIVE: 
After going through this unit you will be able to: 

 Perceive various principles of web design. 



 Identify various important elements of Web Design. 

 Assess the importance of color calibration in Web Design. 

 Examine various essential points of typography in Web Design.. 

2.2 THE PRINCIPLES OF DESIGN 

 

Web design is a relatively new area of study compared to other forms of design. As 

with any design discipline, there are aspects of the Web design process that are unique to the 

medium, such as screen resolution, additive color spaces and image compression. But too 

often these more unique details over-ride our sense of the bigger picture. We focus on the fact 

that it is Web design and push aside core design concepts—concepts that can that make any 

project stronger without interfering in the more technical considerations. 

Web design may be defined as being one of many disciplines within the larger field of 

design. To step back even further, we can explain design as a discipline within the field of art 

(like painting, illustration, sculpture, etc.) The point is that in order to start with a discussion 

about the fundamentals of design as they relate to Web design we need to understand that 

there is a good degree of inheritance that design has received over the years from other art 

forms. These art forms, such as lithography, typography, painting/illustration and industrial 

design, evolved over many centuries, and a number of basic ideas have emerged as providing 

universal guidance to any artistic endeavor. When talking about fundamental concepts we 

inevitably look outside our discipline and adopt a slightly larger perspective. 

 

2.3 COMPOSITION OF WEB DESIGN 

There are many basic concepts that underlie the field of design. They are often 

categorized differently depending upon philosophy or teaching methodology. We can group 

all of the basic thought of design into two categories: principles and elements. The principles 

of design represent the basic assumptions that guide the design practice, and affect the 

arrangement of objects within a design composition. By comparison, the elements of design 

are the components of design themselves, the objects to be arranged.  



For the purpose of learning designing steps one must be well equinted with the basic 

elements of web designing. These basic elements of web designing are as follows: 

 Balance 

 Rhythm 

 Proportion 

 Dominance 

 Unity 

2.3.1 Balance: 

In easy words we can say that the balance is a sort of equilibrium that results from 

looking at images and judging them against our ideas of physical structure (such as mass, 

gravity or the sides/margin of a page). It is the arrangement of the objects in a given design as 

it relates to the appearance within a composition. Balance usually comes in two forms, these 

forms are as follows:  

 Symmetrical and  

 Asymmetrical. 

2.3.1.1 Symmetrical Balance: 

Symmetrical Balance occurs when the weight of a composition is evenly distributed 

around a central vertical or horizontal axis. Normally it assumes identical forms on 

both sides of the axis. When symmetry occurs in a similar, but not in identical 

manner, the specific form it is known as ―Approximate Symmetry‖. Besides, it is also 

possible to build a design composition equally around a specific central point 

resulting in ―Radial Symmetry‖. Symmetrical balance is also known as ―Formal 

Balance‖.  

2.3.1.2 Asymmetrical Balance: 

Asymmetrical Balance occurs when the weight of a composition is not evenly 

distributed around a central vertical or horizontal axis. It involves the arranging of 

objects of differing size in a such a manner that they balance one another with their 

respective visual weights. In these cases there is one dominant form that is offset by 



many smaller forms. In general, asymmetrical balance based compositions presents a 

greater sense of visual perception. This form of balance is also known as ―Informal 

Balance‖. 

 

2.3.2  Rhythm: 

Rhythm is the form of repetition often with defined intervals between a said design. 

Rhythm can create a sense of movement, and can establish pattern and texture. There are 

many different kinds of rhythm, often defined by the feeling it evokes when looking at it. 

Some of its common types are as follows:  

2.3.2.1 Regular: A regular rhythm occurs when the intervals between the elements, 

and often the elements themselves, are similar in size or length. 

2.3.2.2 Flowing: A flowing rhythm gives a sense of movement, and is often more 

organic in nature. 

2.3.2.3 Progressive: A progressive rhythm shows a sequence of forms through a 

progression of steps. 

 

2.3.3  Proportion: 

Proportion is the comparison of dimensions or distribution of various forms within the 

presentation. It is the relationship in scale between one element and another, or between a 

whole object and one of its parts. Differing proportions within a composition can relate to 

different kinds of balance or symmetry, and can help establish visual weight and depth. In the 

below examples, notice how the smaller elements seem to recede into the background while 

the larger elements come to the front. 

 

2.3.4  Dominance: 



Dominance relates to varying degrees of emphasis in design. It determines the visual 

weight of a composition, establishes space and perspective, and often resolves where the eye 

goes first when looking at a design. Generally there are three stages of dominance, each stage 

relates to the weight of a particular object within a composition. 

2.3.4.1  Dominant: The object given the most visual weight, the element of primary emphasis 

that advances to the foreground in the composition. 

2.3.4.2  Sub-dominant: The element of secondary emphasis, the elements in the middle 

ground of the composition. 

2.3.4.3  Subordinate: The object given the least visual weight, the element of tertiary 

emphasis that recedes to the background of the composition. 

 

2.3.5  Unity: 

The concept of unity describes the relationship between the individual parts of a 

composition and the whole of a composition. It investigates the aspects of a given design that 

are necessary to tie the composition together, to give it a sense of wholeness, or to break it 

apart and give it a sense of variety. Unity in design is a concept that stems from some of the 

Gestalt theories of visual perception and psychology, specifically those dealing with how the 

human brain organizes visual information into categories, or groups. Gestalt theory itself is 

rather lengthy and complex, dealing in various levels of abstraction and generalization, but 

some of the basic ideas that come out of this kind of thinking are more universal.  

 

2.3.6  Closure: 

Closure is the idea that the brain tends to fill in missing information when it perceives 

an object is missing some of its pieces. Objects can be deconstructed into groups of smaller 

parts, and when some of these parts are missing the brain tends to add information about an 

object to achieve closure. 



 

2.3.7  Continuance: 

Continuance is the idea that once you begin looking in one direction, you will 

continue to do so until something more significant catches your attention. Perspective, or the 

use of dominant directional lines, tends to successfully direct the viewers eye in a given 

direction. In addition, the eye direction of any subjects in the design itself can cause a similar 

effect.  

 

 

2.3.8  Categories of Space:  

We commonly use the term Positive and Negative space, which refers to the 

juxtaposition of figure and ground in a composition. The objects in the environment represent 

the positive space while the environment itself is the negative space. For example we can say 

positive space is shapes as actual sculpture or building. While a negative space is the shape 

which is the space around the sculpture or building.  

 

2.3.9  Form (Shape): 

The simplest definition of shape is a closed contour, an element defined by its 

perimeter. The three basic shapes are: circle, rectangle (square) and triangle. Form is the 

shape and structure of a dimensional element within a given composition. Form can be both 

two-dimensional and three-dimensional and can be realistic, abstract or somewhere in 

between. The terms form and shape are often used synonymously, which is why they are both 

included here. In reality, form is derived from the combination of point, line and shape. 

There are many additional concepts that are related to the principles of design. These 

can include specific terms and/or techniques that are in some way based on one or more of 

the above tenets.  



 

2.3.10  Point: 

A point is an element that has position, but no extension. It is a single mark in space 

with a precise, but limited, location. Alone it can provide a powerful relation between 

negative and positive space, but when grouped with other points the Gestalt grouping 

principal of closure tends to kick in and the brain compulsively connects the points together. 

Line or form is a natural result of multiple points in space. 

 

2.3.11  Line: 

A line is an element characterized by length and direction. Lines create contours and 

form, and are often used to convey a specific kind of feeling or point to an important feature 

in a design. Lines are also used to create perspective, and dominant directional lines are often 

adopted to create a sense of continuance in a composition. In addition, lines that are grouped 

together often create a sense of value, density or texture. 

 

2.3.12  Perspective:  

Perspective may be divided in two broad categories, as Non linear and Linear 

perspective.  

 Nonlinear Perspective: Nonlinear Perspective is the method of showing depth that 

incorporates the following techniques: 

 Position- Placing an object higher on the page makes it appear farther back 

then objects placed lower on the page.  

 Overlapping- When an object overlaps another object it appears closer to the 

viewer, and the object behind the object appears farther away.  



 Size Variation- Smaller objects look farther away in the distance.  Larger 

objects look closer.  

 Color- Bright colors look like they are closer to you and neutral colors look 

like they are farther away.  

 Value- Lighter values look like they are farther back and darker value look like 

they are closer.  For example in a landscape the mountains often look bluish 

and lighter then the trees or houses that are closer to you.  

Linear Perspective: Linear Perspective is the method of using lines to show the illusion of 

depth in a picture.  The following are types of linear perspective: 

 One-point perspective- When lines created by the sides of tables or building 

look like that are pointing to the distance and they all meet at one point on the 

horizon this is one-point perspective. To see an example stand in the middle of 

the hallway and look at the horizontal lines in the brick or the corner where the 

ceiling meets the wall.  See how they move to one point on the horizon.  

 Two-point perspective- Here the lines look like they are meeting at two points 

on the horizon line.  

 

2.3.13 Texture: 

Texture is used to create surface appearance and relates to the physical compilation of 

a given form. Texture often refers to the material that something is made of, and can be 

created using any of the elements previously discussed. Texture is both a visual and a tactile 

phenomenon. 

Categories of Texture: 

 Real Texture: It is the actual texture of any object on a designed web site.  

Artist may create real texture in art to give it visual interest or evoke a feeling.  



A piece of pottery may have a rough texture so that it will look like it came 

from nature or a smooth texture to make it look like it is machine made. 

 Implied Texture: It is a type where a two-dimensional piece of art is made to 

look like a certain texture but in fact is just a smooth piece of paper.  Like a 

drawing of a tree trunk may look rough but in fact it is just a smooth piece of 

paper. 

 

2.3.14 Rule of Thirds 

The rule of thirds is a compositional tool that makes use of the notion that the most 

interesting compositions are those in which the primary element is off center. Basically, take 

any frame of reference and divide it into thirds placing the elements of the composition on the 

lines in between. 

2.3.15 Visual Center 

The visual center of any page is just slightly above and to the right of the actual 

(mathematical) center. This tends to be the natural placement of visual focus, and is also 

sometimes referred to as museum height. 

 

2.4 CATEGORIES OF VALUE: 

Broad categories of Values are as follows: 

 Tint is adding white to color paint to create lighter values such as light blue or pink. 

 Shade is adding black to paint to create dark values such as dark blue or dark red.  

 High-Key is where the picture is all light values.  

 Low-Key is where the picture is all dark values.  

 Value Contrast is where light values are placed next to dark values to create contrast 

or strong differences.  



 

2.5 COLOR 

Color is the response of the eye to differing wavelengths of radiation within the 

visible spectrum. The visible spectrum is what we perceive as light. It is the part of the 

electromagnetic spectrum that we can see. The typical human eye will respond to 

wavelengths between 400-700 nanometers (nm), with red being at one end (700 nm), violet at 

the other (400 nm) and every other color in between these two. 

There are many different kinds of color systems, and many different theories on color. 

We will focus on the basics, using a color wheel for illustration purposes. There are three 

main components of color: 

 Hue: Where the color is positioned on the color wheel. Terms such as red, blue-green, 

and mauve all define the hue of a given color. 

 Value: The general lightness or darkness of a color. In general, how close to black or 

white a given color is. 

 Saturation: The intensity, or level of chrome, of a color. If the color is showing more 

gray in its presentation, it shows that it has included the less chrome in its color 

calibrations. 

 

2.5.1 Color harmonies: 

Color harmonies serve to describe the relationships certain colors have to one another, 

and how they can be combined to create a palette of color. 

 Complementary: A complementary relationship is a harmony of two colors on the 

opposite side of the color wheel. When complementary colors are placed side-by-side 

they tend to enhance the intensity (chroma) of each other, and when they are blended 

together they tend to decrease the intensity of each other. 

 Analogous: An analogous relationship is a harmony of colors whose hues are 

adjacent to one another on the color wheel. Analogous colors tend to be families of 



colors such as blues (blue, blue-violet, blue-green) and yellows (yellow, yellow-

orange, yellow-green). 

 Triadic: A triadic relationship is a harmony of three colors equidistant from one 

another on the color wheel. Primary colors and secondary colors are examples of 

color triads. 

In these examples, a subtractive color space was used for illustrative purposes. 

            

 

   

 

2.5.2 Color spaces: 

Color is typically organized in a hierarchal fashion, based on how colors are mixed. A 

color space helps to define how the colors are mixed, based on the medium in which the 

colors are used. There are two different kinds of color spaces: 

 Subtractive: A subtractive color space is the traditional color space that most people 

refer to when they talk about color. It is pigment-based color, as in the mixing of 

paint. In a subtractive color space, the pigments manipulate the wavelengths that our 

eyes see. The absence of any pigment produces white, and all pigments blended 

together produces black.  

o Primary colors: Red, yellow, blue 

o Secondary colors: Orange, green, violet 

 Additive: An additive color space is an electronic color space. It is light-based color, 

as in the mixing of color on the computer. In an additive color space, light is added to 



the screen in differing amounts to produce color. The absence of any light is black, the 

presence of all light, or light at full intensity, is white.  

o Primary colors: Red, green, blue 

o Secondary colors: Yellow, magenta, cyan 

                                                                 

                               Subtractive color space                       Additive color space  

Further there are many additional concepts that are related to the elements of design. 

These can include specific terms and/or techniques that are in some way based on one or 

more of the above ideas. They add to the collection of compositional tools available for use 

by a web designer. 

 

2.5.3 Contrast: 

Contrast addresses the notion of dynamic tension or the degree of conflict that exists 

within a given design between the visual elements in the composition. It gives an effect for 

increasing the attraction of a viewer.  

 

2.6 SIMILARITY, PROXIMITY AND ALIGNMENT 

Items of similar size, shape and color tend to be grouped together by the brain of a 

human being, and it express a genuine semantic relationship between the various designed 

items of the web site. In addition, items in close proximity to or aligned with one another tend 

to be grouped in a similar way.  

 



 

 

2.7 TYPOGRAPHY 

Typography is the art of arranging typefaces, selecting style, line spacing, layout and 

design as a means of solidifying language. There are many facets to typography, and only a 

brief investigation will be started here based around some common terms. 

 Baseline: The line on which all letters rest. 

 Beardline: The line reached by the descenders of lowercase letters. 

 Bowl: The round or elliptical parts of a letterform. 

 Cap line: The line reached by the top of uppercase letters. 

 Counter: The white space enclosed by a letterform, whether completely or partially. 

 Extenders: Extenders are the parts of letters that extend either below the baseline 

(descenders) or above the midline (ascenders). 

 Midline: The top of lowercase letters such as a, c, e and the top of the torso of 

lowercase letters such as b, d. 

 Serif: A stroke added to either the beginning or end of one of the main strokes of a 

letter. 

 Stem: The main stroke of a letter that is generally straight and not part of a bowl. 

 Topline: The line reached by the ascenders of lowercase letters. 

 X-height: The distance between the baseline and midline of an alphabet. The x-height 

is usually the height of the unextended lowercase letters. 

We can express these concepts in the bellow mentioned illustrative example: 

                                

 



 

 

2.8 PATTERN 

Pattern is the repetition of shape or form. It can also reflect the underlying structure of 

a design by organizing the surfaces or objects in the composition. There are many different 

kinds of patterns: 

 Flowing: A flowing pattern is based on the repetition of an undulating line, and 

reflects a natural meandering through a composition. 

 Branching: A branching pattern is the repetition of forking lines, or patterns of 

deviation. These kinds of patterns can be found in almost all plants, and in many other 

places in the natural world. 

 Spiraling: A circular pattern, or a pattern that winds in and around itself. 

 

2.9 MOVEMENT 

Movement can be defined as motion of objects in space over time, and it may often 

described in one of two ways: 

 Literal: Literal movement is physical movement. Examples of literal movement 

include: Products such as the automobile, motion pictures and dance. 

 Compositional: Compositional movement is the movement of the viewer‘s eye 

through a given composition. Compositional movement can be either static or 

dynamic. Static movement jumps between isolated parts of a composition. Dynamic 

movement flows smoothly from one part of the composition to another. 

 

2.10 SUMMARY 

In this chapter we have identified various elements essential for web page design. We 

have also discussed each element in detail and found out various important issues related to 



them. If we consider all of the above mentioned elements in a serious manner, we will be able 

to develop an ideal and balanced institutional or library web site.  

2.11 SELF-CHECK EXERCISE 

i. Explain the basic principle of Web design. 

ii. What is the role of balance in web design? 

iii. Discuss its various types. 

iv. Discuss various categories of perspectives. 

v. What do you mean by color harmony? 
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1.0 INTRODUCTION  
The field of ICT and especially the Internet and web applications is a vast and dynamically 

changing subject field. We are witnessing the overnight changes in the tools, techniques and 

technology. In this unit of the course it is intended to familiarize you with the website 

creation and management. As stated this subject is very vast and ever growing which contains 

lot of tools and techniques. It is impossible and also worthless to try to have mastery in all 

available tools, but it is must to have competency to select right tool for right purpose at right 

time. This unit is prepared keeping this central idea in mind. It is deemed that you are already 

familiar with the basics of ICT tools like computers, printers, scanners, cameras, windows 

operating system, MS Word, Word-pad, Notepad etc applications and having good 

experience of internet/web browsing, moreover having access to these resources. 

The unit deals with the tools of the trade, website creation and management tools, internet 

connectivity and server space, and Browsers and web extras. The unit will introduce you with 

the basics of the field to create and manage a simple website and familiarize with the basic 

idea and give tips to create and manage a complex web site.    

Content is the central part of any form of communication, including web site. What you want 

to say is always more important than how you say it, but here we will focus ourselves on how 

to say something using world wide web as a medium. It is also presumed that you have 

digital copy of well written contents.  

1.1     Objectives 
After reading this unit you will be able to understand different aspects of website creation and 

management tools. Different issues related to Internet connectivity and server space have 

been covered in details. Browsers and web extras has also been covered in this unit. 

  

1.2 TOOLS OF THE TRADE 

Creating a Web site necessarily requires hands on experience and access to ICT (Information, 

Computer and telecommunication) tools including relevant software tools. In this block, our 

focus falls on the array of software that you can use to create, edit, and manipulate Web 

elements. You can frequently mix and match tools of your choice depending on the need. 

Likewise, knowing your choices will help you create a working environment that best suits 

your needs and personal style. Creation of functional website necessarily requires the 

expertise to select and use the relevant software tools quickly. Web editors or html editors, 

CSS, (cascading style sheet) graphic applications and FTP utilities are the basic website 

creation and management tools competency to select and use appropriate tool in best possible 



way is a necessity for a web developer. It includes a very long range of open source (free) 

and paid software. We will discuss some of the important tools in coming section of the 

block.   

Knowledge about internet connectivity, domain name registration and server space is also 

important to upload a functional website. The access to type of Internet connectivity is 

depends on the local infrastructure and availability of type of internet connectivity which 

varies from dialup, broadband to V-SAT based, Leased line based internet connection but to 

create and manage a simple web site a broadband connection is sufficient. Another important 

requirement is the URI or web address (Domain name) and server space to upload your 

website. It is must to store your web site on the internet server to make it accessible 24X7. In 

coming paragraphs we will discuss it in details.   

 Knowledge of browsers and web extras is another set of competency required to develop a 

functional web site, basics of the browsers and web extras will also be discussed in the unit. 

Due to development of Unicode support now it became possible to create and host websites 

in all most all major languages of the world, therefore you must be aware about it. You can 

very easily create a website in Hindi or any other language if you know typing in that 

language using Unicode. This is not the part of the block but you may try it by activating 

language pack on any Windows XP, Vista or Windows 2007 operating systems, it will give 

you a new kind of pleasure to do things in your own language using ICT.    

To get started, let‘s look at the most basic competency, after internet connection, you‘ll need 

during your Web creation attempt i.e. website creation and management tools. It is presumed 

that you have internet connection and some browsing experience.  

 

1.3 WEBSITE CREATION AND MANAGEMENT TOOLS 

Website creation is a creative as well as technical job. You must have competency to try and 

use new software tools to get the desired results and creativity to present contents in best 

possible way. As you know creativity is an insight which can‘t be developed only by lectures 

or texts. Therefore leaving creative part to you, in this section we will discuss the software 

tools required to create and manage the website.    

1.3.1 TEMPLATES 
A template is a preformatted page layout that incorporates graphical components, font styles, 

colours, and other design elements. You have to enter the required information in specified 

fields and select the any of the available template. If you create a Web presence using a 

blogging site or an online group, you‘ll most likely start by using templates to set up your 

site. Templates are also available online and with software applications that you can use to 

design your Web pages. Most of the web sites, which provide the free web site creation and 

hosting services, provide templates to create webpage. You can try on webxgeneration site to 

have hands on experience of using templates. http://webxgeneration.in  

You may download the web template of required category from  
http://www.e-webtemplates.com  view of one such template is given below. 
 
If you download and extract the template file you will get the detailed list of html and css 
files and images used in this template. You can open the html file in notepad or word pad 
and enter your desired test instead of already entered text, provided that you have basic 
knowledge of html tagging. You may replace the jpj and gif files from your own files having 
same file name. Templates are good for understand the structure of the web sites and to 
practice. You can get lot of free templates from many websites.  

http://webxgeneration.in/
http://www.e-webtemplates.com/


 
1.3.2 BASIC WEB EDITORS 

A basic Web editor is a text editor like notepad, word-pad etc. If you have good hands on 

experience on HTML, you can use any basic web editor. When you use a text editor to create 

a Web page, you type your Web page‘s text and all the HTML commands and into a blank 

document and save it as HTML document. The most basic of the basic text editors is the 

Notepad application that comes with the Microsoft Windows operating system.  

There are many web editors called WYSIWYG (what you see is what you get) editor which 

automatically encode HTML tags to your document, you can try MS-WORD to save your 

word document as html document using save as option of file menu. You might wonder why 

Web developers opt to manual HTML coding of their Web pages when the WYSIWYG 

editor can do it readily. The answer varies, but for the most part, Web developers hand-code 

their Web pages due to following reasons, these reasons also be said as Merits of the manual 

HTML coding. 

 CONTROL:   
Hand-coding enables you to use the codes you want instead of the codes a WYSIWYG (what 

you see is what you get) editor inserts. For example, you might want to use two blank line 

breaks, but a WYSIWYG editor might insert a paragraph marker. Furthermore, some 

WYSIWIG editors create ―messy‖ code; hand-coding can keep code orderly and easy-to-

read, with code alignment set to the developer‘s preferences. 

 QUICK FIXES:  
Knowledge and hands on experience to manually create and modify HTML, XHTML, CSS, 

and XML code enables Web designers to make quick changes to a Web site, regardless of 

how the Web site was initially created. For instance, if you want to update your site‘s 

copyright date or title bar text, you could update and save the change in a text editor in less 

time than it would take to simply open the page in a WYSIWYG editor. 

 CODE CLEANUP:  
Many advanced Web editors add extra code to documents. If you know how to create and 

edit standard HTML, XHTML, CSS, and XML code, you can clean out extra code and 

reduce the size of your files. And remember—on the Web, size matters, and the smaller, the 

better. Furthermore, because Web editors are only designed by humans, at times, Web editors 

might miscode your page. In those instances, you can save yourself lots of time and 

aggravation by changing the code directly instead of hunting down the proper dialog box 

setting in the Web editor. 

 FINE TUNING:  

http://www.e-webtemplates.com/website_templates_holder.aspx?template=templates/user/education-center/education-center.htm&title=Education_web_template


Another habit of advanced Web editors is that they sometimes use code that does not support 

all browsers. You can use text editors to modify code so that it conforms to the capabilities of 

most browsers. 

Display any Web page of your choice in your browser, and then click SOURCE on your 

browser‘s VIEW menu. A Notepad document opens that displays a text version of the Web 

page‘s HTML code. 

Of course, learning HTML and XHTML (a stricter version of HTML based on XML 

principles) is a prerequisite to creating your pages in a text editor. In other blocks of this unit, 

you will walk through the process of hand-coding cascading style sheets and XHTML to give 

you an idea of how style sheets and XHTML work together to display Web sites. That will be 

an introduction you‘ll need to access additional resources if you really want to get expertise 

on manual-coding of Web sites. 

The most popular HTML text editors (Web editors) in use today are as follows: 

 Notepad: Notepad comes with the Microsoft Windows operating system and is 

about as barebones as it comes when you‘re talking about text editors. 

 WordPad: WordPad is a step up from Notepad. It offers more word-processing 

features than Notepad, and it supports longer documents. 

 TextWrangler: TextWrangler is a basic text editor designed by Bare Bones 

Software for Macintosh computers. 

1.3.3 MIDRANGE WEB EDITORS 
Midrange Web editors are one step up from basic text editors, and they include a number of 

timesaving and accuracy-assisting features. In this group, you‘ll often find applications that 

provide Web-coding-specific features, such as tag inspectors, tag generators, colour coding, 

large file support, and more. Some of these editors start to enter the realm of WYSIWYG 

(such as Microsoft Word and Microsoft Publisher), but their main draw is that these programs 

include features designed to help you create HTML, CSS, XHTML, and related Web code. In 

this category, we recommend a few applications. You should test a couple to find which one 

feels most comfortable for you. 

 MS-Word and MS-Publisher: MS-Word and MS-Publisher enable you to use a 

familiar interface to create Web documents via the Save As command of file menu. 

When you save an Office document as a Web page, the application automatically 

creates the HTML, CSS, XML, or other relevant source code. 

Word and Publisher are useful for creating simple Web sites and to edit simple Web 

pages that were created using a particular Office application. Office applications do 

not always work as well when you attempt to edit more advanced sites or Web sites 

created in applications other than those in Microsoft Office. But to understand the 

process and see the html coding it is advised to have some hands on experience of 

these applications because most probably these will be readily available on your 

computer. 

Some other midrange web editors, which you can try, are as follows.    

 OpenWysiwyg: OpenWysiwyg is a cross browser rich text editor with almost 

every editing capability you could want. It features a sleek user interface 

including drop-downs and buttons. High on its features is its capacity to handle tables 

well, with different borders and colors. However, Chrome is still not supported by this 

web editor. 

http://www.openwebware.com/


 

 TinyMCE: TinyMCE is an open-source JavaScript HTML WYSIWYG editor. It‘s 

easy to integrate, and is highly customisable with themes and plugins. TinyMCE is 

one of the more ―complete‖ editors out there, offering an experience similar to 

MSWord. 

 

 CKeditor: CKeditor is the new FCKEditor that proved to be market leading 

previously. It builds from that, and aims to fix what FCKEditor got wrong. The result 

is a high performance WYSIWYG editor that offers editing features comparable to 

MSWord and Open Office. 
 

 The YUI Rich Text Editor: The YUI Rich Text Editor is a UI control from 

Yahoo that turns text area‘s into fully functioning WYSIWYG editors. IT comes in 

several different versions of varying features and complexity, but still manages to 

achieve a great user experience without a plethora of buttons crowding the interface. 

 

 NicEdit: NicEdit is an alternative to some of the larger, more complex WYSIWYG 

editors out there, with its small download size. It boasts many of the expected editor 

features and easily integrates into your site. 

1.3.4 ADVANCED WEB EDITORS 
The third and final group of Web editors includes the advanced applications that enable you 

to create and edit Web pages by using graphical interfaces. In advanced editor applications, 

you can view and edit source code directly as well as work in the WYSIWYG interface. 

Further, most advanced editors provide a preview feature, which enables you to view how a 

http://www.openwebware.com/
http://tinymce.moxiecode.com/
http://tinymce.moxiecode.com/


Web page will be displayed online, sometimes in more than one browser, before you view the 

page in your browser as well as other advanced tools. Popular advanced Web editors are well 

documented online and being updated frequently with new features, so instead of giving 

details, URLs of pertinent Web sites is being provided. Although other editors are readily 

available, the following applications are some of the most popular Web development 

programs around. Remember, most of the advanced web editors are not free or open source 

so you have to pay to use them. Some of them offer trial or free version having limited 

features. 

 CoffeeCup The HTML Editor 2010 SE (www.coffeecup.com/html-

editor) CoffeeCup Software started in a real coffee house in 1996. It‘s first program 

was the HTML Editor. Over the past 10 years they have created a lot more Web 

Design and Flash Software. The CoffeeCup HTML Editor is an HTML editor that 

supports both raw HTML and WYSIWYG editing. Originally created by Nicholas 

Longo and Kevin Jurica. 

According to the authors the editor was the first to support Javascript (version 3.5 

Sep. 1996), split-screen editing (version 4.0, March 1997) and built-in FTP upload 

(version 5.2, February 1998). 

 

 Adobe Dreamweaver CS5 

(http://www.adobe.com/products/dreamweaver) 

Adobe Dreamweaver (formerly Macromedia Dreamweaver) is a web development 

application originally created by Macromedia, and is now developed by Adobe 

Systems, which acquired Macromedia in 2005. 

Dreamweaver is available for both Mac and Windows operating systems. Recent 

versions have incorporated support for web technologies such as CSS, JavaScript, and 

various server-side scripting languages and frameworks including ASP, ColdFusion, 

and PHP. 
 

 NetObjects Fusion (www.netobjects.com/products/html/nof8.html) 

NetObjects Fusion (NOF) is a web design tool, from 1996 - 2001 developed and 

distributed by NetObjects, Inc., marketed from 2001 until 2009 by Web.com (former 

called Website Pros), which acquired the application in 2001, and from July 2009 on 

distributed again by the re-established NetObjects, Inc. 

NetObjects Fusion has a graphical user interface and generates HTML or (since 

release 11) XHTML through its own proprietary database. 

Keep in mind that your Web site creation environment doesn‘t have to be an either/or kind of 

setup. At times, we find it‘s quickest to use an advanced WYSIWYG application, especially 

when reorganizing a design layout, but at other times, a quick edit in Notepad serves better. 

Therefore you must develop competency to quickly learn and use the required software tools. 

1.3.5 GRAPHICS APPLICATIONS 
Now-a-days it is almost impossible to find any website having only textual contents and no 

doubt the graphics express more in less. Therefore the Graphics application is the second 

most important competency for Web site development after text or Web editor. After all, 

most sites use graphics, and you‘ll want to either create or add a readymade graphics you use 

on your Web site. Therefore, you‘ll need to have a graphics package installed on your system. 

Corel Paint Shop Pro and Adobe Photoshop or Photoshop Elements are the most popular 

graphic applications among web developers.  

http://www.coffeecup.com/html-editor
http://www.coffeecup.com/html-editor
http://www.adobe.com/products/dreamweaver
http://www.netobjects.com/products/html/nof8.html


Regardless of your graphics package, the five main skills you‘ll need to acquire when using a 

graphics program are cropping, cutting, resizing, recolor, and saving the graphic file as a 

different file format. So check your application‘s help files to brush up on your technique. 

Now, here are some popular graphics programs along with their Web addresses. 

 Photoshop: http://www.photoshop.com - Photoshop is probably the leading 

image editing program. It can be a little tricky to use when you‘re first learning it, but 

once you get the commands mastered, you‘ll be highly satisfied with the application‘s 

flexibility. 

 Paint Shop Pro: http://www.corel.com - Paint Shop Pro is an affordable, all-

purpose graphics program used by many designers. Visit the Corel Web site to 

download a free trial version of the software.  

 Fireworks: http://www.adobe.com/products/fireworks - This application 

is easy to use and especially convenient when you need to create buttons and other 

basic Web site graphics. Macromedia developed Fireworks specifically for creating 

Web graphics. 

 LView Pro: http://www.lview.com - LView Pro is a popular shareware 

graphics program that includes typical graphic features as well as Web page utilities 

 Microsoft Paint: Microsoft Paint is a graphics program that comes with Microsoft 

Windows. Paint is a scaled-down graphics package, but it serves as a handy graphics 

tool and easy to understand for beginners. 

Remember that all these software are paid and expansive.  

 

1.3.6 FTP UTILITIES 
FTP denotes file transfer protocol. In order to upload your web files and programs on a web 

server you should be familiar with the FTP utilities. FTP utilities are software programs that 

allow you to copy files and directories from your computer to another computer across the 

Internet. You can find numerous FTP programs online, many of which are shareware or 

freeware programs. 

File Transfer Protocol (FTP) is a standard network protocol used to copy a file from one 

host to another over a TCP/IP-based network, such as the Internet. FTP is built on client-

server architecture and utilizes separate control and data connections between the client and 

server. FTP users may authenticate themselves using a clear-text sign-in protocol but can 

connect anonymously if the server is configured to allow it. 

The first FTP client applications were interactive command-line tools, implementing standard 

commands and syntax. Graphical user interface clients have since been developed for many 

of the popular desktop operating systems in use today. 

 

The common view of a ftp utility is as follows: 

http://www.photoshop.com/
http://www.corel.com/
http://www.adobe.com/products/fireworks
http://www.lview.com/


 
Popular FTP programs include the following: 

 CoffeeCup Free FTP 4.3 (www.coffeecup.com/free-ftp) 

Free FTP is a simplified, intuitive, and best of all free FTP client. It uploads and 

downloads files quickly and reliably, keeps your FTP server settings in one place, and 

allows you to pause or cancel transfers. Make CoffeeCup Free FTP your choice for a 

no-cost, highly effective tool to complement your Webmaster suite. 

 Fetch 5.6 (www.fetchsoftworks.com) 

Fetch is a reliable, full-featured file transfer client for the Apple Macintosh whose 

user interface emphasizes simplicity and ease of use. Fetch supports FTP and SFTP, 

the most popular file transfer protocols on the Internet 

 CuteFTP 8 (www.globalscape.com/cuteftp) 

 BulletProof FTP Client 2010 for Windows (www.bpftp.com) 

You probably won‘t need to use an FTP program if you‘re creating a blog or an online 

community Web page. Further, you can use the My Network Places feature in Windows to 

transfer files from your computer to your server space. You might need to use an FTP utility 

to delete, copy, and otherwise manage online files. 

1.4 INTERNET CONNECTIVITY AND SERVER SPACE 

The Web site created on your computer is useless for rest of the world unless you connect to 

the Internet and transfer the site‘s files to a server. The server is a powerful computer that is 

connected to the Internet‘s backbone data lines, stores Web files, and responds to users 

requests to view the stored Web files. You must be connected to the Internet or have access to 

an Internet connection before you can achieve an online presence. You can create a Web site 

without an Internet connection, but it will save lot of time if you have internet connection in 

the same computer. 

If you use your computer to surf the Web, rest assured—you have an Internet connection. 

Using a standard dial-up or broadband Internet connection, you can copy Web files from your 

computer onto a server that‘s connected to the Internet. In addition to the basic prerequisite of 

Internet connectivity, you will need to pay for some space on a server for your Web files, if it 

is not freely provided in addition to other paid services of ISP. For example, your Internet 

service provider (ISP) might give you 20-30 MB of free server space in addition to your 

Internet connection. The notion of free server space catches many people by surprise but it‘s 

out there, and it‘s a thriving online practice. Not surprisingly, however, you‘ll find benefits in 

purchasing server space as well as using free space. 

http://www.coffeecup.com/free-ftp
http://www.fetchsoftworks.com/
http://www.globalscape.com/cuteftp


1.4.1  FREE SERVER SPACE ONLINE 
As mentioned earlier, you can get the server space on payment to upload your website in 

addition to it you may also get free server space at many web servers to upload your web site. 

To get start in the field and also for practice it is advisable to get free web space. To get the 

instance web presence you may create your blog at http://www.blogger.com. At this site you 

may your own free Web site in a matter of minutes, which is another way you can build a 

Web presence online for free.  

 

 

MERITS AND DEMERITS OF FREE WEB SPACE: 
The main benefits of free web space providers are that they‘re inexpensive, they‘re quick and 

easy to use, they cater to all experience levels, and they provide just enough space for a basic 

site.  

Lack of proper support is the common demerit of free web space providers usually they offer 

little or no support.  They use overcrowded servers, which may cause slow downloads or 

server crashes that make your site temporarily unavailable online, they offer limited long-

term reliability and fewer features, and they post advertisements on your site.  

With that said, free hosting often provides a good way for you to practice setting up your first 

Web sites or short-term Web sites. Yet another type of ―free‖ online Web space—which 

technically isn‘t free—is Web space that you get from your ISP. Because you pay to your ISP 

on a regular basis, we can‘t exactly label ISP server space as free; it‘s more like prepaid, 

available space. The upside of ISP server space is that you‘re already paying for it, so you 

might as well use it. Another advantage that ISP server space has over blogging sites and 

online communities is that you generally have greater freedom regarding how you create and 

display your site. The demerit of ISP server space is that you‘ll probably have to live with a 

lengthy and cumbersome Web address, similar to online community Web addresses, which is 

not easy to remember. 

Search in any search engine to find free Web server space, you‘ll get a long list of sites 

offering to host your page at free of cost. The main point about free online sites is that Web 

space is instantly available to you. And as long as you don‘t mind a lengthy Web address, 

design limitations, and possibly advertising, free space is a great way to initiate yourself on 

the Web. 

List of web sites which offer free web space is given for your practice. Simultaneously it is 

also warned to be-aware and read the contents of the offer very carefully before uploading 

your files on any free web server. 

 Tripod.com - http://www.tripod.lycos.com/  

20 Mb. Banner or Pop-up ad on each page. FTP uploads. MS FrontPage, CGI and Perl 

supported. Web-based builder and templates provided. URL: 'http://yoursite.tripod.com/'.  

 Freeservers.com - http://www.freeservers.com/  

12 Mb. Banner ad on each page. Browser uploads. Email forwarding. CGI scripts: 

counter, guestbook and form mailer. Domain hosting. URL: 

'http://yoursite.freeservers.com/'.  

 Free Web Space - http://www.freewebspace.com/  

20 Mb. Banner ad on each page. Browser uploads. Email forwarding. CGI scripts and 

website tools. URL: 'http://yoursite.freewebspace.com/'.  

http://www.blogger.com/
http://www.tripod.lycos.com/
http://www.freeservers.com/
http://www.freewebspace.com/


 WebSpawner.com - http://www.webspawner.com/  

For beginners. Pop-up ad on each page. Web-based builder and site management tools.  

 FreeHomePage.com - http://www.freehomepage.com/  

50MB with 1GB of monthly bandwidth. Templates and web-based site builder provided. 

Banner ads on each page. URL: 'http://yoursite.freehomepage.com/'.  

 www.freewebsites.com 

 www.freewebindia.com 

 www.hosting.india.to 

 http://manashosting.com 

 www.hosting.b4uindia.com 

 

1.4.2  PURCHASING SERVER SPACE ANDDOMAIN NAME 
As mentioned earlier, instead of free web space you may purchase/ subscribe the web space 

at a server of hosting server providers. Using these servers you can use the Web address of 

your choice provided that it is available. When you decide to subscribe the paid web space, 

you have two main considerations—choosing and registering a Web address, and signing up 

with a web space provider that will upload your Web site, unless you‘re going to run your 

own server. 

 Let‘s look at how to register a Web address and obtain a hosting service. Registering a Web 

Address Before we go any further, let‘s nail down some simple vocabulary. In particular, 

instead of Web address, we really should say domain name. Loosely speaking (very loosely), 

a domain name is a Web address. As you might know, all Web addresses are actually groups 

of numbers (called Internet Protocol, or IP, numbers) that serve as Internet addresses. Being a 

human, you probably also know that, for most people, remembering a meaningful name is 

much easier than remembering a series of numbers divided by dots. Therefore, the Domain 

Name System (DNS) came into existence. Fundamentally, DNS simply assigns textual names 

(such as inflibnet.ac.in) to numbered Internet addresses (such as 117.211.83.108). Thus, to 

appear as if you know what you‘re doing, you should use the term domain name in place of 

Web address when you‘re referring to a Web site. When you‘re ready to obtain your own 

domain name, you can pick a domain name of your choice and see whether it‘s available, and 

if it is, register the domain name as your very own for a nominal annual fee. 

After accessing a legitimate domain name registration site Web domain name selection and 

registration is a simple and straightforward process. An agency named InterNIC 

http://www.internic.net/ of the U.S. Department of Commerce hosts a Web page that lists all 

the acceptable domain name registration Web sites. Many web hosting sites also offer domain 

name registration services. 

National Informatics Centre, New Delhi http://www.home.nic.in/gdr and  

Ernet, Ministry of ICT, New Delhi http://www.registry.ernet.in are the domain name 

registration agencies for government departments and educational institutions of our country.  

List of some other Indian domain name registration sites accredited by Internic are as 

follows:  
http://www.indiadns.net/ 

http://www.webspawner.com/
http://www.freehomepage.com/
http://www.freewebsites.com/
http://www.freewebindia.com/
http://www.hosting.india.to/
http://manashosting.com/
http://www.hosting.b4uindia.com/
http://www.internic.net/
http://www.home.nic.in/gdr
http://www.registry.ernet.in/
http://www.indiadns.net/


www.aboutdomainsolutions.com 
http://www.publicdomainregistry.com/ 
http://www.goodluckdomain.com/ 
http://www.domainsrs.net/ 
http://www.mindgenies.com/ 
http://www.net4.in/net4app/index.aspx 
http://domain.indiatimes.com/WebSol/shopping/domainHome.sh 
http://www.tirupatidomains.in/ 
You may browse above stated sites to check and review their pricing schedules and policies, 

you will also find some sites in this list which will register your domain name as well as host 

your site for you.  

When you open any of above sites for domain name registration, you will be asked to type 

your proposed domain name in a text box, and the site will then inform you whether the name 

is available. If it is, you work out a payment arrangement by credit card or any other means, 

and the site registers domain name of your web site. Your next step is to find an ISP that will 

host your domain name and Web site, if it is not same. 

1.4.3  FINDING SPACE FOR YOUR DOMAIN 
After registering the domain name your next step is to find a hosting service that‘s willing to 

provide a home for your domain name. You can find numerous hosting services online, just 

type ―web hosting‖ in any search engine, and you find a long list of various Web hosting 

service providers. You may visit http://www.hostindex.com  a comprehensive site for web 

solutions. 

 SPACE:   
When you sign up for Web hosting services, hosting companies assign you a certain amount 

of server space. Most ISPs and hosting services offer more space on their servers than you‘ll 

initially need. However, you should get at least 10 MB of server space. Most hosts provide at 

least 50 - 100 MB server space. Therefore before deciding on the Web hosting services you 

must check the size of your website and server space provided by the agency.  

 SUPPORT:   
After sales service or technical support is a very important rather critical requirement in the 

field of ICT including web development. When you‘re choosing a Web hosting company, if 

you encounter any problem, you‘ll need to contact someone who can help immediately. The 

most basic support consideration you should look for is the number of hours per day the 

technical support staff is available. Many sites offer 24 hours a day, seven days a week 

support, so look for round-the-clock support. Round-the-clock support is important because 

you‘ll most likely be updating your pages during off-hours, so off hours are the times you‘ll 

probably need support the most. Also see whether the site publishes its support response rate. 

Finally, check to see whether you can readily identify the avenues of support the company 

offers, including phone numbers including toll-free numbers, fax numbers, e-mail addresses, 

chat etc. 

 EXTRAS:  
You might want to check to see what ―extras‖ each company offers to entice customers. For 

example, most hosting services provide e-mail accounts you can use with your domain name 

(such as rr@redbridge.com or cc@whitecoller.org). You can generally set up anywhere from 

5 to 40 or more e-mail accounts with a single Web hosting agreement. Other features you 

might check out include the cost of adding space to your site, in case your site grows larger 

than your originally allotted space; the cost of upping your traffic quota, in case more people 

visit your site than you anticipated; whether FrontPage Server Extensions (if you‘re using 

FrontPage) and streaming media are supported; and available add-on services, such as chat 

http://www.aboutdomainsolutions.com/
http://www.publicdomainregistry.com/
http://www.goodluckdomain.com/
http://www.domainsrs.net/
http://www.mindgenies.com/
http://www.net4.in/net4app/index.aspx
http://domain.indiatimes.com/WebSol/shopping/domainHome.sh
http://www.tirupatidomains.in/
http://www.hostindex.com/


groups, ecommerce features, and site search features. Now that you‘ve considered your 

domain name, hosting services, and basic Web site options, we‘re ready to move closer to 

home and talk about desktop applications. In the next section, we look at software 

applications you can use on your system to create, edit, and publish Web sites. 

  



 

1.5 BROWSERS AND WEB EXTRAS 

A web browser or Internet browser is a software application for retrieving, presenting, and 

traversing information resources on the World Wide Web. An information resource is 

identified by a Uniform Resource Identifier (URI) and may be a web page, image, video, or 

other piece of content. Hyperlinks present in resources enable users to easily navigate their 

browsers to related resources. 

Although browsers are primarily intended to access the World Wide Web, they can also be 

used to access information provided by Web servers in private networks or files in file 

systems. Some browsers can also be used to save information resources to file systems. 

 

1.5.1 PURPOSE & FUNCTIONS OF BROWSERS: 
The primary purpose of a web browser is to bring information resources to the user. This 

process begins when the user inputs a Uniform Resource Identifier (URI), for example 

http://www.inflibnet.ac.in into the browser. The prefix of the URI determines how the URI 

will be interpreted. The most commonly used kind of URI starts with http: and identifies a 

resource to be retrieved over the Hypertext Transfer Protocol (HTTP). Many browsers also 

support a variety of other prefixes, such as https: for HTTPS, ftp: for the File Transfer 

Protocol, and file: for local files. 

In the case of http, https, file, and others, once the resource has been retrieved the web 

browser will display it. HTML is passed to the browser's layout engine to be transformed 

from markup (tagged) to an interactive document. Aside from HTML, web browsers can 

generally display any kind of content that can be part of a web page. Most browsers can 

display images, audio, video, and XML files, and often have plug-ins to support Flash 

applications and Java applets. Upon encountering a file of an unsupported type or a file that is 

set up to be downloaded rather than displayed, the browser prompts the user to save the file to 

disk. 

Interactivity in a web page can also be supplied by JavaScript, which usually does not require 

a plugin. JavaScript can be used along with other technologies to allow "live" interaction with 

the web page's server via AJAX. 

Information resources may contain hyperlinks to other information resources. Each link 

contains the URI of a resource to go to. When a link is clicked, the browser navigates to the 

resource indicated by the link's target URI, and the process of bringing content to the user 

begins again. 

Internet Explorer, Netscape Navigator, Mozilla Firefox, Chrome, Safari, 

Opera, Epic are some of the popular web browsers. Each one of these has some special 

features, therefore it is must to test your website on at least 3-4 cross plate form web 

browsers, before hosting it for public usage. You may test cross plate form performance of 

your site on http://browsershots.org. You have to give URI of your web site and select the 

browsers on which you want to test your site and the programme available on this site will 

give details about performance of your site in different web browsers. The screenshots of 

some important web browsers are as hereunder- 

  

http://en.wikipedia.org/wiki/World_Wide_Web
http://en.wikipedia.org/wiki/Web_page
http://en.wikipedia.org/wiki/Uniform_Resource_Identifier
http://www.inflibnet.ac.in/
http://en.wikipedia.org/wiki/File_Transfer_Protocol
http://en.wikipedia.org/wiki/File_Transfer_Protocol
http://en.wikipedia.org/wiki/AJAX
http://browsershots.org/


 
Internet explorer8 

 
Firefox 

 

 
Google Chrome 7 - Windows Vista 

 
Netscape 4.78 - Windows 98 SE 
 
 



  
Epic India 
The Epic Browser is the first-ever web browser for India and the first product from 

the software company Hidden Reflex. 

Hidden Reflex is a software product startup founded by Alok Bhardwaj in 2007 and 

based in Bangalore. Alok, who was raised in the U.S., was inspired by the success of 

open source software and web 2.0 innovations. Hidden Reflex began as a team of 

three but soon progressed and now has dedicated teams working on two products 

simultaneously – the Epic Browser and NewsDrink. The company‘s mission with the 

Epic browser is to create the most secure, most productive and most ―Indian‖ 

browsing experience of any web browser, therefore it must be tried to test its‘ claim. 

    

Some of the known special features of different web browsers are as follows: 

 Margin spacing of the page varies. For example, Internet Explorer tends to 

leave more margin space at the top by default than other browsers. 

 Default font size is smaller on Windows than on Macintosh, which means that 

text wraps differently on Macintosh systems than on Windows-based systems. 

 Varying amounts of information appears in a page, because text wraps 

differently in different browsers.  

 Browser window widths vary due to toolbar and scroll bar widths. 

Although cross-platform fonts—Arial, Comic Sans, Courier, Georgia, Times New 

Roman, Trebuchet (MS), Verdana and Mangal (Unicode Hindi Font) —are displayed 

on both Windows-based and Macintosh systems, their default sizes vary, with the 

fonts consistently displayed smaller on the Macintosh. For most designers, ensuring 

that pages are displayed properly in the biggies—Internet Explorer and Firefox—is 

plenty; combined, these two browsers account for over 90 percent of all browsers 

accessing the Internet. Of course, you must always consider your audience. If you 

know your viewers will be using Safari browsers, you better ensure that your page 

looks good in Safari.  

1.5.2 Web Extras 
Some common statistics gathered by tracking tools include time zones, languages, 

monitor resolutions, and colour depths. Sometimes, you can see how many visitors‘ 

computers support JavaScript, style sheets, and other technologies. Often, you can see 

how long visitors stay on each page, which pages visitors view most, and which pages 

visitors view last before they leave your site. Many hosting services provide some 

logging capabilities and tracking services. In addition, we recommend Site Meter 

(www.sitemeter.com), a free tracking tool that you can add to your Web site.  

In addition to the standard tools which are necessary to create Web sites, many more 

applications and tools are available to create added functionality. For instance: 
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 If you want to include multimedia elements such as movies, audio, and 

animations, you need special programs to develop those. 

 If you want to include payment services, you need to find secure payment 

options and applications, such as PayPal (www.paypal.com) and VeriSign 

(www.verisign.com). 

 If you want to dynamically display text from content services, you might need 

to work with custom interface utilities. 

 If you want to supply information from databases, you need a database to 

handle the information. It will be required to upload library OPAC on the 

website. 

The preceding list of Web tools is just the introductory, and many of these topics are 

having a book of their own. Here we have introduced you to as much as we can fit 

into this unit. 

You don‘t need to collect tools for advanced Web features yet. The goal here is to 

help you gather basic tools for getting a custom Web site online—Internet 

connectivity, server space, a Web editor, a graphics program, a file transfer 

application, and a browser etc. 

1.6 SUMMARY 
It is must to have Internet connectivity and server space to display a Web site online. 

You‘ll find that free Web space is readily available online, particularly on blogging 

and online group sites, or you can purchase a domain name and buy server space to 

have full control over your Web site and Web address. Templates and Web editors 

can be used to create Web sites. Web editors range from all-text programs to 

midrange coding applications to advanced WYSIWYG interfaces. Graphics 

applications required to create Web graphics, edit pictures, and create mock-ups of 

future Web pages. GIF animators, banner creation sites, button creators, and image 

map utilities are available online as part of graphics programs. 

FTP programs and the My Network Places feature enable you to copy files from your 

computer to a remote computer or servers. Not all browsers are created equal—

different browsers display the same Web files in various ways, so you should always 

view your Web pages in Internet Explorer and Firefox (at least)and in two three other 

browsers before publishing your Web site online. Tracking tools help you learn how 

visitors view your pages, which can help you make informed design decisions. Many 

tools are available that enable you to add functionality to your Web sites, including 

multimedia features, shopping utilities, databases, and so forth. 

1.7 Self-check Exercise 

1. Write a short essay on tools of the trade for website development. 

2. What do you understand by website creation and management 

tools? 

3. What is internet connectivity and server space? 

4. Write a short essay on browsers and web extras. 

5. Write short notes on followings: 

a. Templates 
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b. Basic web editors 

c. Mid-range web editors 

d. Advanced web editors 

e. Graphic applications 

f. Free server space online 

g. FTP utilities 

h. Domain name  
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Unit 2- Planning To Design web page  

2.0 Introduction 

2.1 Objective 

2.2 Building a case for planning 

2.2.1 How To Structure Your Website 

2.2.2 How To Design Intuitive Navigation 

2.2.3 How To Write Page Titles 

2.2.4 How To Choose Keywords 

2.2.5 How to Write Page Descriptions 

 

2.3 Defining your goal 
2.3.1 Why Set Site Goals? 

2.3.2 Defining Site Goals 

2.4 Getting to know your audience 

2.4.1 Think Like Your Audience From the Beginning 

2.4.2 Profile Your Target Market 

2.4.3 Cater to Varying Abilities & Skill Levels 

2.4.4 Will They Return? 

2.5 Drawing the blue prints for site 

2.6 Laying home page’s foundation 

2.7 Gathering suppliers and preparing to build 
2.7.1 Register Domain Name  

2.7.2 Web Hosting Service  

2.7.3 Developing Text Content  

2.7.4 Optimize Content: 

2.7.5 Optimize Images:  

2.7.6 Web Page Design & Navigation  

2.7.7 Inserting Meta Tags Into Your Web Pages  

2.7.8 How to Write a Compelling Description: 

2.7.9 Optimizing Pages For Search Engine Placement  

2.7.10 Contact Forms versus e-mail Links  

2.7.11 Bounce Messages Not Addressed To An E-mail Identity  

2.7.12 Bulletin Board or Forum Programs 

2.7.13 Mailing List Programs 

2.7.14 Testing  

 

2.8 Summary 
 

2.9 Self-check Exercise 

 

 

2.0 Introduction: 

A website is an address (location) on the World Wide Web that contains your web pages. 

Basically, a website is your personal online communications connection to the rest of the 
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world. It is totally different from any other type of publishing, advertising or communications 

media.  

Designing for the web requires the relevant content of a brochure or magazine, the colorful 

look of high-quality print, and the attention-grabbing impact of television advertising. Plus it 

should offer a valuable product and/or information, be updated frequently and stay current 

with changing technology. 

 2.1 Objectives: 

After reading this unit you will be able to understand different aspects of planning a 

website. Different issues related to website design such as goal setting, target 

audience and tips related to better navigation have been covered in details. Tools and 

whereabout of webpage hosting and working through webpage has also been covered. 

 

2.2  Building a case for planning 

For a small to medium sized business, initiating a Website can be one of the toughest 

jobs you'll face. This section is designed to provide basic knowledge in site structure, 

content organization, the selection of keywords, and writing page descriptions. This 

can be as a basis for further learning and will help you establish a strong foundation 

for your company's Website.  

 

2.2.1 How To Structure Your Website 

For most small to medium-sized businesses, there are two types of content sections 

you'll need to think about. 

 Common sections: those elements you see on most commercial Websites.  

 Organization-specific sections: those sections those are unique to your 

business. They may be sub-sections of the above.  

 

A. Common Section: these will contain general information about the organization. 

It is upto you to decide which sub-elements should be included. You may consider 

following points in this section: 

  a. About us: This section gives information about the organization. You will see this 

on almost every commercial website, both small or big.  It is a common practice to 

know the organization you are dealing with. This section helps outside world to know 



 

 
122 

about you. This information might fit on a single page, or stretch to several pages. 

Following element might be included in this part:  

 Who are you 

 Company/organization History 

 Company/organization profile 

 Mission Statement 

 Contact us- You should include as many different ways for customers to 

contact you as possible. This part must be updated regularly. The contact 

information must include: 

- Telephone and fax numbers 

- Email addresses 

- Email forms 

- Physical address 

- A ‗we are here map‘ 

- Emergency contact details 

b. Products and Services: It is a general practice to include information about their 

products or services on the index page (the front or home page), but it‘s important to 

also dedicate separate section of your site to your products. This will help your 

customers find your products and services easily, and allow them to research and 

assess your quickly. 

 

 

B. Organization-specific sections: 

 The best way to go about creating organization specific sections for your website is 

to follow the same general structure as above by creating logical subsections for each 

section. The first page of a subsection should contain general information on the 

subject, as well as links to more detailed information if your visitors require it. For 

example, a special library site may have special collection on specific subjects that 

may contain following sub-subject: 

- Special collection on the subject 

- Period it covers 

- Uniqueness of record 
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- Information Media  

- Accessibility 

 

 

 

2.2.2 How To Design Intuitive Navigation 

 

This information will help you avoid some of the more common navigational 

mistakes made by many small to medium sized businesses. This particularly 

important since bad navigational systems will kill Websites. 

 

 What makes good navigation? 

As far as designing Website navigation is concerned the key to intuitive navigation is 

consistency. Take a look at any large commercial Website and you'll find very similar 

elements in very similar places. Why? Because that's what users expect. Here are a 

few guidelines to bear in mind when considering your site's navigation: 

 a. Place major section/category links horizontally, near the top of every page. 

Most sites will place these links beneath the logo in the top left corner. If this doesn't 

immediately make sense, think about how you read a page of text: from top left to 

bottom right. Right? Also, limit your major categories to a maximum of about eight. 

Give them too many choices, and your users won't make a choice at all. 

 

b. Put section-specific links in a clearly marked column along the left-hand edge. 

Again, this is where users will expect to find such links. Remember, the easier your 

site is to use, the better the user experience, and the better the impression they'll have 

of your site. This doesn't mean you should throw style out the window of course, but, 

like many things in life, it's a matter of balance and priority. An example of section-

specific links for the obligatory About Us section might look like this: 

 

    * About Us 

    * Who We Are 

    * Company Profile 

    * Mission Statement 
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c. Use contextual links in your body text. 

Wherever appropriate, use contextual links to lead your users to related information. 

And don't be afraid to link to outside content: contextual links to outside sources add 

value to your own information, and well chosen links lend validity to your authority 

on a given subject. If your information is of interest to your visitor he'll come back, 

and if he doesn't, then you never had him anyway. 

 

d. Provide a search box for your visitors. 

All users are different, and some will undoubtedly prefer to find the information they 

seek via a search box rather than your neatly placed, intuitive text links. A search box 

is an essential feature of any Website, and it's extremely easy to set up. You can find 

an excellent third party solution here. 

 

e. Use text links wherever possible. 

Not all the visitors to your site will be human (cue ominous music). Many will be 

search engine robots. Search engines and graphical links don't mix well, so if you 

can't avoid using graphical links, then provide text alternatives at the bottom of the 

page. 

 

f. Provide a site map. 

Sounds kind of obvious, huh? However, most small to medium sized sites don't offer 

a site map, and this is a crying shame. They're very easy to make, don't have to be 

particularly pretty to be functional, and will aid both your human and non-human 

visitors. A good place to put a link to your site map is in the page 'footer' near the 

copyright notice. 

 

e. A small disclaimer 

If you've questioned any of the above statements, then good: if we don't constantly 

question what we do and why we do it, we'll never change anything. 

 

The fact is that this section is not aimed at those developing artistic, non-commercial 

Websites. It's aimed at small to medium sized organization designing sites that need 



 

 
125 

to be accessible to a wide variety of users -- and this is most certainly not an in-depth 

discussion of this topic. Common sense dictates that we should base our navigation on 

what users expect, making it as simple for your dear old granny, or your key 

customers, as it is for you or I. If your artistic flair has been a little blunted by my 

rather strictly worded guidelines, then don't be too disheartened, style is most 

definitely not dead! With a little thought and planning you can have both a great 

looking, and superbly functional Website. Web design has always been about 

compromise, and those that learn to blend artistic considerations with practical 

restrictions will find that the restrictions themselves will breed creativity. 

 

 

 

 

What makes bad navigation? 

Many small business Websites actually do more harm than good. When a user comes 

away from your Website feeling frustrated, it reflects directly on your business. Bad 

navigational style is the number one cause of such online aggravation, and it typically 

has two key effects upon your site's visitors: 

    * They leave before having explored all the information you offer that's relevant to 

them 

    * They get frustrated while trying to explore the site, and simply leave 

 

The first problem has a whole variety of common causes including Flash intros, 

Splash pages and misleading information. This is most definitely a topic worthy of 

discussion, but if I start down that path, I may never come back! 

 

The second problem is an all-too-common occurrence on small to medium-sized 

company Websites, particularly those of the 'home grown' variety. There's usually not 

a single cause, but rather a combination of common mistakes and pitfalls, to which 

user frustration can be attributed. The result, inevitably, is a well-intentioned Website 

that unfortunately turns out to be a miserable experience for all concerned. 

Bad navigation can be caused by: 

    * Overly complicated or gimmicky menu systems 
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    * Inconsistent or unusual placement or style of links 

    * The user not being able to find the links at all 

    * Inconsistent page design or layout 

    * Unclear or misleading link text 

    * Graphics-only links 

Notice here that inconsistency is a common theme here. 

 

2.2.3 How To Write Page Titles 

Good page titles can increase traffic and qualify your visitors. A Web page's title has 

two main functions: 

   1. To explain what the page contains, and 

   2. To promote keywords or phrases and thus increase and qualify traffic. 

A page's title is the most important part of what makes a user click a link in a list of 

search results. To demonstrate, imagine you're in search of a second hand book, 

which of these links are you more likely to click? 

    * Publisher name 

    * Affordable second hand books 

    * Untitled document 

    * SALE!!! Books!! DEALS ON Amazon.com!! 

It's clear that your first choice would be number two, but let's take a look at why. 

Number 1 says absolutely nothing of any value to anyone, and for that reason alone 

it's less likely that you'll even come across this link in your search for a second hand 

book, let alone click on it. If you're searching through a directory like Yahoo! or Jubii 

then it will probably be there, but it'll be much easier to miss, as it's unmemorable and 

uninspiring. 

 

Number 3 might as well say 'Don't buy anything from us, we're a bunch of clowns!'. 

This poor effort just spells incompetence and I personally think that it should be a 

punishable crime to publish such monstrosities. Similar crimes include 'page 1', 'Min 

nye hjemmeside' and 'Welcome to some shabby html editor!'. Number 4 is clearly the 

work of someone who should be kept away from the rest of society. 

 

So what's so good about number two? 
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Ideally page titles should contain, or better still, be the phrase that your visitors search 

for. Many search engines award higher rankings to short, concise titles that contain 

the searcher's keywords. Ideally you should keep your page titles less than 40-50 

characters long and be as honestly descriptive of the page's contents as possible.  

 

Remember that not everyone that visits your site will enter via the front door. It's no 

good having the same title for every page, as all you'll end up doing is limiting the 

number of visitors you attract. If one of the pages in your 'second hand book' site 

deals with reference and referral services might attract prospective information users.  

In conclusion keep your titles short, honestly descriptive, and above all, relevant to 

your page's contents. Try to use the terms or phrases you expect your visitors to 

search for, and avoid the multiple exclamation mark and capital letter madness: overly 

promotional titles are a turn-off to most users. 

 

2.2.4 How To Choose Keywords 

Targeting keywords increases traffic and qualifies visitors. Keywords and search 

terms are those words or phrases that your customers may enter on a search engine in 

order to find a Website that offers products or services like yours. Choosing keywords 

is not difficult if you follow a few guidelines. 

 

Basic rules for choosing keywords 

1. Think Like Your User 

Try to think like your customers, and choose words or phrases that you could imagine 

them entering into a search engine. How would you find a site like yours? If you can 

find your competitors via a search engine, what search terms did you use to locate 

them? 

2. Be Specific 

Be specific. If you sell cars, for example, it will be almost useless to choose 'cars' as a 

keyword, as you compete with too many other sites. 'Affordable second hand cars' 

would be a much better choice. 

3. Use Words From the Page 

Use words that appear in your page's content. Let's say your site sells second hand 

books and you have different sections for Globe International and PHI. An effective 

choice of keywords might work like this: 

    * Front page: 'second hand Books', 'used books', 'affordable books' 

    * PHI page: 'second hand PHI Books' 'used PHI Books' 'previously used PHI 

Books' 

    * PHI page: 'second hand PHI Books' 'used PHI Books' etc. 

And make sure you use these keywords in your page titles. 
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2.2.5 How to Write Page Descriptions 

Good page descriptions can make a big difference to your site's traffic. Some search 

engines such as msn use a page's description as the text that appears beneath the title 

in a list of search results. This provides Websites with an excellent opportunity to 

create the right impression pre-click. Combined with a good page title, you can use 

your description to further qualify your visitors. Here are a few rules of thumb: 

    * Page descriptions should be a maximum of two sentences long and be as 

concise as possible. 

    * Be as honest as you can. It's far better to attract visitors that really are 

looking for a company like yours than to mislead people. 

    * If possible, write descriptions that also contain the keywords or phrases 

you're targeting. 

    * Do not use overly promotional language -- people don't like it and some 

search directories may refuse to include pages that do this. 

    * Don't use all capital letters or multiple exclamation marks. People will think 

you're insane. 

A practical example: Let's say you sell second hand books and that you've already 

chosen a title. Here are some examples of what to do and what not to do: 

 

Bad example: 

"BOOK BOOK BOOK!!!!! LOWEST PRICES GUARANTEED!!!!!!!! CHEAP 

BOOK AT LAUGHING LARRY'S BARGAIN BONANZA!!!!!! BOOK BOOK 

BOOK!!!!" 

 

Good example: 

"We sell second hand books and will deliver anywhere in India for free. Check out 

our online showroom here. " 

I won't bother explaining why the first example is so dreadful -- if you can't see why 

yourself, then there's probably no hope for you! 

What makes the second example so good is that first sentence tells the reader exactly 

what you do, while at the same time making sure that the site doesn't lose potential 

customers due to the business's location: they can deliver for free. The second 



 

 
129 

sentence tells the reader what kind of site to expect when they click the link. The 

whole description is accurate, informative and appealing, without being overly 

promotional. 

To conclude when you're writing page descriptions, try to think like a user that's 

looking through a list of search results. What would make you choose one link rather 

than another? Try to keep your descriptions short, to the point and honest: a user 

who's tricked into visiting your site will not buy from you. 

 

2.3 Defining Your goal 

2.3.1 Why Set Site Goals? 

In this section we‘ll discuss the two key reasons for developing specific goals for your 

website. When we sit down with organization to talk about their web strategy, one of the first 

questions that I ask is ―Why did you originally develop your site?‖ Often, there‘s a moment 

of uncomfortable silence before someone replies, ―because our competitors all had one‖, or 

―our customers kept asking for our web address‖, or one of my personal favorites ―to get our 

name out there‖.  

 

In addition, some companies build a website for branding purposes, or to provide 

information to potential clients, thinking that one-way communication is a return on 

investment, and therefore a valid goal. I‘m afraid that I disagree. Using a website 

merely to provide information is like using an airplane to drive around town without 

ever leaving the ground, you‘re missing the real opportunity to help your business 

‗take-off‘ by creating opportunities to follow up with qualified prospects. After all, a 

website is an organization resource, and like any other resource it must provide a 

return on investment, or some kind of conversion. That return should be immediate 

and measurable, meaning that the bottom line for any website is – how specifically 

has the website grown my online business today/this week/this month, and so on. 

 

Furthermore, the issue of identifying goals is a critical one for two reasons. First, 

goals help you to determine what should or shouldn‘t be included on your site. In a 

sense, you actually build your site backwards – start with your online goals and then 

flesh out the structure and content from there. This can actually remove much of the 

politics of website development. As you use your goals document as a set of criteria 
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for determining site content, there‘s much less room for disagreement. For example, 

instead of executives engaging in power struggles about who decides what is included 

on the website, reviewing site goals will allow any particular suggestion to be 

evaluated in an objective way – does this content help accomplish any of these goals? 

 

Secondly, having specific goals allows you to measure the effectiveness of your site 

after it‘s completed and live. That‘s key because if you can‘t measure conversion, 

then improving it becomes much more problematic. So you‘ll find that measurement 

and improvement are the keys to that ROI you‘re looking for. 

 

I think the bottom line on goal setting is that if you never identify the target, then you 

can‘t expect to hit it. Likewise, developing a website with only fuzzy goals about 

educating your target audience won‘t allow you to effectively design, measure, or 

refine your site. In addition, you‘ll be missing the awesome potential of driving 

qualified leads and customers to your in-box 24x7. 

 

2.3.2 Defining Site Goals 

Most small organization websites have a combination of goals, but it‘s important to 

prioritize them so that the appropriate amount of focus can be placed on them during 

the site creation process, and so that results can be accurately measured and compared 

once your web design project is complete. For a small business website, there are 

three primary goals: 

 generating leads 

 selling products via e-commerce 

 generating referrals 

The reason why it is said because, these are the only conversions that lead to real 

rupees. So, they‘re the only way for your website to produce a return-on-investment 

(ROI). I think I‘ve said before, small businesses don‘t have time or money to waste on 

ineffective marketing, you need an ROI, and you need one fast. 

 

I do understand that websites can accomplish other less-tangible benefits for a small 

business. I call these secondary goals. Typical secondary goals include objectives 

such as: 
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 building credibility 

 supporting existing customers 

 and, recruiting partners or affiliates 

I consider these goals secondary because if this was ALL that your site did, then 

you‘re really missing the real potential of a company website. Defining primary and 

secondary site goals is relatively easy. Ask yourself ―what would I like my site to do 

for me that it‘s not doing today?‖  

 

Think things through from your own perspective – your website is a company 

resource, and should provide a real ROI. Be a little ‗self-centered‘ as you identify 

what you want your site to accomplish. We‘ll get around to making your site 

interesting to visitors a little later. For now, just focus on what you want. 

 

Now, I understand that everyone wants to increase their sales, but let me provide a 

word of caution. Not every product or services lends itself to purchasing on the web. 

Some examples include products with a high cost, professional services (like CPA‘s 

and so on) that require some level of interaction, complex products that have involved 

selection processes. The bottom line is probably this – if it seems unlikely or 

unreasonable to expect visitors to enter their credit card to purchase your products or 

service, and then shoot for lead generation as your primary goal. 

These goals will be used extensively later as you consider site structure, messaging, 

calls to action, and other critical elements of an effective site. Your secondary goals 

are likely to translate into single pages, whereas the primary goals will account for the 

majority of the site structure and content. 

 
2.4 Getting to know your audience 

It is critical when designing your website to understand and recognize your target 

audience. Many websites lose sight of this fact or never really have a true target 

audience in mind to begin with. The loss of this most fundamental aspect of any 

website may lead to a meandering design that tries to appeal to everyone, thus lacking 

focus and in actuality appealing to very few. Being too broad in scope may draw 

occasional visitors, but risks being so vague and bland that it connects with only a 

very small readership. 
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However, some websites take it in the other direction, choosing to focus so strongly 

on their target audience that they narrowly pinpoint too particular a demographic or 

segment in their design, therefore ostracizing other possible audiences. This can in 

turn leave their audience too small to support the site. 

 

If you‘re concerned about focusing your website‘s design toward your target 

audience, here are some crucial areas you may want to consider when doing so. 

 

2.4.1 Think Like Your Audience From the Beginning 

When you write or post items on your website, to whom are you writing? Who do you think 

will see what you are posting? Will the design and information contained on your site 

have the desired effect upon this audience? 

 

These are the types of questions you might want to ask yourself when it comes to 

envisioning who will be you target audience. If you don‘t have a clear idea before you 

begin designing your website, the sooner you can get one, the sooner you can begin to 

design a website that is better geared toward your target audience. 

2.4.2 Profile Your Target Market 

But sometimes it isn‘t that easy to pinpoint an exact target audience. Knowing who or 

what kind of people you want your site to appeal to, may not be dry. Let‘s take the 

design of a financial website for example. A financial website could appeal to a huge 

variety of audiences, each with their own needs when it comes to design. There could 

be the personal finance audience who is looking for articles teaching them how to 

save money. Maybe the stockbroker and investment analyst audience is looking for 

hot stock picks and fancy charts. It could be that the baby boomer, retiree audience 

needs retirement calculators. Or are you catering to the stay-at-homers looking to clip 

coupons to save on diapers, baby food and household items? 

 

Therefore, when you are considering your target audience, consider breaking your 

possible audience into categories of people most likely to be in tune with your site. 

Categories such as age, sex, profession, income, interests, hobbies and geographic 
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location may all come into play when deciding if your website‘s design matches your 

target audience. 

 

2.4.3 Cater to Varying Abilities & Skill Levels 

You will also likely need to consider the abilities of your target audience, when it 

comes to your website design. Is your target audience going to have the skills, 

education or capability needed to understand, navigate and properly use your website 

as you have designed it? Just because you‘ve created a beautiful website doesn‘t 

necessarily mean that it will be conducive to your target audience‘s needs. If your 

website isn‘t useful to your target audience, you may find yourself with a site that is 

incredibly designed, but used by no one. 

 

2.4.4 Will They Return? 

Finally, you might consider whether the design of your website has made it worth 

your target audience‘s while to return. If not, maybe this isn‘t your target audience 

after all, or may be you need to adjust the design of your website, if it is not 

conducive to your audience‘s needs. Consider the balance between design and 

usability on your website to better ensure your target audience will visit again. What 

do you need to do to attract and keep your target audience? Is it your site‘s design that 

you may need to adjust or your theory behind who your target audience may actually 

be? Being open and honest when answering such questions will allow you to focus on 

how or if your website‘s design and your target audience are compatible. 

2.5 Drawing the blue prints for site 

This blueprint is created with easy to use components within Microsoft Excel 

although many different software packages could be used to accomplish the same 

thing. The website blueprint serves as a visual way to keep track of pages you create, 

the keywords you use and how the pages within the website link to each other. The 

blueprint is also a great planning aid because it allows you to record keyword demand 

and profitability and keep running notes on the organization of your website as it 

grows. This free website blueprint is basically a "Business Plan", for your website. 

 



 

 
134 

The Spreadsheet examples shown in this instructable relate to building a website. But 

the basic principles shown can be used with other types of e-commerce web hosting 

and website creation programs. 

 

 

 
 

STEPS 

Step. 1 

Tier 1 

Webpage 
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 Draw your site blueprint with Microsoft Excel This instructable uses Microsoft Excel 

but many different software packages can be used  

 Open a new spreadsheet and right click on any toolbar  

 Scroll down the list of toolbars and click on the "Drawing" toolbar  

 The Drawing toolbar pops into the bottom of your screen.  

 Select the rectangle tool and draw rectangles to represent each page in your website. 

Place the rectangle for your home page at the very top of the spreadsheet.  

 Right click in the rectangle and select "Add Text". For your home page, select the 

keyword that defines your websites theme. Then add other important information 

such as keyword monthly demand, profitability index and notes such as what this 

page links to.  

 
 

Step. 2 

 Show the links from one page to another 

 Click on the down arrow in "Auto Shapes" to get the connections tool. Click 

on the connections tool to select arrows that are used to connect the rectangles. 
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 In this case you connect an arrow from the rectangle representing your home 

page, to other rectangles representing all the pages in your navigation bar.  

 The arrows or connectors represent how the pages in your website are linked 

together. The home page is linked to all the pages shown in your websites 

navigation bar  

 You now have all you need to lay out your entire websites structure on paper. 

 

Step. 3 

 Show the home page and the pages it links to. 

 You can now show all the pages your home pages are linked to.  

 Enter important data for each page such as monthly keyword demand and 

keyword profitability.  

 Your Home Page should be focused around the keyword with the highest 

demand and profitability.  

 The pages that your home page links to or the pages in your navigation bar, 

should focus on your second best keyword demand and profitability keywords. 
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 You only need to create one rectangle with this useful information and then 

copy and paste it to make rectangles for all the other pages in your website. 

The text information can be edited as required. 

 

 

Step. 4 

 Enter the remaining pages in your website 

 Each of the pages in your navigation bar will have pages that they also link to.  

 You can show this by edit copy and pasting rectangles beneath each page that is 

listed in the navigation bar.  

 Again edit the text information for each page  

 The keyword demand for these pages would normally be much lower than the 

pages in your navigation bar. But these pages are related and so the links to 

them are shown by using the connection tool previously described. 
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Step. 5 

Finish the Website Blueprint by using it to analyze your website 

Once your website is up and running, you can use the site blueprint to keep track of 

how it is doing. If you discover that pages in your website are well ranked by Google 

or any other Search engines, indicate that by coloring the rectangle representing that 

page green. This gives a quick visual indication that this page is doing well and needs 

little attention. 

 

On the other hand if one of your WebPages has high demand and profitability figures 

and your traffic statistics show it has not been found by the search engines, color the 

text in the rectangle that represents it red. This can be a signal for you to work on that 

page. 

 

This website spreadsheet tool should be a handy tool for anyone building a website. 
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Once you've built a lot of pages, it can get hard to keep track of what page links to 

what and also what pages you should be paying attention to. This tool should give you 

all you need to get your website in order 

 

 

 

2.6 Laying home page’s foundation 

Attractive web pages with easy navigation are critical to the success of a commercial 

website. 

 

Do-It-Your Self or Hire A Web Designer? 

 

If you have the time and desire to design and manage your own web pages, you will 

need to first get an HTML editor program such as FrontPage, Dreamweaver, or 

HotDog. If you are a quick study, it may only take a few months before you can 

http://en.wikipedia.org/wiki/HTML_editor
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produce marginally adequate web pages. For most serious business people, the time 

that it takes to acquire web design skills is a diversion from their real goal, which is 

marketing of their products or services. For others, working with the web site design 

is a fun way to be personally involved in the creation of your web site. Whether you 

have a professional design or do-it-yourself, it helps to know some basic web site 

design guidelines. 

 

Overall design guidelines 

Balance, Unity and Variety:  

The web pages should maintain a consistent theme, which emphasizes your identity. 

At the same time, there needs to be enough variety to keep things interesting. Choose 

a logo, stick with it, and use it throughout your site. Use variations of your logo as 

needed to fit into the context of each page, but keep the basic logo design consistent.  

 

Support the Message –  

A tasteful balance of visual aesthetics will enhance the message without 

overpowering it. Weird fonts, bizarre punctuation, moving objects, or too many colors 

can call attention to themselves and distract your visitors. 

 

Appropriate Design Theme: 

Choose a design theme that's appropriate for the message you're trying to convey. 

What's good design for a real estate company's website may be wrong for a site that 

sells skateboards. 

 

User Friendly Navigation: 

A good navigation system is consistent from page to page. The most important links 

should be placed in prominent locations. If graphics are used for links, they need to 

clearly identify their purpose. Text links should always be included. 

 

2.7 Gathering suppliers and preparing to build 

2.7.1 Register Domain Name  
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Before registering a domain name, decide if search engine optimization is one of your 

goals. If this is the case, include keywords in the domain name. The domain name is 

the first thing that search engines look at when ranking your site for keywords.  

 

Domain registration services number in the hundreds. Prices currently vary from 

about $8 to $15 for annual domain name registration. What's the difference between 

all of these different domain registration services?  

 

2.7.2 Web Hosting Service  

Web hosting services have popped up everywhere in recent years. Thanks to virtual 

web hosting software, just about anybody can sell or resell web hosting service. There 

are many good web hosting services available and just as many or more that doesn‘t 

have a clue about what they are doing! The specific web hosting plan that you choose 

will depend upon the type of website that you are developing and the features 

required, but if you are serious about your online business, the hosting company must 

be selected based upon reliability, performance, customer service, and last of all; 

price. ECommerce Hosting Service Plan Considerations 

1]  Platform (operating system) - The two main server platforms available is Unix 

and Microsoft. Unix is by far the oldest and most established multi-user server 

platform. Microsoft got into multi-user server platforms only a few years ago. 

Linux is based upon the Unix operating system and are the same for our 

purposes. Unix servers are usually lower priced, more stable, and offer more 

bang for the buck than Microsoft servers.   

2]  Features - Determine what your minimum required features are before 

shopping for a web hosting service. Here are some examples.  

POP3 Mailboxes mySQL Databases 

Web Mail Mailing Lists 

CGI / PHP / Pearl  e-Mail Forwarding 

SSL Secure Socket Layer Autoresponders 

FrontPage Support Shopping Cart Supported  

Amount of Monthly Bandwidth Amount of Disk Storage 
 

3]  Connection - Most web server computers are connected to the Internet 

backbone by T1, T3, or OC3 lines. A T1 can carry up to 1.5 mbs (megabits per 

second), while a T3 can carry 45 mbs, and an OC3 can carry 155 megabits per 
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second (the equivalent of 100 T1's). Small ISP hosts sometimes have ISDN 

connections to the Internet, or "fractional T1" connections (part of a T1). A T3 

connection is typically considered the minimum acceptable connection for 

business hosting. 

4]  Server Speed - Much like home computers, there are many brands and types of 

server machines. Pentium processors are the industry standard. Most cheap 

hosting services cut costs by using inexpensive Celeron servers, which typically 

run at less than half the speed of a good Pentium machine. Then, they overload 

the server capacity with too many high traffic web sites to maximize profit per 

machine. 

4]  Reliability - Many web hosting services claim 99.9% up time. Don't take their 

word on this unless you have a reliable reference. There are many virtual 

hosting services with slick, compelling websites and substandard servers with 

non-existent technical support. Ask someone who has used their service if you 

can. If not, look for one with no set up fees and a money back guarantee. Even 

if they actually have 99.9 percent uptime, this is not necessarily good enough 

for an ecommerce site. A down time of .3 percent equates to more than 26 

hours each year. 

5]  Support - 24/7 supports sounds great, but this advertising slogan is usually not 

accurate. There are very few web hosting companies that actually have trained 

support technicians available 24 hours a day. Usually 24/7 means that you can 

e-mail to them 24 hours a day and they respond within 24 hours.  

Beware of autoresponder support systems that are presented as 24/7 support. 

These completely automated systems can cause you much grief! 

Most web hosting companies only support the basic operation of your hosting 

account and they won't assist with installation or usage of ecommerce scripts 

such as a shopping cart, affiliate program, bulletin board, autoresponder, 

mailing list, etc. 

6]  Location - The Internet is an international marketplace, but distance does 

matter. As distance increases between the server and clients, there are typically 

an increased number of connections between them. This can slow page loading 

and increases the likelihood page not found errors caused by broken Internet 
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connections. 

6]  Price - How much should you pay for a web hosting service? This depends on 

your web site needs. If you don't need reliability or technical support there are 

hundreds of cheap hosting services that may satisfy your needs. If the web site 

is commercial and products are being sold, then reliability becomes a major 

factor. A few dollars saved on cheap hosting service can end up costing 

hundreds or thousands in lost sales and can also disrupt search engine 

optimization if the site cannot be found for periods of time. Our web hosting 

plans are structured for business web site development with an emphasis on 

ecommerce software applications and personal service. If this is the type of 

SERVICE that you need, check out our web hosting plan. 

 

2.7.3 Developing Text Content  

Good search engine rankings are a top priority for most ecommerce web sites. The 

ease or difficulty of achieving good search engine placement typically depends on the 

number of web sites that are competing for the same keyword placement and how 

well your competitor's web sites are optimized for search engines. There are other 

factors such as link popularity, but that is another subject. In any case, the more 

relevant content that you have on your site, the better your chances is of being found. 

Increasing the amount of relevant content increases your search engine exposure, 

especially if it is optimized for search engine keyword ranking.  

 

Writing Effective Copy - Once people reach your web site, you want to keep their 

interest and draw them in further. You need to write strong, persuasive copy and 

create attractive, effective visuals. You should almost always do most of the writing 

before designing the web pages. 

 

Many experts cite the AIDA formula: Attention, Interest, Desire, and Action. This is 

expanded here to ten points.  

1] Catches the reader's attention with something relevant 

2] Addresses the reader's fears, anxieties, and/or aspirations 

http://ashopwebhosting.com/index.html
http://ashopwebhosting.com/optimize-content-search-engine.htm
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3] Offers to solve the reader's problem, in the most specific terms possible 

4] Stresses specific benefits to the user - not the features that lead to those benefits 

5] Shows the consequences of a failure to act 

6]  Provides the reader with a chance to acquire something of clear value - but 

(according to most theories) only for a limited time 

7] Pulls the reader toward an immediate action step 

8] Includes solid, substantial validation of your claim by someone else (a customer, an 

expert) 

9] Backs up claims with comparisons to competitors 

10] Provides the necessary order form or contact information to allow the reader to 

move forward.  

 

2.7.4 Optimize Content: 

After writing your text content, we recommend that you optimize it for best search 

engine indexing. This can be a tricky task. Many times the best keyword optimization 

negatively affects readability. Usually it takes some juggling of the words to achieve a 

good balance. 

 

2.7.5 Optimize Images:  

Images used within web pages must be reduced to 72 pixels per inch and should be 

resized to fit the location on the page. Un-optimized image files may cause pages to 

load slowly. If the images don't fit the place where they appear on the page, they may 

appear distorted. Image processing for web pages is usually done on a local computer 

before uploading images to the server. Resizing and optimization images to use within 

web pages typically require an image processing program such as Adobe PhotoShop. 

 

Note:  

Images that are uploaded through AShop Deluxe are automatically optimized to 72 

pixels per inch and resized to fit the location on the page.* The program does this for 

each product within the shopping cart when the images are uploaded. This can be a 

big time saver when adding a large number of products to the shopping cart. GD or 

http://ashopwebhosting.com/optimize-content-search-engine.htm
http://ashopwebhosting.com/ashop-deluxe-shopping-cart-features.htm
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ImageMagick ( PHP library tools) must be installed on the server to support automatic 

image optimization by AShop Deluxe. ImageMagick is installed globally on 

AShopWebhosting.com servers. 

 

Basic Steps to Prepare Graphics For Web Pages  

1. Resize the Image: 

Keep your original images in a safe folder so that if you need them again, they will be 

fully intact. Avoid enlarging images as you will lose resolution and end up with a 

muddy looking picture. It is always better to start with a large image file and reduce 

it. The images should be no larger in dimensions than is necessary to achieve the 

desired visual effect. 

 

2. Enhance the Image: 

 Usually changing the size of a raster graphic causes some distortion of the image. 

There are many methods of cleaning up and enhancing your images so that they 

appear sharp, bright, and clear after they have been reduced in size and depth. The 

methods include adjustments to contrast, brightness, saturation, hue, and sharpness. 

For best results, we use Adobe Photoshop. 

 

3. Reduce File Size: 

The download time for a web page is dependent on the amount of data that the page 

contains. A few large image files will slow the download time down to a crawl on 

slow connections. In order to shorten the download time and reduce bandwidth, 

graphics are reduced in file size before inserting into web pages. 

 

4. Logo Design  

A logo is one of the main vehicles for consistently communicating a company's image 

and for gaining attention and recognition. The logo creation (or modification) process 

usually occurs only once or twice in the lifetime of a small business. For most people, 

it is best to have a skilled graphic artist develop an attractive, yet simple logo and 

create several sizes and formats that can be displayed in web pages, publications, ads 

and correspondence. Below are some guidelines for creating a logo. 
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The logo design process starts with a graphic image, which can be rendered from a 

picture or from artwork. It is best to keep the graphic simple with identifiable, 

visually appealing lines. Starting with a stock image or artwork will reduce your logo 

design costs. Creation of custom artwork from scratch will typically increase the cost 

of your logo design substantially. 

Text is then added. There are hundreds of text fonts available. Choose one or more 

that will enhance the visual appeal of the graphic and that will also be appropriate for 

your type of business. Custom font development is considered artwork and will 

increase your logo development cost. 

 

Colors are applied in layers. A simple two-color logo can usually be produced within 

a small budget if the design satisfies the above guidelines. The more colors that are 

added, the more time it takes to refine each layer, which will increase your design 

cost. A full color design packs the most visual punch and will add further to the cost 

of development and production. 

 

2.7.6 Web Page Design & Navigation  

Attractive web pages with easy navigation are critical to the success of a commercial 

website. 

Do-It-Your Self or Hire A Web Designer? 

 

If you have the time and desire to design and manage your own web pages, you will 

need to first get an HTML editor program such as FrontPage, Dreamweaver, or 

HotDog. If you are a quick study, it may only take a few months before you can 

produce marginally adequate web pages. For most serious business people, the time 

that it takes to acquire web design skills is a diversion from their real goal, which is 

marketing of their products or services. For others, working with the web site design 

is a fun way to be personally involved in the creation of your web site. Whether you 

have a professional design or do-it-yourself, it helps to know some basic web site 

design guidelines. 

 

2.7.7 Inserting Meta Tags Into Your Web Pages  

http://en.wikipedia.org/wiki/HTML_editor
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Meta tags are identifiers that are included in the HTML header of web pages. They do 

not appear in the visible web page through the browser. Meta tags are not required for 

your web pages to work, but some (not all) search engines consider them when 

placing your site in relation to the search terms (keywords) used. The meta tags that 

are of primary concern are the keywords and description. 

 

Meta Tags of Importance To Search Engines  

Meta Keyword - The purpose of this tag is to define what keywords apply to your 

page. However, only some search engines will read this tag, and those that do often 

do not place as great importance on it as keywords found in other areas of the page. 

Still, you should generally include a META keyword tag on your page within the 

<HEAD> area.  

 

Example of a META keyword tag: <META name="keywords" content="blue 

widgets, green widgets, red widgets, Jerry's Widget Emporium"> 

 

Commas should separate each keyword or keyword phrase. In general, list keywords 

in lower case. Avoid repeating keywords more than 3 to 7 times, and never list the 

same keyword twice in a row.  

 

Meta Description - The text found in the META Description tag will be displayed to 

the user in the search results for many engines. Therefore, it pays to craft a good 

description so that you not only rank well, but so people will actually click on your 

link once they see it. 

 Example of a META Description tag: 

<META name="description" content="Place paragraph text here."> 

2.7.8 How to Write a Compelling Description: 

The following title and description may get you a high ranking for a keyword search 

on the word "mortgage":  

 

! AAA Mortgage banking, the Mortgage money lenders - Mortgage, lenders, money, 

mortgages, mortgage money, mortgage loans, home equity loans, mortgage money. 
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What it says, however, is unappealing. Instead, look at another site description, which 

would also be ranked high, and see which site you would be more likely to visit: 

 

Mortgage Applications Approved Overnight!! - Mortgages and mortgage financing 

techniques that the larger banks just can't offer. Learn the 8 important things to 

include on your application so that your mortgage can be approved in 24 hours, even 

if you have poor credit. 

 

The listing above has the word "mortgage" as the first word of the title, the first word 

of the description and repeats the word "mortgage" 4 times. The difference is that this 

description is compelling, solves a problem and offers "8 important things" or pieces 

of information that could be valuable to consumers who visit the site. 

 

The direct response businesses - those companies that make infomercials and run 

classified ads in papers across the country - have studied and mastered the art of 

writing headlines. What they learned is that headlines are most effective when they 

accomplish 4 things: 

 

 

1]  Solve a problem 

2]  Solve that problem quickly 

3]  Solve that problem for what appears to be a small or reasonable amount 

4]  Make the reader curious to learn more... 

 

With that in mind, the following headline is acceptable, but not as effective as it could 

be: I can help you to get out of debt and get a good credit rating - I've done it for 

others I can do it for you! 

 

It solves a problem, does so quickly and shows how much money is involved. People 

relate to this appeal because it has a fundamental basis. Remember the many adages 

about goal setting, "A goal without a deadline is a wish!" Or, how about what they 
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teach you in business school about proposal writing, "Never offer a plan that does not 

include both time and money." 

 

The direct response model is effective because it addresses these things, especially 

time and money. Think about this when writing your page description and title before 

you submit them to the search engines. Ask yourself: 

· Is my headline compelling? 

· Is it interesting? 

· Will it make someone curious to learn more? 

· Would I read it and want to visit the site? 

· Does it include time and money? 

· Does it solve a problem? 

· Does it suggest that it solves that problem quickly? 

· Does it show a price? (only emphasize the price if yours is very attractive) 

 

Be careful, you don't want to offend anyone's intelligence. Many direct marketers 

write headlines that underestimate readers. Read it yourself and see if you would find 

the title interesting. If you don't, others won't. This direct response model does not 

apply universally in its purist form. Many websites are not selling things directly, or 

are informational in nature, or support what ad execs would call image advertising. 

However, do not overlook the fundamental truth ―Being first in the search engines is 

great! - Being first and compelling is better‖. 

 

Your listing in the search engine should be compelling. If the description of the site 

right below yours is more compelling, you lose. That prospect just passed over your 

site. 

 

2.7.9 Optimizing Pages For Search Engine Placement  

Search engine positioning is dependent upon keyword prominence within the body of 

your pages, but this is only one part of the formula. Each search engine has its own 

criteria for placing websites. Factors include:  

A. Number AND Prominence of Keywords 

 Domain Name  

http://ashopwebhosting.com/select-keywords.htm
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 File Name  

 Title  

 Body Text 

 Link Text  

 Link URL  

 Image Alt Text 

 Too many or too few keywords will affect your search engine position 

B. Number of Words in Body Text: This varies between 400 and 900 words, 

depending on each 

    search engine. 

 

2.7.10 Contact Forms versus e-mail Links  

Unsolicited email is commonly called spam and it can be a major nuisance. Here are 

some suggestions to avoid being affected adversely by spammers. eMail Spammers - 

Greedy and Ruthless. A common practice for email spammers is to use e-mail address 

harvesting software to "crawl" the web searching for web sites and grab e-mail 

address links from web sites. The email addresses are added to mailing lists and may 

be sold or even distributed for free to other spammers. If you have an email address 

listed on your web site, it is only a matter of time until you are bombarded with 

advertisements for everything from vitamins to Viagra. Filtering through hundreds of 

e-mail messages every day just to find a few messages that are from customers can 

waste a lot of your time AND your chances of receiving computer viruses are 

increased dramatically when your email address is posted on your web site. 

 

Eliminate Email Addresses - Use Contact Forms: Eliminate all email addresses and 

email links from web pages to avoid having your email address harvested by 

spammers. Use a contact form instead. Customers can make initial contact through 

the form page. Then you can reply via e-mail and they can reply to your message and 

save your e-mail address in their address book.  

 

2.7.11 Bounce Messages Not Addressed To An E-mail Identity  

Many times spammers don't even grab legitimate email addresses. They might simply 

add your domain to a mailing list with common email identities such as 
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info@yourdomain or sales@yourdomain. One way to avoid receiving spam this way 

is to use non-standard email identity names. In addition, set the mail server for your 

domain to bounce messages that are not addressed to a legitimate mailbox. 

 

Autoresponders: An autoresponder replies to incoming mail with a canned (pre-

defined) message. 

Benefits of using autoresponders: 

 Immediate confirmation 24/7 that the message has been received. 

 It serves as a follow-up reminder. 

 The message can provide a contact link. 

 The message can provide a link to your website. 

 Information can be dispensed automatically, saving you time. 

 

Here are just a few of the many ways that autoresponders can be used: 

a.   Follow-up On Sales - Enhance your customer service by sending a thank you 

message after the sale.  

b.   Up Sell Products or Services - Offer additional items or upgrades to the product 

or service that was purchased. 

c.   Dispense Information - Build a mailing list, while providing useful information 

to your customers. 

 

2.7.12 Bulletin Board or Forum Programs 

A bulletin board or forum is an electronic message center. Most bulletin boards serve 

specific interest groups. They allow you to review messages left by others, and leave 

your own message if you want to. phpBB is a free bulletin board (forum) program 

written in PHP using a mySQL database. When phpBB is installed on the same server 

as AShop Deluxe, each product can optionally be associated with a phpBB discussion 

group. When someone buys the product, they will automatically be added to the 

corresponding group within phpBB and an email with the phpBB username, password 

and link to phpBB is sent to the customer. Note that due to it's popularity, phpBB has 

become a target for hackers. To avoid being hacked through phpBB, always keep 

phpBB updated to the latest version. Another bulletin board is punBB, which is a free 

http://www.phpbb.com/
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bulletin board program written in PHP using a mySQL database. punBB seems to be 

less prone to hacking than phpBB. AShop Deluxe does not yet integrate with punBB.  

 

2.7.13 Mailing List Programs 

Mailing list programs provide a tool to organize email lists into mailing groups, to 

save pre-defined messages, and to mail to selected individuals, groups, or the entire 

mailing list. 

ListMessenger is a free opt-in mailing list management program written in PHP 

using a mySQL database. When ListMessenger is installed on the same server as 

AShop Deluxe, each product can be associated with a mailing list group within 

ListMessenger. When customers purchase products through AShop Deluxe, they are 

added to the associated mailing list groups. This program can be used to send targeted 

follow-up messages to customers or enewletter subscribers. 

 
2.7.14 Testing  

Test, Test, Test! 

Before publicizing and submitting your web site to the search engines, it is extremely 

important to test EVERYTHING thoroughly! Here is a list of the main things to test: 

 HTML Coding And Links: 

If there are HTML errors on your pages, the search engines may downgrade 

your placement or reject the web site completely. Dreamweaver and most other 

WYSIWYG HTML editing programs include utilities that can check for 

improper HTML coding and broken links. There are also online services that 

check internal and external links in both directions. Many of them offer a demo 

or trial period. It is worth it to make sure that there are no broken links to begin 

with, then stay on top of it by checking again from time to time. 

 Spelling And Grammar –  

Misspellings, typos, and bad grammar are a sure way to turn your customers off. 

Dreamweaver includes a spell checker. Use it! Even if your body text was 

composed in a word processor such as Microsoft Word, you need to check the 

spelling of link text and other text that may have been added or modified during 

the page design process.  

 Cross Browser Support –  

http://scripts.digitalorphans.org/listmessenger/index.php
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There many different possible combinations of browsers, versions, computers, 

and screen resolutions. Your web pages may look great in IE6 and be all 

screwed up in IE5, Netscape Navigator or AOL Browser. You should test your 

web site with at least the three most commonly used browsers and with different 

screen resolutions. Design web pages to fit within the smallest common screen 

resolution.  

 Programs and Forms 

Check all programs such as shopping cart, bulletin board, contact form, 

autoresponder, and submission forms. Go through the process for each program 

in real time as if you are a customer. Make sure that redirection pages open, 

email notices are received, and that database records are updated if applicable. 

This step can be tedious with large web sites, but it is absolutely essential. 

2.8 Summary 

 In this unit we have discussed how to build a case for web planning. We have 

also identified the audience and drawing the blue print for website. If we consider all 

of the mentioned elements in a serious manner, we will be able to design web page. 

 

2.9  Self-check Exercise 

1.  What are Common sections of a website? 

2.  Write Notes on the followings 

a. Auto responders 

b. Bulletin Board 

      c. Navigation 

3. What are the different steps to prepare graphics for web pages?  

4. Discuss in detail overall design guidelines you have studied. 
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Unit 3- Intensive web designing with word and XML 

3.0 Introduction 

3.1 Objectives 

3.2 Word on the web 

3.2.1 Before you begin 
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3.2.3 Trouble-shooting 
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3.5 Creating main templates 
3.5.1Creating Templates for Web Pages 

3.5.2 What is a Web Template?  

3.5.3 Standard Web Template Toolkits  

3.5.4 Let's Write Our Own Web Template Toolkit  

3.5.5 Why use Web Templates?  
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3.7.2 Apply a style 

3.7.3 Use balanced colors 

3.7.4 Select a pre-designed color scheme 
3.7.5 Create a custom color scheme 
3.7.6 Choose the right font 

3.7.7 Add special background effects 

3.7.8 Add a background image to a Web page 
3.7.9 Add a gradient color background to your Web site 

3.8  Working with XML data 
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3.8.2 System Requirements 

3.8.3 Binding a Database 

3.8.4 Working with XML files 

3.8.5 Updating the Database 

3.8.6 Conclusion 

3.9 Summary 
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3.0 Introduction 

 

Designing website using word and XML is interesting as well as challenging for new 

professionals. If the basics related to tools are understood systematically the task will 

be simpler MS Word can create very nice web pages entirely from within the 

program. Because MS Word writes its web pages in XML, historians and other 

practitioners have much more control over the appearance of the text than they might 

have using an HTML editor 

 

3.1 Objectives 

 

After reading this unit we will be able to understand 

- XML,MSXML,XSLT 

- How to Plan word web site 

- Creating main templates 

- Building the Site Framework 

- Working with XML data 

-  

3.2 Word on the web 

 

Like most academics, historians work primarily with text. One of the tasks that they 

face is transferring a syllabus to the Web—without devoting hours to the process. 

Using MS Word‘s Save as Web Page (File > Save as Web Page) looks like it should 

work, and does—after a fashion. But the sprawling web page that results from using 

the command on a raw text manuscript is often a disappointment. 

 

But MS Word can create very nice web pages entirely from within the program. 

Because MS Word writes its web pages in XML, historians and other practitioners 

have much more control over the appearance of the text than they might have using an 

HTML editor. They are, moreover, working in a familiar environment, albeit with a 

few tools that they might not use on a regular basis. A MS Word syllabus will display 

in older browsers but may not be very attractive and contain strange characters. 

Microsoft‘s XML implementation also adds a good deal of proprietary code to the 
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web page, resulting in a larger page, a bit longer download time. With these 

constraints in mind, the goal of this unit is to provide the steps toward creating a well-

designed, visually interesting, web-based syllabus entirely within MS Word and 

XML.  

 

There are a number of different ways and shortcuts—as is the case with most software 

applications—to make a web page out of a MS Word document. This unit focuses one 

of the simplest and most accessible. The steps follow the conventions of menu > 

selection. So, ―Choose View > Normal‖ translates into pulling down the View Menu 

from Menu Bar and selecting Normal. With a little practice, turning a manuscript into 

a nicely formed web page should take about 10 minutes, again depending on how 

much tweaking you want to do. 

 

3.2.1 BEFORE YOU BEGIN 

Although it may seem self-evident, the Web differs from word processing in a 

number of ways, so we‘ll begin by cleaning up the syllabus copy so that it is more 

webcentric. If you are working on an existing syllabus, do not use an original ms for 

experimentation. Make a duplicate so that you have a hedge against inevitable 

software misfortunes. These steps are not entirely necessary, but working through 

them will prevent confusion later on and demonstrate several of MS Word‘s 

capabilities. 

 

Move on to ‚―Designing the Syllabus for the Web‖ if you want to get right to work. If 

you have your copy made and want to ―take it from the top,‖ open your document and 

do the following: 

1.      Choose Edit > Select All. 

2.     Choose Normal from the ―Style‖ drop-down menu on the Formatting Palette 

On a Mac using MS Office X, once you have Selected All, choose Clear Formatting > 

Formatting Palette and then choose Normal. > Formatting Palette 

1.      Click the 1 and 1/2 button from ―Line Spacing‖ on the Formatting Palette 

2.     Select a line of text that you want as a subhead. 

3.     Choose Heading 1 or Heading 2 from ―Style‖ drop-down menu on the Formatting 

Palette. 
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4.     Repeat for Steps 4 & 5 for all lines of text that you want as subheads. (To speed 

up the  

     process, use COMMAND + Y (Mac) or CONTROL + Y (PC) to repeat the last 

action.) 

5.     Remove any tabs 

 

Tabs are troublesome on the Web; you‘ll spend more time trying to make them work 

on your web page than is worthwhile, so get rid of them early on. 

Now we‘ll add some specifically webcentric elements: rules and bulleted lists to the 

syllabus by doing the following: 

1.      Select a place between sections for a horizontal rule 

2.     Choose Insert > Picture > Horizontal Rule. 

3.     Navigate to Clip Art Folder > Lines Folder 

4.     Select Default Line and click Open. 

5.     Select some text for a list. (The book list or readings for a particular day are good 

candidates  

     for lists.) 

6.     Choose Format > Bullets and Numbering. 

7.     Click the Bulleted tab. 

8.     Click on one of the bullet options. 

9.     Click OK. 

For the purposes of experimentation, it is sometimes advantageous to work from 

scratch by dummying up a two- or three-page syllabus that includes the following: 

 Several subheads 

 An illustration or two 

 A bulleted list or two 

 Generous white space 

 Horizontal rules to set off sections 

 Define three styles: Normal, Heading1, Heading 2  

If you are unsure about how to define a style, consult MS Word‘s online help facility. 

Styles are a great timesaver for academics, and it pays to put some effort into 

mastering styles. 

Web visitors ―read‖ differently on the web; they scan rather than read, and subheads 

and bulleted lists aid scanning. Be sure that the manuscript follows standard word 

processing typographic conventions. Do the following: 

 Be sure that only one space follows a period, colon, and question mark 

 Change all quotation marks to ―curly quotes‖ 
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 Select a web-centric font (Verdana, Arial, or Comic Sans for sans serif and 

Georgia or Trebuchet for serif—anything but Times New Roman) and a 

size of 10 points. 

 Set the line spacing or leading to 1 1/2 spaces 

 

3.2.2 DESIGNING THE SYLLABUS FOR THE WEB 

Now that the manuscript has been ―massaged,‖ it‘s time to begin the actual 

construction. In this section, we‘ll turn the text into a single-cell table and set the 

table‘s width to accommodate a good, readable line length. 

1.      Choose View > Normal. 

2.     Choose Edit > Select All. 

3.     Choose Table > Convert > Text to Table 

4.     Type 1 in Number of Columns. 

5.     Type 5 in Initial Column Width 

6.     Click OK. 

7.     Select File > Web Page Preview. 

 

The table is now narrower, but it has unsightly black lines separating paragraphs. The 

table is also flush against the left side of the browser window. To remove the table 

grid lines, do the following: 

1. Choose Table > Select > Table. 

2. Choose Format > Borders and Shading. 

3. Click None under Setting. 

      4.     Click OK.  

      5.     Select File > Web Page Preview. 

 

To center the page, so that it floats gracefully to the center of the browser window, do 

the following: 

1. Choose Table > Select > Table 

2. Choose Table > Table Properties 

3. Click Center in Alignment 

4. Click OK. 

5. Select File > Web Page Preview. 
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The page no longer has a border and centers itself in the web browser window. But 

the page is rather plain. 

 

In this section, we‘ll add a theme. Be careful to select a theme that promotes high 

legibility and readability. In other words, choose a theme with high contrast—dark 

text on a plain or muted background. Like the ―little black dress with pearls‖ black 

text on white background is always in style. For pages containing large blocks of text, 

avoid light text on a dark background—what designers call ―reversed out‖ text. It is 

difficult to read and scan and may cause printing problems. ―Kids‖ (for the whimsical 

at heart) ―Blocks‖ and ―Loose Gesture‖ are good choices. 

1. Choose Table > Select > Table 

2.   Choose Format > Theme. 

3. Click Active Graphics and Background Image. 

4. Scroll to Blocks (or a theme of your choice) in the Theme pane 

5. 5.     Click Blocks (or a theme of your choice) 

6. Click OK. 

7. Choose File > Web Page Preview. 

 

If you discover that you have few themes to choose from, install additional themes 

from your original CD or go to Microsoft‘s website Mactopia (Mac) and download 

additional themes. When you are satisfied with your layout and formatting, do the 

following: 

1. Choose File > Save As Web Page. 

2. Click ―Save entire file into HTML.‖ 

3. Click Web Options. 

4. Type a tile in the ―Web page title‖ box. 

5. Type several keywords in the ―Web page keywords‖ box. 

6. Click the Files tab. 

7. Click ―Update links on save.‖ 

8. Click the Picture tab. 

9. Choose ―1024x768. . . .‖ from the ―Screen Size‖ drop-down menu. 

10.    Click the Encoding tab. 

http://www.mactopia.com/
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11. Choose ―Unicode (UTF-8)‖ from the ―Save this Web Page as‖ drop-down 

menu. 

12. Click OK. 

13. Click Save. 

 

Essentially, the web page is ready to upload to a server. To upload your syllabus, you 

will need an FTP program. Although there are many FTP programs, many Wintel 

users find WS_FTP serviceable, and Mac users find Fetch equally useful. You should 

also check with your university IT department to see if your institution maintains a 

site license. In the event, the software will be available for you to download. When 

you do FTP your syllabus, remember to upload the folder associated with the web 

page. Once it is on the server, be sure to check it in your web browser. 

 

3.2.3 TROUBLE-SHOOTING 

If you put your pages on the server and notice that your quotation marks, apostrophes, 

and em- dashes have disappeared, you have problem but not one that is difficult to 

solve. Some versions of MS Word fail to translate these special characters into 

Unicode. The solution is to use Find and Replace in a text editor. Tex-Edit, a 

shareware program for the Mac (not TextEdit that is included with OSX) or 

SimpleText for the Mac and Notepad for Wintel are good tools. The most common 

candidates for Find and Replace are: 

 Left double quotes &#8220; 

 Right double quotes &#8221; 

 Em dash &#8212; 

 Apostrophe  &#8217; 

 Ellipsis &#8230; 

If you need to replace other special characters, see one of the Unicode pages, such as 

Alan Wood's Web Site. Click on Character Entity References in HTML 4.0 to find 

codes for any other special characters. 

1.      Choose File > Open and open you syllabus.htm file. 

.     Choose Edit > Replace 

3.     Type OPT + [ (Mac) or ALT + [ (Wintel) for the left ―curly quote‖ in the Find 

What box and 

http://www.ftpplanet.com/download.htm
http://fetchsoftworks.com/
http://www.alanwood.net/index.html
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     &#8220; in the Replace box. Note that the Unicode entity ends in semi-colon. 

4.     Click Replace All. 

5.     Type OPT + SHIFT + [ (Mac) or ALT + SHIFT + [ (Wintel) for the right ―curly 

quote‖ in the 

    Find What box and &#8221; in the Replace box. Note that the Unicode entity ends 

in semi- 

    colon. 

6.     Click Replace All. 

7.     Type the apostrophe OPT + SHIFT + ] (Mac) or ALT + SHIFT + ] (Wintel) in the 

Find What  

     box and &#8221; in the Replace box. Note that the Unicode entity ends in semi-

colon. 

8.     Click Replace All. 

9.     Continue using Find and Replace until all your special characters are accounted 

for. 

10.   Choose File > Save. 

Upload your page to the sever once more and check it in your browser. 

 

3.2.4 FINISHING TOUCHES 

There are, however, some editing or additions that you may wish to make to so that 

the manuscript looks more ―at home‖ on the web. Some of these might be: 

1. Changing the color or formatting of the subheads and so forth. To change the 

color or formatting of a subhead, modify its style. Choose Format > Style. 

Click the desired style (Heading 1, Heading 2, or Normal) in the Styles pane. 

Click Modify. Choose Font from the Format drop-down menu and make your 

selections. 

2. 2.     Change the theme altogether. You can try out themes endlessly until you 

find one that works best for you and for your material. Choose Format > 

Theme and experiment away. Remember to click Background Image to get an 

idea of the background‘s effect on the page. If the background is not one you 

want or one that interferes with reading the text, unclick Background Image. 
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3. 3.     Put in tabs that may have disappeared or that may be necessary. In a table, 

pressing the tab key moves from cell to cell. Type OPT + TAB (Mac) or ALT 

+ TAB (PC) to insert a tab in a table cell. 

4. Single-space double-spaced items or bring together lines that need to be kept 

close. Use a soft return by pressing SHIFT + RETURN (Mac) or SHIFT + 

ENTER (PC) to keep lines close together. 

 

3.2.5 A FEW LAST WORDS 

There‘s a great deal more that you can do within MS Word to increase the 

sophistication of your web page. Some but not all of your experiments will transfer 

successfully from MS Word to the web. Spend a few hours learning and ins and outs 

of tables and styles; getting a handle on tables and styles is helpful for not only for 

web page construction but also for standard word processing. And to think that a 

Microsoft product makes it all so easy fairly boggles the mind. 

 

3.3 XML,MSXML,XSLT 

3.3.1  What is XML? 

XML is a markup language for documents containing structured information. 

Structured information contains both content (words, pictures, etc.) and some 

indication of what role that content plays (for example, content in a section heading 

has a different meaning from content in a footnote, which means something different 

than content in a figure caption or content in a database table, etc.). Almost all 

documents have some structure. 

A markup language is a mechanism to identify structures in a document. The XML 

specification defines a standard way to add markup to documents. 

What's a Document? 

The number of applications currently being developed that are based on, or make use 

of, XML documents is truly amazing (particularly when you consider that XML is not 

yet a year old)! For our purposes, the word "document" refers not only to traditional 

documents, like this one, but also to the myriad of other XML "data formats". These 

include vector graphics, e-commerce transactions, mathematical equations, object 

meta-data, server APIs, and a thousand other kinds of structured information. 

So XML is Just Like HTML? 
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No,  in HTML, both the tag semantics and the tag set are fixed. An <h1> is always a 

first level heading and the tag <ati.product.code> is meaningless. The W3C, in 

conjunction with browser vendors and the WWW community, is constantly working 

to extend the definition of HTML to allow new tags to keep pace with changing 

technology and to bring variations in presentation (stylesheets) to the Web. However, 

these changes are always rigidly confined by what the browser vendors have 

implemented and by the fact that backward compatibility is paramount. And for 

people who want to disseminate information widely, features supported by only the 

latest releases of Netscape and Internet Explorer are not useful. 

XML specifies neither semantics nor a tag set. In fact XML is really a meta-language 

for describing markup languages. In other words, XML provides a facility to define 

tags and the structural relationships between them. Since there's no predefined tag set, 

there can't be any preconceived semantics. All of the semantics of an XML document 

will either be defined by the applications that process them or by style sheets. 

 So XML Is Just Like SGML? 

No. Well, yes, sort of. XML is defined as an application profile of SGML. SGML is 

the Standard Generalized Markup Language defined by ISO 8879. SGML has been 

the standard, vendor-independent way to maintain repositories of structured 

documentation for more than a decade, but it is not well suited to serving documents 

over the web (for a number of technical reasons beyond the scope of this section). 

Defining XML as an application profile of SGML means that any fully conformant 

SGML system will be able to read XML documents. However, using and 

understanding XML documents does not require a system that is capable of 

understanding the full generality of SGML. XML is, roughly speaking, a restricted 

form of SGML. 

For technical purists, it's important to note that there may also be subtle differences 

between documents as understood by XML systems and those same documents as 

understood by SGML systems. In particular, treatment of white space immediately 

adjacent to tags may be different. 

 Why XML? 

In order to appreciate XML, it is important to understand why it was created. XML 

was created so that richly structured documents could be used over the web. The only 

viable alternatives, HTML and SGML, are not practical for this purpose. 

http://www.xml.com/pub/a/98/10/guide0.html?page=3#WHITESPACE
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HTML, as we've already discussed, comes bound with a set of semantics and does not 

provide arbitrary structure. 

SGML provides arbitrary structure, but is too difficult to implement just for a web 

browser. Full SGML systems solve large, complex problems that justify their 

expense. Viewing structured documents sent over the web rarely carries such 

justification. 

This is not to say that XML can be expected to completely replace SGML. While 

XML is being designed to deliver structured content over the web, some of the very 

features it lacks to make this practical, make SGML a more satisfactory solution for 

the creation and long-time storage of complex documents. In many organizations, 

filtering SGML to XML will be the standard procedure for web delivery. 

 

XML Development Goals  

The XML specification sets out the following goals:   

1. XML shall support a wide variety of applications. XML should be beneficial 

to a wide variety of diverse applications: authoring, browsing, content 

analysis, etc. Although the initial focus is on serving structured documents 

over the web, it is not meant to narrowly define XML. 

2. XML shall be compatible with SGML. Most of the people involved in the 

XML effort come from organizations that have a large, in some cases 

staggering, amount of material in SGML. XML was designed pragmatically, 

to be compatible with existing standards while solving the relatively new 

problem of sending richly structured documents over the web. 

3. It shall be easy to write programs that process XML documents. The 

colloquial way of expressing this goal while the spec was being developed 

was that it ought to take about two weeks for a competent computer science 

graduate student to build a program that can process XML documents.  

4. The number of optional features in XML is to be kept to an absolute 

minimum, ideally zero. Optional features inevitably raise compatibility 

problems when users want to share documents and sometimes lead to 

confusion and frustration.  

5. XML documents should be human-legible and reasonably clear. If you don't 

have an XML browser and you've received a hunk of XML from somewhere, 
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you ought to be able to look at it in your favorite text editor and actually figure 

out what the content means.  

6. The XML design should be prepared quickly. Standards efforts are notoriously 

slow. XML was needed immediately and was developed as quickly as 

possible.  

7. The design of XML shall be formal and concise.  

8. XML documents shall be easy to create. Although there will eventually be 

sophisticated editors to create and edit XML content, they won't appear 

immediately. In the interim, it must be possible to create XML documents in 

other ways: directly in a text editor, with simple shell and Perl scripts, etc.  

9. Several SGML language features were designed to minimize the amount of 

typing required to manually key in SGML documents. These features are not 

supported in XML.  

 How Is XML Defined? 

XML is defined by a number of related specifications: Extensible Markup Language 

(XML) 1.0 

 

Defines the syntax of XML. The XML specification is the primary focus of this 

section. 

As time goes on, additional requirements will be addressed by other specifications. 

Currently (Sep, 1998), namespaces (dealing with tags from multiple tag sets), a query 

language (finding out what's in a document or a collection of documents), and a 

schema language (describing the relationships between tags, DTDs in XML) are all 

being actively pursued. 

 

You combine the power of XML and programming languages such as JavaScript, 

Visual Basic, and C++ when you use Microsoft‘s XML Core Services, simply 

referred to as MSXML. MSXML is an application program interface that contains 

features that enable you to interact with XML from within an application written in 

one of the commonly used programming languages.  

 

This means that you can unleash an XML document from within a program rather 

than having to use a web browser. You can easily integrate any XML document into 

http://www.w3.org/TR/WD-xml
http://www.w3.org/TR/WD-xml
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your application by calling features of MSXML from within your program.  You‘ll 

learn about MSXML in this chapter and how to access an XML document using 

JavaScript. The same basic principles used for JavaScript can be applied to other 

programming languages.  

 

3.3.2 What Is MSXML?  

XML is a dynamic approach to managing information. As you‘ve learned throughout 

this book, you can access an XML document using an XML-enabled browser. This is 

fine if you want to display all or a portion of an XML document. Simply follow the 

directions we present in this book and you‘re able to view information contained in 

the XML document from your browser.  

However, accessing an XML document using an application other than a browser can 

be tricky because code must be written within the application to extract information 

contained in the XML document.  

 

Fortunately, Microsoft provides the magic to take the pain out of writing code to 

access an XML document from within an application with Microsoft XML Core 

Services—MSXML for short. MSXML consists of preprogrammed classes and 

functions that contain code to access and manipulate information in an XML 

document.  

 

You don‘t have to write the tedious code to read and parse an XML document 

because Microsoft has done this for you. All you need to do is to call the appropriate 

classes or functions within your application to work with an XML document.  

 

MSXML is designed for a variety of programming languages, including C, C++, 

Visual Basic, VBScript, Jscript, and JavaScript. You can download the MSXML API 

at http://msdn.microsoft.com/xml/default.aspx, and will need to do 

so before you can use the examples we illustrate in this chapter.  

 

We use JavaScript as the programming language for this chapter because you don‘t 

need to use a compiler to create a JavaScript application. You simply write the code 
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using the same editor that you use to write your web page. JavaScript is executed by 

calling the JavaScript from a web page using your browser.  

 

We‘ll show you a few JavaScript basics in this chapter—enough so you can get 

started using MSXML. However, you may want to read JavaScript Demystified by 

Jim Keogh (McGraw-Hill Osborne Media, 2005) to become proficient using 

JavaScript.  

You‘ll need to install the MSXML API or download it from the Microsoft web site. 

We‘re using version 4.0; however, you should download the latest release.  

 

 

 

3.3.3 What Is XSLT?  

Extensible Stylesheet Language Transformations (XSLT) has evolved from the early 

Extensible Stylesheet Language (XSL) standard. XSL specifies a language definition 

for XML data presentation and data transformations. Data presentation means 

displaying data in some format and/or medium. Presentation is about style. Data 

transformation means parsing an input XML document into a tree of nodes, and then 

converting the source tree into a result tree. Transformation is about data exchange.  

 

Because these functionalities serve two distinct purposes, XSLT was proposed and 

later accepted as a separate standard for XML data transformation only. XSL is now 

generally referred to as XSL Formatting Objects (XSL-FO), to distinguish it from 

XSLT. The future of XSL-FO as a standard is uncertain, because much of its 

functionality overlaps with that provided by cascading style sheets (CSS) and the 

HTML tag set. If cross-vendor compatibility is important, you might want to avoid 

XSL-FO until it becomes a standard fully accepted by the Worldwide Web 

Consortium. 

 

XSLT is a Programming Language  

From a programmer's point of view, XSLT is a programming language for processing 

XML data — that is, transforming XML documents. As such, it supports the 

following:  
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 A small set of flexible data types: Boolean, number, string, node-set, and 

external objects. 

 A full set of operations: <xsl:template>, <xsl:apply-templates>, 

<xsl:sort>,<xsl:output>, and so on. 

 Programming flow-control: <xsl:if>, <xsl:for-each>, <xsl:choose>, and 

so on. 

XSLT adopts the XPath language syntax for expressions. There are also built-in and 

custom extension functions for building expressions for XML data queries and 

transformations. An XSLT style sheet is an XML document. This means that XSLT 

instructions are expressed as XML elements, and an XSLT style sheet can transform 

other XSLT style sheets, or even itself. 

 

3.4  Planning word web site 

3.4.1 How do I figure out what I want? 

An easy way to answer this question is to look at other business Web sites — both in 

your specific industry and in your business category, such as retail sales, 

manufacturing, or services.  

As you view these sites, ask yourself: 

 What do I like about this Web site? What do I dislike about it? 

 Does the page hierarchy (also called navigation) make sense?  

 What information can I link to from the home page? How is the information 

organized? 

 Do the categories and subcategories of information make sense? 

 How are the pages laid out? Are they using one or more columns? 

 Is the page easy to read? How does the page use headings, lists, and links? 

 How much information is on each page? Is finding information easy? Is the 

information complete?  

 Would a page like this be useful on my site? If yes, what would I do 

differently?  

 

3.4.2 What Web site pages do I need? 

You must decide how much information you want to present to your Web site visitors 

before determining the number of pages that you need. 
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 Make a list of the information you want to present.  Be general and be 

specific. Listing broad categories in addition to specific information helps you 

determine how to organize your site. Such organization also helps you name 

your pages and think about how visitors find those pages. 

 Present one idea per page.  Statistics show that site visitors spend less than 

10 seconds looking for specific information before they go somewhere else. 

The idea can be a large category of information, with links to more specific 

information, or one specific set of information. 

For example, a manufacturing company has a Products page on their Web site, 

which gives a general overview of all the types of products that they 

manufacture. Descriptions of each product type are located on subsequent 

pages. Users reach these pages by clicking links on the Products page. The 

main purpose of these pages is to give a more detailed description of the 

individual products. 

 Make your page names easily identifiable.  When you create new pages, 

you give them both a page title and a name. The page title appears in the 

browser's title bar, and the page name is appended to your Web address. The 

page title can be changed at any time, but the page name cannot. It is 

recommended that you use a page name that reflects the content of the page. 

 

 

 

3.4.3 What should my Web site look like? 

The Web design tool included with Office Live Small Business makes designing your 

overall Web site easy. Using Site Designer, you choose the theme, style, and color so 

that all of your Web pages will have the same look. Your header and footer are used 

on every page of your site. You can, of course, individualize each page. 

 Create a meaningful header.  The content that you put in your header 

appears throughout your entire site, not just on your home page. Think about 

all of the pages you are creating, and ask yourself, ―does my header make 

sense for each page?‖ The header can include just your company name, or it 

can include your company slogan or a description of your business. You can 

also add a logo. 
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 Less is more.  Too many colors, too many font changes, or too much content 

will confuse visitors to your Web site. If there are too many design elements 

competing for attention, nothing stands out. 

 Be consistent.  Stick with one heading style, font, and layout, if possible. If 

you change the look on every page, your visitors may not associate what they 

see on the site with your business. 

 

3.4.4 How will visitors get around on my Web site? 

Unless your Web site has only one page, you need to decide how visitors will 

navigate to other pages to find the information that they need. When you make a list 

of all the information that you want on your site, try to group the larger categories of 

information with the related categories underneath each category. You may find that 

some information fits under more than one category. 

There are several ways to direct your Web site visitors to other pages on your Web 

site. You can use links in the navigation bar, inline links, and links in the footer. 

 Create a useful navigation bar.  The same navigation bar appears on every 

page on your Web site. The links on this bar are always available to your 

visitors. A good rule of thumb is to have no more than six main links in your 

top-level (or parent) navigation, and then a similar number of subcategory (or 

child) links under any parent link. 

 Include all of the pertinent pages under the main category.  As noted 

earlier, you may find that one page really belongs in several different 

categories. Go ahead and include that link under each link for the category to 

which it applies. For example, for a site that advertises apparel, a page that 

contains a sizing chart may be pertinent to the Men, Women, and Children 

main categories, and also to each product subcategory. You can include the 

page link for the sizing chart in each of those categories. 

 Use links in your content.  Inline links can be some of the most effective 

ways to drive traffic to other pages on your Web site. These links are used in 

context, so users know exactly what they will find. You can use both text links 

(links that are embedded in the written portion of your page) or picture links 

(pictures that, when clicked, open a new page). 
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 Use your footer to link to other pages.  Because the footer is used on every 

page on your Web site, it is a great way to send your visitors to useful content. 

Typically, footer links go to pages that visitors use frequently but may be 

buried in the page navigation. You can, for example, link to a careers page, the 

site map page, a business hours and location information page, and a Contact 

Us page. 

3.4.5 What about my content? 

Most people do not read every word on a Web page; instead, they scan it. With only a 

few seconds to grab the attention of your visitor, you have to decide what information 

your visitors are looking for, and make that information prominent. 

 Make each page ―scannable.‖  Using large, unbroken blocks of text is a sure 

way to lose your visitors' interest. Break up your information into smaller 

chunks by writing short paragraphs using only one or two sentences, creating 

bulleted lists, or bolding important information within a block of text. 

 Use pictures.  A photo or other graphic can communicate lots of information 

quickly. The picture should be immediately recognizable and convey your 

message at the same time. And don't hesitate to use the picture as a link to 

more information.  

 Speak the language of your customers.  Don't let industry jargon or highly 

technical terms that your visitors may not understand appear in your content.  

 Answer your visitors' questions.  Make sure that the content on each page 

addresses the information your Web site visitors expect to see discussed. For 

example, a Contact Us page should have all of the ways a person can find you: 

phone numbers, e-mail addresses, street address, driving directions, and when 

you are available. 

 Redundant links are okay.  If content is pertinent to several areas of your 

Web site, be sure that visitors can access it. Include links to the information, 

either on the navigation bar or through an inline link. Your goal is to make 

sure visitors can find what they need, when they need it. That could mean, for 

example, having multiple links to the same page from different areas on a 

single page (a navigation bar link and an inline link). 
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3.5 Creating main templates 

3.5.1Creating Templates for Web Pages 

The purpose of this section is to explain web templates and to quickly write some 

code demonstrating it in action. The section is for absolute beginners who want to 

understand the basic principles of templating.  

 

3.5.2 What is a Web Template?  

The basic purpose of templating is to separate presentation from logic. Presentation is 

usually referred to markup languages like HTML, XHTML. Logic is the part handled 

by programming language like PHP, Perl, Python, Ruby, etc.  

 

3.5.3 Standard Web Template Toolkits  

There are many open source web template toolkits available. For example, 

 Perl: Template.pm module  

 PHP: Smarty  

 Python: Cheetah  

 Ruby: Web::Template module  

The feature sets of these standard template toolkits can be fairly large. There are many 

built-in functions that can completely separate presentation from logic.  

 

3.5.4 Let's Write Our Own Web Template Toolkit  

We will create two files: 

 index.pl: will contain Perl codes  

 template.inc: will contain HTML codes  

Let's start easy and write the template.inc file: 

# file: template.inc 

<html> 

<head></head> 

<body> 

<h1>Our Company</h1> 

{{content}} 

<small>Copyright Foo Bar</small> 

</body> 

</html> 

Note that we have defined a template variable above enclosed in {{}} as {{content}}. 

We will parse this template variable in our Perl code in index.pl:  

#!/usr/bin/perl 

# file: index.pl 
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use CGI qw/:standard/; 

print header; 

 

my $content = "Welcome to our website. This is the main content 

area."; 

 

open(FH, 'template.inc') || die "CanÕt open file; $!\n"; 

while(my $line=) { 

 $line =~ s/{{content}}/$content/; 

 print $line; 

} 

close FH; 

Now for some explanation. 
#!/usr/bin/perl 

use CGI qw/:standard/; 

print header; 

 

The above block initializes the perl script, uses the CGI module and sends some basic 

headers to the browser.  

my $content = "Welcome to our website. This is the main content 

area."; 

This declares what the content of the site will be. 

open(FH, 'template.inc') || die "Can't open file; $!\n"; 

while(my $line=) { 

 $line =~ s/{{content}}/$content/; 

 print $line; 

} 

close FH; 

 

This is our template engine - 6 lines of code. It opens the template file, reads each line 

- one by one. As soon as it finds the predefined template variable {{content}} it 

substitutes it with the $content variable and prints the output to the browser. If no 

match is found the line is simply printed to the browser without substitute. Finally out 

of the loop, it closes the file handle.  

A better design of the code shown above would be: 

 To make it a function and place in separate file so other *.pl files can call it  

 Instead of hard linking {{content}} - pass it as a functional argument so that 

users can declare and use template variables at will  

 

3.5.5 Why use Web Templates?  

Separating presentation from logic in web templates provide two important functions. 
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1. Efficiency for Designers and Programmers: Designers and programmers are 

usually concerned with two separate aspects of website development. 

Designers are more interested in presentation aspects of a web page, while 

programmers are concerned more with the coding and establishing business 

logic.  

2. Reusing Common Page Elements: A common use of templates is simply to 

reuse the most common elements of a web page like the header (your 

company logo and slogan), menus (main navigation bar) and footer (copyright 

message).  

3.5.6 Conclusion  

Sometimes developers will use a very lightweight toolkit or a home-brewed system 

where most of the presentation is separated from logic (but not all). The code base can 

be much smaller and simpler to maintain if some mixing of presentation and logic is 

allowed.  

 

There are advantages and disadvantages of both hybrid and full-scale template 

implementations. These two questions below can help you decide which approach to 

follow.  

 Are you willing to maintain extra code so that you can have presentation 

completely separated from logic?  

 Do you value simplicity and don't mind presentation code and logic mixed 

together?  

There is no right or wrong approach about this. Depending on your needs just use 

what works for you. 

 

3.6 Building the Site Framework 

The framework for what a page is has changed considerably even in the past few 

years, though our applications for designing those frameworks are still stuck in the 

web, and largely dictated by their use for print design. This section focuses on some 

of the tools we currently have at our disposal, mostly either freely available or from 

Adobe. 

 

3.6.1 What’s this ―design‖ you speak of? 

http://www.zeldman.com/2010/07/05/an-indesign-for-html-and-css/
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Design is a multifaceted problem. How something behaves is interdependent on how 

it looks, sounds, reads, moves, and responds. We can‘t separate these from the end 

result, but we can divide and conquer them during the creative process. Web design is 

not merely building. It‘s not just designing. It‘s not only the rest of the myriad 

disciplines and titles we all align ourselves with, but the culmination of all these 

things. 

 

3.6.2 One process, or ―how I work‖ 

For over a decade, I‘ve been designing websites. And I‘ve followed nearly the same 

process for every one of them: once it‘s time for visual design to happen, I typically 

start out in rough form (sketches, grey boxes), then move on to higher fidelity comps 

in Photoshop. I make these Photoshop comps look as real as possible, and continue to 

revise them for clients until they sign off on the designs. I make exceptions as needed 

depending on the problem at hand, but I rarely allow much visual design and layout to 

happen during coding. This includes painstakingly changing type styles and colors in 

Photoshop when revisions are needed. I‘m experienced enough with making websites 

that I know what I can push off until coding happens, and how certain things will act 

when in use. I like spending my time this way because it helps me focus on the story 

I‘m trying to tell with my design. 

 

 

 

3.6.3 Our current toolbox 

Every option out there has its tradeoffs. These are not intended to be knocks against 

the goals of these applications; they‘re all powerful in their own right. The purpose of 

this brief audit is to highlight the gaps in the creative process. 

 

 
Photoshop has high-fidelity design capabilities and image editing, but the type 

rendering isn‘t true-to-browser and it‘s lacking in layout capabilities. Each new 

release feels more bloated and directionless than the last. 

http://www.adobe.com/products/photoshop/family/
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Illustrator is great for drawing and working with vectors, but the type and image 

rendering aren‘t true-to-browser and it‘s ill suited for anything but the simplest 

layouts. 

 
InDesign is capable of high-fidelity layouts and has advanced type styling features 

with stylesheets, but it‘s primarily a print application and lacks the language and feel 

for screen-based designs. 

 
Fireworks showed promise back in the hands of Macromedia, but it has taken a 

backseat under Adobe. It‘s primarily a screen-based design app and is great for 

prototyping and image optimization, but it lacks true-to-browser type rendering, is 

flakey performance-wise, and feels neglected among the flagship Adobe products. 

 
Dreamweaver is a hybrid WYSIWYG text editor with true-to-browser type and 

layout rendering, but it lacks flexible visual design capabilities, image editing, and 

typographic control. 

 
Browsers are obviously the baseline for type and layout rendering as they are the 

platforms we‘re designing for; but the design production is then transferred to hand 

coding in text editors. Hand coding isn‘t the problem here; it‘s the prospect of laying 

out a page without design production tools that‘s difficult for many (myself included). 

 

In recent years, a few indie image editing apps have hit the scene, including 

Pixelmator and Acorn. These apps, and others like them, are impressive 

achievements, and a good alternative for certain tasks like image editing. 

Unfortunately, they aren‘t sophisticated enough to compete with the applications 

above when it comes to web design and layout. And that‘s OK—I don‘t believe they 

want to compete in this space; I only mention them for the purpose of discussion. 

http://www.adobe.com/products/illustrator/
http://www.adobe.com/products/indesign/
http://www.adobe.com/products/fireworks/
http://www.adobe.com/products/dreamweaver/
http://www.pixelmator.com/
http://flyingmeat.com/acorn/
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3.6.4 A wishlist 

So what does an app that‘s made for web design look like? What are the native and 

common attributes that keep popping up with every page we design? This is a start for 

the considerations I find myself making on nearly every design I work on. 

 

3.6.4.1 Per document grids 

Different designs require different grids. Currently, in an app like Photoshop, you are 

only able to set global grid settings. Meaning, if you want to use different grids for 

your documents, you need to change these settings each time. Many people I know 

(myself included) get around this by just drawing out a grid on a separate layer and 

placing it above all the other layers. The disadvantage of this is not being able to use 

any sort of snap-to-grid and alignment functions built into the program. Everything 

either needs to be eyeballed or placed mathematically through a measurement palette. 

Having this reside at the document level would allow a design‘s grid to travel with it 

and stay intact for repeat uses (especially important when working as part of a team 

and sharing documents). 

 

 

 

3.6.4.2 Page states 

Webpages are living, dynamic spaces where the smallest interaction from a visitor can 

change the scope of an entire site. Menus can emerge and recede, system messages 

display and require action, page elements move, and the contents shift, all without the 

need for a page refresh. Because we‘re not dealing with a static medium, we need to 

be able to design for interactions and the shifting landscapes of a webpage. This is 

probably heading into something akin to object-oriented design, but an application 

needs to see elements rather than blocks of color or text. Photoshop, Illustrator, and 

Fireworks have some low-level functionality in this regard, but the need for more 

dynamic and non-destructive handling is clear. 
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The Character and Paragraph Style palettes from InDesign are able to globally control 

type similarly to how we use CSS. 

 

3.6.4.3 CSS-esque type styling (dynamic styles palette) 

This one should come as no surprise. CSS saves loads of time when it comes to global 

changes to typography. Merely changing a link color or font styling for a headline in a 

Photoshop file can be tedious because they aren‘t centrally controlled. In Design 

offers Character and Paragraph styles, which work like a charm. Something along 

those lines, but obviously geared a bit more towards CSS functionality, would be key. 

Additionally, being able to relatively link type styles (―make h2s 200% the base body 

text size‖) would be very powerful. 

 

3.6.4.4 Fonts 

Fonts are exploding on the web in a big way. The ability to design with external fonts, 

or be able to use WOFF fonts safely, would help depict our designs better, and allow 

for quicker changes. Hell, being able to specify a font stack along with your styles—

so you could quickly cycle through the visual changes that occur with fallback 

fonts—would be killer. 

3.6.4.5 Page flow, text wrap, and fluidity 

Every element on a webpage has the ability to affect the layout of other elements. We 

should be able to specify what actions to take (float, clear, wrap, etc.) when that 
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happens. Additionally, a browser window is a fluid canvas; desktop design apps only 

work with a fixed canvas size, making comping a fluid/flexible design little more than 

a guess. 

 

3.6.4.6 Knowledge of current browser interfaces 

Using any of the desktop design apps for web design means having a bit of 

knowledge for the parameters of a browser window and screen sizes. Most of us 

probably work at what we consider a safe size (right now, likely around a 960px-wide 

viewing area). An application that can be configured to preview for a given screen 

size or the sizes of the different browser chromes (not unlike xScope‘s ―Screens‖ 

feature) could be really handy. Especially if the different views of a browser also 

carry with them the rendering styles, defaults, fonts, and more for the platform and 

browser version. 

 

3.6.4.7 Forms 

Form elements are part of the basic language of the web. I‘m tired of taking 

screenshots of forms in various states just to comp into a page. These things are baked 

into the OS, and an app should be able to easily allow for their display, not as 

bitmaps, but as editable objects. 

 

3.6.4.8 Mobile platforms 

This is a big one, and an area I don‘t think I‘m as qualified to discuss. Design for 

mobile devices is a difficult problem; there are so many devices, most with unique 

software and hardware, and it‘s the field with the most amount of movement. Perhaps 

these requirements would be clearer after some formulation of the above occurred. 

 

3.6.4.9 Non-scientific chart 

The x-axis shows how true-to-browser rendering ranges from approximate to actual, 

while the y-axis depicts the scope of centralized control over layout and type from 

local to global. The sweet spot lies somewhere at the intersection of browser-like 

behavior for—and widespread control over—type and layout elements, while 

providing a fertile environment for creative thinking. 
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3.6.5 Options for the future 

3.6.5.1  Why not design in the browser? 

By now you must be saying, “hey moron, just design in a browser!” Well, I half-

agree with you. In my section from a few years back about Fireworks I made the case 

for a new desktop app that could handle some of these functions. With how much 

things have changed in recent years, I‘m more inclined to suggest the way forward 

probably lies with the help of a browser. 

But I don‘t think the browser is enough. A web designer jumping into the browser 

before tackling the creative and messaging problems is akin to an architect 

hammering pieces of wood together and then measuring afterwards. The imaginative 

process is cut short by the tools at hand; and it‘s that imagination—or spark—at the 

beginning of a design that lays the path for everything that follows. Without it, you‘re 

at best able to make a website that looks like a website—rather than a design that tells 

a story in the form of a website. 

 

3.6.5.2  Can WebKit save us? 

I‘m asking for something that sits on the fence between all of this. I don‘t think any of 

the current desktop apps or any given browser gets the job done. They all do a pretty 

good job at a few things, but no single one does well enough to really make it a solid 

http://v3.jasonsantamaria.com/archive/2008/01/23/mucking_up_the_fireworks.php
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prospect. So why not build a desktop app for web design around WebKit? I‘m not 

talking about an in-browser AJAX toolkit for dragging elements around and changing 

fonts, but an actual desktop application built with WebKit as the core to its display. It 

could have accurate rendering and previews for the way page elements would look, 

but with some of the WYSIWYG tools desktop design apps have. We wouldn‘t just 

approximate pixels in a flat comp, our CSS would be baked in to the layouts we draw 

and create on the page. And as Webkit grows, so too could this new app, always 

taking advantage of the latest and greatest functionality. Just like a browser, it could 

pull assets from remote servers; and just like a desktop app, it could make use of local 

processing power and OS-level functionality. This would allow it to effectively 

combine some of the best of both worlds, with a foot firmly planted in the web. 

 

The advantages would be monumental, allowing a strong creative and explorative 

process, while seeing how things could react on a live stage. It would fulfill many of 

the items on my wishlist because these are already part of core browser functionality. 

We would essentially be designing with live page elements; not a picture of a text 

field—but a text field you could click into and start typing, and then drag to a 

different area of the page entirely. 

 

I know I‘m generalizing; I‘m a designer first and most certainly not a developer, but 

I‘ve been occupying this space and using these tools long enough to have a hunch for 

what works and what doesn‘t. An application like this could change the process of 

web design considerably. Most importantly, it wouldn‘t be a proxy application that 

we use to simulate the way webpages look—it would already speak the language of 

the web. It would truly be designing in the browser. 

 
 

3.7  Adding basic content 

3.7.1 Choose a site theme 

A good place to start when you are planning the overall look and feel of your site is to 

select a theme. The theme you choose controls the image that appears in the header at 

the top of each page. You can select from a variety of built-in themes for many 

industries, including automotive, finance, manufacturing, and real estate.  
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To select a theme, follow these steps: 

1. Sign in to Office Live Small Business. On the Home page, at the top, click 

Web Site. 

2. On the actions bar, click Design Site, and then, in the drop-down list, click 

Design site. 

3. Click Theme. A list of theme categories appears. 

 

4. In the drop-down list, click the theme category that you want. For each 

category, a list of images appears. 

5. Click the image that you want to use in your header. It is automatically 

selected and placed in the header on all of the Web pages on your site. 

 

3.7.2 Apply a style 

After you have chosen a theme that suits the purpose of your Web site, you can select 

a style. The style controls the placement of all elements in your Web site header. The 
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header elements that are affected by your style choice include the logo, theme image, 

and the site title and slogan. 

When you select the style, the header is reconfigured according to the definition of 

that style. For example, one style may show your logo as left-justified and another 

may show your logo as right-justified. 

 

To select a style, do the following: 

1. On the Office Live Small Business Home page, at the top, click Web Site. 

2. On the actions bar, click Design Site, and then, in the drop-down list, click 

Design site. 

3. Click Style. A list of styles appears. 

 

4. In the drop-down list, click the style you want to use. You can select different 

styles until you find the one that works for your site. 
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3.7.3 Use balanced colors 

Color arguably has the most immediate visual impact on your Web site. The color you 

select should correspond with the theme you chose and should also work well with 

your logo, if you have one on your site. If the color is out of balance with the other 

elements, a site can sometimes look unprofessional. 

 

Fortunately, it's easy to choose or change colors on your site. You can select colors 

and see what they look like with your theme and logo before you save your choices. 

 

There are several color choices for you to make. For example, one color is used for 

the background of the site while another color is used for the menus. To simplify the 

decision-making, Office Live Small Business groups all colors used on a Web site 

into color themes and gives them names that in some way describe the overall feel of 

the theme. The Ocean color theme uses mostly blue colors, for example, while the 

Mustard color theme uses mostly orange and brown shades. You can select one of 

these predesigned color themes, or you can create your own custom color scheme.  

 
3.7.4 Select a pre-designed color scheme 

To select a color theme for your site, do the following: 

1. On the Office Live Small Business Home page, at the top, click Web Site. 

2. On the actions bar, click Design Site, and then, in the drop-down list, click 

Design site. 

3. Click Color. 

4. In the drop-down list, click the color theme that you want. You can select 

different color themes until you find the one that works for your site.  
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3.7.5 Create a custom color scheme 

If you don't want to use one of the predesigned color schemes, you can create your 

own in Site Designer. 

1. On the Office Live Small Business Home page, at the top, click Web Site. 

Page Manager appears.  

2. In Page Manager, on the actions bar, click Design Site.  

3. In the drop-down list, click Design site. Site Designer appears.  

4. In Site Designer, click Color, and then click Create custom color scheme.  

5. In the Create custom color scheme dialog box, under Theme colors, a list of 

color groups appears. Click the color group name to expand the list of colors. 

The color groups are areas of your Web site where you can apply color — for 

example, Header or Body.  

6. Click an item in the list to select it, and under Select a color, select a color 

that you want for that item.  

7. To specify a custom color, click More colors.  

8. Under select a color, set the slider on the right to the hue that you want. On 

the left, click and hold the color selector circle, and drag it to the shade and 

saturation that you want. The hex number for the color you are currently 

selecting appears in the Hex box. You can also specify a precise color by 

typing the hex number into the Hex box.  
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Note: Note the Hex number of the color you select if you want to use it 

elsewhere on your site.  

9. Click Apply.  

10. Repeat these steps for each color group that you want to apply a custom color 

to, and then click OK.  

After you create your custom color scheme, it appears in the Color drop-down menu 

in Site Designer. You can switch between this custom color scheme and any of the 

predesigned schemes; however, you can have only one custom color scheme. If you 

create another custom color scheme, it overwrites the previous one.  

 

3.7.6 Choose the right font 

Another important visual element for your Web site is the font you choose for the 

content. You can select a font to use on all of the pages on your site, or you can pick a 

different font for different pieces of text. Applying a font to the whole Web site 

enables you to quickly and easily give the entire site a common look and feel, which 

typically is more attractive to site visitors. 

The fonts that you select should be applicable to the message you want to portray. For 

example, if you have a Web site that displays legal content, you would probably not 

want to use a font with a lot of embellishments, such as Trebuchet MS. Instead, you 

would use a font that is easy to read, such as Arial or Times New Roman. 

 Note:   Not all fonts render correctly on all Web browsers (for example, Windows 

Internet Explorer and Mozilla Firefox). The available fonts have been tested on a 

range of browsers to ensure that the text renders correctly, regardless of the browser 

that your site visitors use. 

To select a font for your site, do the following: 

1. On the Office Live Small Business Home page, at the top, click Web Site. 

2. On the actions bar, click Design Site, and then, in the drop-down list, click 

Design site. 

3. Click Font, and then, in the drop-down list, click the font that you want. 

There are several ways that you can add impact to the look and feel of your Web site. 

By making a few simple changes to the theme, the colors, and the font, you can give 

your site a professional and personalized look that will appeal to your visitors.  
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3.7.7 Add special background effects 

You can enhance the appearance of your Web site by adding a background image to a 

Web page or by adding a color gradient to the background of your entire Web site. 

 

3.7.8 Add a background image to a Web page 

A background image appears in the content area of the page. 

1. On the Office Live Small Business Home page, at the top, click Web site.  

2. In Page Manager, locate the page you want to add a background image to, and 

click Edit.  

3. On the Page Editor tab, In the Advanced group, click Page background.  

4. Select the Use background image check box.  

5. Next to the Image file box, click Select.  

6. In the Select an image box, under Choose images from, do one of the 

following:  

 To use an image that is located on your computer, select My 

computer. Click Browse for an image, locate the image that you want 

to use, and then click Open. If you want to optimize the image for the 

Web, select the Optimize my image check box. Then click Insert 

image.  
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Note: If you select this option, the image is converted to JPG (if it is 

not already in this format), and the JPG conversion quality level is set 

to 100%. The image is resized to a maximum of 640 pixels, 

maintaining its aspect ratio. These improvements help the image load 

faster in Web browsers. 

 To select an image that you uploaded to the Image Gallery, select My 

uploaded images. Select the image, and then click Insert Image.  

Note: For more information about the Image Gallery, see Add or 

remove an image. 

7. In the Page background dialog box, in the Position list, select the place on 

the background you want to position the image. If you want to tile the image 

on the page, in the Tiling list, select how you want it to be tiled. Click OK.  

 

3.7.9 Add a gradient color background to your Web site 

You can add a gradient to the background of your entire site. The background color 

will be the same on each page. 

1. On the Office Live Small Business Home page, at the top, click Web site.  

2. In Page Manager, click Design Site, and then select Design site.  

3. On the Site Designer tab, in the Advanced group, click Options.  

4. In the Site Options dialog box, under Display options, select Gradient in the 

drop-down list.  

Note: You can also select Flat color for a solid color or Blank for no color in 

your site background. 

5. Click OK.  

 
3.8  Working with XML data 

3.8.1 Introduction 

This section gives you an introduction to using DataSets and how to use them with 

XML files. Working with them really makes your life easier when you want to share 

data from a data source and you are thinking of XML. 

 

 

http://office.microsoft.com/search/redir.aspx?AssetID=XT102618811033&CTT=5&Origin=HA102375681033
http://office.microsoft.com/search/redir.aspx?AssetID=XT102618811033&CTT=5&Origin=HA102375681033
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3.8.2 System Requirements 

To compile the solution you need to have Microsoft Visual Studio .NET installed. To 

run any of the client executable you need to have the .NET framework installed. 

The sample provided is a simple application written in C#. It displays a form with a 

DataGrid. By default, the application connects to a SQL Server, binds the Northwind 

database and fetches some parent records from table Customers and some child 

records from table Orders. By default, the application assumes that you have an 

instance of SQL Server installed on your machine. If this is not the case, then you 

must manually modify the connection string and then rebuild the sample. 
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Then, you can save the dataset to XML file. Schema information is also saved. 

 

3.8.3 What is a DataSet? 

A DataSet object is a very generic object that can store cached data from a database in 

a very efficient way. It is member of the System::Data namespace. 

 

One obvious question is: When to use a dataset? Well, the answer is: it depends. You 

should consider that a dataset is a collection of in-memory cached data. So it's good to 

use datasets when: 

 You are working with multiple separated tables or tables from different data 

sources. 

 You are exchanging data with another application such as a Web Service. 

 You perform extensive processing with the records in the database. If you use 

a SQL query every time you need to change something, processing each 
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record may result in connection being held open which may affect 

performance. 

 You want to perform XML/XSLT operations on the data. 

 

You should not use a dataset if: 

 You are using Web Forms in your application because Web Forms and their 

controls are recreated each time a page is requested by the client. Thus, 

creating, filling and destroying a dataset each time will be inefficient unless 

you plan to cache it between roundtrips. 

 

A DataSet has a DataTableCollection object as a member that is nothing but a collection of 

DataTable objects. You declare a DataSet object and add tables to it like this (in 

Managed C++): 

 

Collapse 

  // Declare the DataSet object 

 

  DataSet* MyDataSet = new DataSet ("MyDataSet"); // give it a name 

here 

 

 

  // Add two tables to it 

 

  // - add a Table named Table1 

 

  DataTable* Table1 = MyDataSet->Tables->Add ("Table1");  

   

  // - add a Table named Table2 

 

  DataTable* Table2 = MyDataSet->Tables->Add ("Table2");  

 

You can refer the tables later either using the pointers returned by the Add method or 

like this: 

Collapse 
  DataTable* table = MyDataSet->Tables->Item[0]; // or  

 

  DataTable* table = MyDataSet->Tables->Item["Table1"];  

                                                  // isn't this 

indexation cool? 
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A DataTable object has two important members: Rows and Columns. Rows is a 

DataRowCollection object and Columns is a DataColumnCollection. 

DataRowCollection is a collection of DataRow objects and DataColumnCollection 

is a collection of DataColumn objects. I am sure you can easily figure out what these 

objects represent. :)  

 

Adding data to a data set is straight-forward: 

Collapse 
  // adding data to the first table in the DataSet 

 

  DataTable* Table1 = MyDataSet->Tables->Item[0]; 

 

  // add two columns to the table 

 

  Table1->Columns->Add ("Column1"); 

  Table2->Columns->Add ("Column2"); 

 

  // get the collection of rows 

 

  DataRowCollection* drc = Table1->Rows; 

 

  // create a vector of Objects that we will insert in current row 

 

  Object* obj[] = new Object* [2]; 

   

  obj[0] = new String ("Item 1"); 

  obj[1] = new String ("Item 2"); 

 

  // add them to the dataset 

 

  drc->Add (obj); 

 

If you want to specify the data type of a particular column you should use the 

DataColumn::DataType property. You can set any of the following data types: 

Boolean, Byte, Char, DateTime, Decimal, Double, Int16, Int32, Int64, SByte, 

Single, String, TimeSpan, UInt16, UInt32, UInt64. 

That's it! Well, that's all you have to do if you want to build up your data set 

manually. This is not how it is done if you want to connect to a real data source. 

 

3.8.4 Binding a Database 

To connect to a database server (such as SQL Server) and fill a dataset from there you 

need three additonal objects: a Connection, a DataCommand and a DataAdapter 

object.  
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The Connection object is used to connect to the database object. You must provide a 

connection string to it. Also, if your application is using transactions, you must attach 

a transaction object to the connection. 

 

The DataCommand object is used to sending commands to the database server. In 

includes four System::String objects named SelectCommand, InsertCommand, 

UpdateCommand and DeleteCommand. I believe it is obvious what these string objects 

represent, nothing else but the four basic SQL operations. 

 

The DataAdapter object is the object that does all the magic work. It fills the 

DataSet with data from the database and updates data from the DataSet to the 

database. 

 

You may now wonder what are the classes that correspond to the objects described 

above. Well, Microsoft have prepared two sets of classes - you can't say life is getting 

much easier in .NET can you? :). The first set is based on OLE DB and is part of the 

System::Data::OleDb namespace. It contains the following classes: 

OleDbConnection, OleDbCommand and OleDbDataAdapter. The other set of classes 

is optimized for working with Microsoft SQL Server. It is part of the 

System::Data::SqlClient namespace and its classes include: SqlConnection, 

SqlCommand and SqlDataAdapter. 

 

Here is a complete example of how to connect to the database and fill the dataset. I 

have used the classes optimized for SQL Server. If you need to use OLE DB you only 

have to replace "Sql" with "OleDb". We try to fetch two tables Table1 and Table2 and 

set a parent-child relationship between them. 

Collapse 

  // Create a database connection string 

 

  String* str = new String ("user id=sa;password=;initial 

catalog=MyDB;" 

                            "data source=(local)"); 

   

  // Create the database connection object 

 

  SqlConnection* sqlcon = new SqlConnection (str); 
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  sqlcon->Open (); // open it 

 

 

  // create the first SQL query 

 

  String* strTable1 = String::Format ("SELECT * FROM Table1 "  

    "WHERE Field1 = {0}", FieldID.ToString ());    // FieldID is  

 

                   // an interger used to filter our query. 

 

 

  // create the second SQL query. It joins the first table to select 

only those 

 

  // fields in relation 

 

  String* strTable2 = String::Format ("SELECT T2.* FROM Table2 T2 " 

                   "INNER JOIN Table1 T1 ON T2.ParendID = T1.ID " 

                   "WHERE T1.Field1 = {0}", Field1.ToString ());    

// FieldID is  

 

                   // an interger used to filter our query. 

 

 

  // create the SQL command objects. We pass in the contructor the  

 

  // SqlConnection object and the query string 

 

  SqlCommand* sqlTable1 = new SqlCommand (strTable1, sqlcon); 

  SqlCommand* sqlTable2 = new SqlCommand (strTable2, sqlcon); 

 

  // Create a data adapter for every table. We pass the SqlComand 

objects as parameters 

 

  SqlDataAdapter* Table1Adapter = new SqlDataAdapter (sqlTable1); 

  SqlDataAdapter* Table2Adapter = new SqlDataAdapter (sqlTable2); 

   

 

  // now we create the dataset object and we give it a name 

 

  DataSet* MyDataSet = new DataSet ("MyDataSet"); 

 

  // we inform the dataset object about the tables it is going to 

contain 

 

  // by adding those tables to the dataset.  

 

 

  DataTable* Table1 = BackupDataSet->Tables->Add ("Table1"); 

  DataTable* Table2 = BackupDataSet->Tables->Add ("Table2"); 

 

  // now we are filling the Dataset using the Dataadapter objects 

 

  // We need not say anything to the DataSet object about the  

 

  // columns of the table and their data type. The DataAdapter 

objects 

 

  // takes care of everything. 
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  Table1Adapter->Fill (Table1); 

  Table2Adapter->Fill (Table2); 

 

  // To ensure relationships between Tables we must add a 

DataRelation object 

 

  // We assume that between column 0 in Table1 and column 1 in Table2 

there is  

 

  // a one-to-many relationship 

 

 

  MyDataSet->Relations->Add (Table1->Columns->Item[0], 

                             Table2->Columns->Item[1]); 

 

For details about relations and constraints you should read about the Constraint 

class and the two classes derived from it, ForeignKeyConstraint and 

UniqueConstraint. 

 

3.8.5 Working with XML files 

DataSets can work with XML files very easily. There are two methods to serialize a 

DataSet object. These are DataSet::WriteXml and DataSet::WriteXmlSchema. 

The first one writes data to the XML file and may include also schema information. It 

is useful when you want to write an XML file that has schema information embedded. 

However, if you prefer schema information in a separate (.xsd) file you should use the 

DataSet::WriteXmlSchema method. 

 

There are also plenty of classes in the System::Xml namespace: XmlWriter, 

XmlReader, XmlTextWriter, XmlDataDocument to name a few. You can use those 

with a dataset to perform some advanced XML operations. For instance, if you want 

to write a dataset to an XML file you can either use 

Collapse 
  // recevies a DataSet in constructor 

 

  XmlDataDocument* xmlDoc = new XmlDataDocument(MyDataSet); 

  XmlTextWriter* Output = new XmlTextWriter ("C:\\Myfile.xml", NULL); 

 

  // perform some formatting 

 

  Output->Formatting = Formatting::Indented; 

  Output->Indentation = 2; 

 

  // and write it 

 

  xmlDoc->WriteTo (Output); 
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  Output->Close (); 

or use the DataSet::WriteXml method directly: 

Collapse 
MyDataSet->WriteXml ("C:\\MyFile.xml", XmlWriteMode::WriteSchema); 

In the latter situation I chose to embed schema information in the file by using one 

member of the XmlWriteMode enumeration. Other fields of the enumeration are 

XmlWriteMode::IgnoreSchema if you do not want to include schema information, 

XmlWriteMode::DiffGram if you want to include both original values of the dataset 

and any changes. For reading an XML file we use another enumeration: 

XmlReadMode. 

A DataRelation has a property named Nested. When this property is set to true 

then every time the DataSet will write a record of a parent table, it will also nest all 

corresponding records in all child tables. 

Formatting data in an XML file is very flexible. By default, a new element is created 

for every column in every table. Assuming you have a table named Table1 with two 

columns named ID and Name the default output of an XML file will be: 

Collapse 
  <MyDataSet> 

    <Table1> 

      <ID>7</ID> 

      <Name>name 1</Name> 

    </Table1> 

    <Table1> 

      <ID>8</ID> 

      <Name>name 2</Name> 

    </Table1> 

  </MyDataSet> 

If one column is to become an attribute of the node then you will set ColumnMapping 

property of DataColumn class. For that you must have a look at the MappingType 

enumeration. Its fields are: Attribute, Element, Hidden and SimpleContent. 

Choosing Attribute will write the corresponding column as an attribute of the parent 

node. The output will be like this: 

Collapse 
  <MyDataSet> 

    <Table1 ID="7"> 

      <Name>name 1</Name> 

    </Table1> 

    <Table1 ID="8"> 

      <Name>name 2</Name> 

    </Table1> 

  </MyDataSet> 

Simple Content means that tags for one column will not be written. If you chose 

Hidden then that column will not be written at all. 
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Of course you can combine them very easily. Doing this: 

Collapse 
  Table1->Columns->Item[0]->ColumnMapping = MappingType::Attribute; 

  Table2->Columns->Item[1]->ColumnMapping = 

MappingType::SimpleContent; 

will give you the following results: 

Collapse 
  <MyDataSet> 

    <Table1 ID="7">name1</Table1> 

    <Table1 ID="8">name2</Table1> 

  </MyDataSet> 

Reading from an xml file is just as easy as writing. The simplest options is to use the 

ReadXml method like this: 

Collapse 
  MyDataSet->ReadXml ("C:\\MyFile.xml", XmlReadMode::ReadSchema); 

 

I have read also schema information from the file. This means that the DataSet will 

automatically detect data type for every column in all tables in the dataset and also 

any constraints or relations between tables. This is really cool if you want to update a 

dataset. You change a value in the parent table and all child tables will have the parent 

value updated. Also, trying to change a value in a child table that does not have a 

parent value will throw an exception. 

 

3.8.6 Updating the Database 

Reading data into a dataset and then updating a database is just as easy as reading 

from a data source and filling a dataset. Assuming you are reading from an XML file 

and you are updating a SQL server, you must do the following: 

 Create the DataSet object and read the XML file. If your XML file contains 

any schema information then the DataSet will detect and create the 

corresponding tables and enable any constraints automatically. 

 Create a DataAdapter object for every table you want to update. 

 Call the Update method for every DataAdapter object. 

Remember that I mentioned four String members of the SqlDataAdapter class? 

These are: SelectCommand, InsertCommand, UpdateCommand and DeleteCommand. 

SelectCommand is the query used to fetch data from the database. You can define the 
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other three objects if you want to perform custom update/insert/delete operations. If 

you do not want to do that you can use either SqlCommandBuilder or 

OleDbCommandBuilderclass. This class will build those strings automatically. 

Whenever you are writing data to a database is good practice to use a transaction to 

prevent concurrent writes to the database. For this. the .NET framework provides two 

classes: OleDbTransaction and SqlTransaction respectively. 

Here is a sample of reading data from an XML file and the writing to a SQL Server. 

Collapse 
  SqlTransaction* SqlTrans; // declare a transaction object 

 

  try 

  { 

    String* str = new String ("user id=sa;password=;initial 

catalog=MyDB;" 

                              "data source=(local)"); 

     

    // Create the database connection object 

 

    SqlConnection* sqlcon = new SqlConnection (str); 

 

    sqlcon->Open (); // open it 

 

 

    // create the data set object and give it a name 

 

    DataSet* MyDataSet = new DataSet ("MyDataSet"); 

 

    // read the XML file 

 

    // I have also read the schema information file 

 

    MyDataSet->ReadXml ("C:\\MyXmlFile.xml", 

XmlReadMode::ReadSchema); 

 

    // Begin the transaction 

 

    SqlTransaction = sqlcon->BeginTransaction (); 

 

    // create the data adapters 

 

    SqlDataAdapter* Table1Adapter = new SqlDataAdapter("SELECT * FROM 

Table1", sqlcon); 

    SqlDataAdapter* Table2Adapter = new SqlDataAdapter("SELECT * FROM 

Table2", sqlcon); 

 

    // we have provided only the SelectCommand strings. To update 

 

    // the database we must provide the DeleteCommand, InsertCommand 

and 

 

    // UpdateCommand also. 
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    // This can be done automatically with the command builder 

 

 

    // create the command builders for each data adapter 

 

    SqlCommandBuilder* Table1Command = new SqlCommandBuilder 

(Table1Adapter); 

    SqlCommandBuilder* Table2Command = new SqlCommandBuilder 

(Table2Adapter); 

 

    // we must specify the transaction used by these adapter. 

 

    Table1Adapter->SelectCommand->Transaction = SqlTrans; 

    Table2Adapter->SelectCommand->Transaction = SqlTrans; 

 

    // update the database 

 

    Table1Adapter->Update (MyDataSet, "Table1"); 

    Table2Adapter->Update (MyDataSet, "Table2"); 

 

    // don't forget to commit 

 

 

    SqlTrans->Commit (); 

 

  } 

  catch (Exception* e) 

  { 

    // if we have started the transaction then rollback it 

 

    if (SqlTrans != NULL) 

      SqlTrans->Rollback();} 

 

3.8.7 Conclusion 

DataSets provide a very easy to use and powerful way to handle large amounts of 

data coming from different tables or even data sources. A dataset will cache all data 

making it useful when you need to read data, perform intensive operations with it and 

then update it. It also provides full XML support making your life easier to share data 

across applications such as Web Services. 

3.9 Summary 

In this unit we have discussed word on the web, XML, MSXML, XSLT, planning 

word website, creating main templates, building the site framework and adding basic 

context. We have also discussed the working with XML data. 

3.10 Self Assessment Questions 

1. Write Short notes on the followings: 

  a. XML 

  b. HTMA 
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c. Word processing Software‘s 

d. Freely available Web authoring Software 

2.  Develop a Webpage using MS-Word. 
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1.0  INTRODUCTION 

 

Web Hosting is required at the point where one has built and tested his website on his 

own computer and wish to make available his creation ―Live‖ on the web for the use 

of the masses. The process of making available a website ―Live‖ on the web is term as 

web hosting. The web is the whole brunch of interconnected computers interacting 

with each other. The computers (on the web) are typically connected by phone line, 

digital satellite signals, cable, and other types of data transfer mechanism. A ‗data-

transfer mechanism‘ is a nerd‘s way of saying: a way to move information from point 

A to point B to point C and so on. The computers that make up the web can be 

connected all the time (24*7), or they can be connected only periodically. The 

computers that are connected all the time are typically what is called a ‗Server‘. 

Servers are also like any other computer with one major difference, i.e. they have a 

special software installed called ―Server‖ software. 

 

If any one wants to share data, information & knowledge with the many 

people and communities on the internet, he has to own a piece of space in cyberspace. 

Web hosting empowers anyone with a computer and internet connection to own a 

piece of cyber space. In this space, one can have news, bulletins, documents, data, 

files (one‘s website) and his own post office (mail server) to accept mail. The 

computer (s) operating server (s) offer access to once files and post office for people 

on the internet to view his website and /or sent and receive e-mail with him.  

 

In this unit you will know about basic concept of web hosting, its importance, 

models and pre-requisites of web hosting. 
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1.1 OBJECTIVES 

 

After reading this unit, you will be able to :- 

 Get a clear concept of web hosting service. 

 Comprehend the wider understanding of various technical aspects related to 

web hosting service. 

 Get acquainted with the importance of web hosting such as web server, DNS 

service etc. 

 Get acquainted with the different models of hosting. 

 Identify the requirements of web hosting. 

 

1.2  STATIC WEBSITE VS DYNAMIC WEBSITE 

 

When approaching the development of a website we always have to make the choice 

between building a static or dynamic website. This choice is determined by type and 

purpose of the website, sometimes this choice is not obvious from the beginning. 

By static website we mean a website that doesn‘t have a content management system, 

hence every time something needs to be updated, such updates must be done 

manually by the person who manages the website. With dynamic website we mean a 

website whose contents are managed via a content management system that allows 

the administrator to add new content, modify the existing content, manage the various 

sections of the site and, generally speaking, manage everything without the need to 

manually edit the HTML files of the website. 

 

The reason for opting a static website is that developing a static website takes 

a lot less time than creating a dynamic one. To create the graphics for the website 

layout, build a HTML/CSS layout, duplicate it for every page and replace the content 

can be a very time and cost effective solution for short term projects and hence one is 

forced to develop a static website if there‘s no time to build a dynamic one.  

 

Static websites use less resource than dynamic websites, but dynamic websites 

have a wide spectrum of advantages that makes them come out ahead hands down 
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against static websites. Their management doesn‘t require a technical person: 

anybody can manage the contents of the website via a content management system 

that usually has an administration area from where the administrator can manage the 

contents displayed on the website. This makes a dynamic website cheaper in the long 

run because one need not have to pay when he want to update the contents. 

 

 

1.3  WEB HOSTING SERVICE 

 

Web hosting is a service (commonly referred to as web hosting service, hosting 

service) that allows once website to be accessible on the web. 

The web hosting company (web host, web hosting provider) provides space on 

one or more of his servers in order to make one‘s website reachable via the World 

Wide Web. 

A basic web hosting service makes your website available to the public as it is 

composed of static html files (the pages that compose one‘s website) and images. But 

most web hosting services deliver a more comprehensive packages such as advanced 

features like scripting languages support and databases. 

 

The possibility to use a scripting language (for example PHP, probably the 

most popular scripting language) in connection with a database management system 

e.g. MySQL or Postgre SQL, opens an extremely wide spectrum of possibilities. A 

scripting language allows one to develop dynamic website. Web hosting providers are 

connected to the internet via extremely fast connections and operate from buildings 

adapted Data Centers. Power interruptions are not a problem since such building have 

backup lines, uninterruptible power supplies and diesel generators in place that can 

keep the company‘s servers working for days in case of major outages. 

 

To sum up, web hosting is a service which makes your website available 

to everyone on the web. The service gives you space for your website on a server 

connected to the internet, with the possibility to execute software on the web 

server and store and retrieve data form one or more databases. 
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1.4  COMPONENTS OF WEB HOSTING ENVIRONMENT 

 

 

Important components that are required to make the cyber space workable in the web-

hosting environment are: 

 

Web Server 

 

The web server is a relatively simple piece of software that accepts requests 

over HTTP (Hypertext Transfer Protocol) and delivers HTML pages and Images files. 

 

FTP Server 

FTP is the means of which a web master can transfer files to and from the 

server. To put your HTML and image files on a server you will generally use FTP to 

upload (transfer to) your files to the server running the web server. 

 

Mail Server 

The mail server consists of two parts POP (Post Office Protocol) and SMTP 

(Simple Mail Transfer Protocol). POP is where email is received into your mailbox 

and SMTP is what is used to send and receive email between mail servers. 

 

 

 

Database Server 

 

If you are using server site scripting on your web server (like Microsoft 

Internet Information Server) then instead of providing static data only on web pages, 

you can provide data from a database allowing your users to search and view the data 

in different and dynamic way. Also, a Database server is used to gather data from 

visitors to your site; order, feedback, discussions and the like. 
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Each one of the above components is software programs running on servers in the 

web-hosting environment. You can interact with each of these with special software 

programs you use on your computer. The main ones being: 

 

Web Browser 

 

When viewing the web one uses a web browser like Internet Explorer. Many 

companies provide a Control Panel to administer one‘s web host account, which one 

uses with his web browser. Most companies allow one to configure most aspects of 

his account using a simple web browser. 

 

Web Site/Page Editor 

 

Today many web servers allow editing of WebPages over HTTP (hypertext 

transfer protocol) based on Microsoft FrontPage Technology. These special editors 

allow one to essentially look at his web site as if he was using a web browser and edit 

the pages directly as he sees them using WYSWIG (What you see if what you get) 

technology.  

 

FTP Client  

 

This is a very simple piece of software that allows one to view the server 

folders and files in his web host account as if they were files and folders on his own 

computer. He can then drag and drop files between his computer and his web host 

account. 

 

Email Client 

 

If you are on the Internet you would already be using an email client to send 

and receive your email. The most common are Outlook Express, Eudora and Web 

based mail clients like Hotmail. 

 

Database Administration Client 
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The most common databases used with web servers are Microsoft SQL Server 

are Microsoft SQL Server (available only on Windows) and MySQL (commonly 

found on Linux and UNIX but also available on Windows). SQL Server comes with 

its own administration client where you can view your databases, edit them, backup 

data and do all the administration functions you need. MySQL has an active online 

community where there is a range of administration clients available. 

 

1.5 WEB HOSTING CHOICE 

 

 

Web hosting plays a key role it‘s the service that makes your website available on 

the net, hence a reliable host is to be picked up in order to have your website up 

and running 24/7 without any thing to worry. 

In order to have a website which might not give an unprofessional impression, 

i.e. website which is not reachable, very slow or not properly working, one should 

carefully consider several website hosting service provider companies before 

picking one. 

A very important aspect to consider when choosing a web hosting company is 

customer support. When a problem arises on website you want it to be fixed as 

quickly as possible: you should always choose a company that offers 24/7 

technical support. The most preferred tech support method is the ticket system 

through which both you and the technicians have the full log of questions and 

answers, so as to easily understand and analyze to what other support employees 

could do for you. However sometimes 24/7 support is offered also via live chat or 

phone. The tickets are by far the best way to receive support because you don‘t 

have to explain everything again to the supports staff one has to talk to during the 

chat session or phone call.   

However, if anyone experience problems with his hosting company, switching 

to a new hosting provider is not difficult. Inspite of the fact that switching to a 

new web hosting provider is easy, one may not like to change the web hosting 

service frequently because it is not advisable to waste time and money in changing 
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host every month. It is for this reason picking a good hosting company that can 

keep a website running without the need for addressing and fixing a new problem 

is important.      

          

 

1.6  DOMAIN NAME 

 

 

A Domain Name is basically, a unique, easy to remember name composed of one or 

more parts and an extension, that allows visitors to reach a website. 

The Domain name makes it possible to direct all the requests to the correct IP 

address. A domain name is obviously unique, it‘s not possible to access two different 

website via the same domain name. When you type webhostingnerds.com you expect 

to see this website, no other sites will ever show up when you type 

webhostingnerds.com in the navigation bar of your browser. 

It is important at this stage to know what an IP address is. It is a unique string 

composed of numbers that uniquely identifies a system (a computer or a web server) 

on the internet. Your own computer or your internet routers have an IP address that is 

assigned by your ISP when you connect to the internet. 

A domain name must be easy to remember. Every website could be accessed 

using the IP address of the web server on which the website resides, appending to it 

the path to reach the appropriate directory on the server‘s file system: it means that 

you could access your website via 

http://123.456.789.277/~yourhomedirectory/path/to/website/ assuming 

123.456.789.277 is the IP address of the server. 

A Web server can host more than one website so there will be many domains 

pointing to the same IP address. The domain name and the DNS service work together 

to drive your request to the correct destination. Once the request arrives to the IP 

address, hence to the server, the web server software delivers the correct content for 

the website requested. 

If on the same server there are two website websitea.com with path 

IPADDRESSHERE/~joe/websitea.com and websiteb.com with path 

http://123.456.789.277/~yourhomedirectory/path/to/website/
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IPADDRESSHERE/~matt/websiteb.com, the web server (Apache, IIS, nginx, lighttpd 

or any other software) will deliver to the browser the content of the first one when it 

receives a request for websiteb.com. 

 

 

 

1.7  WHAT IS DNS SERVICE? 

 

DNS stands for Domain Name System: it is a hierarchical naming system for 

computers or devices connected to the internet. 

Its task is to translate domain names into numerical values associated with networking 

equipment connected to the internet: web Servers, network switches, network routers, 

firewalls, mobile devices etc. 

Every internet service relies on the domain name system: web, email, ftp, mobile 

services, everything. 

The importance of the domain name service is so strategic that needs to be extremely 

reliable: failure is not an option. In case of failure of the domain name system no mail 

could be delivered and no website could be visited. 

A failure in the domain name system would be a disaster, just imagine the number of 

services that wouldn‘t work: servers and communication wouldn‘t work in airports, 

stations, hospitals, banks etc resulting in delayed flights, trains, the impossibility to 

buy and sell stocks. Today‘s world depends on communication, and today‘s 

communication depends on the domain name system. 

 

1.8  MODELS OF HOSTING 

 

 

There are different models of hosting which can be used for hosting of a website. The 

different models have their own advantages and disadvantages and choice of a 

particular model for hosting a website depends on many factors such as cost, user‘s 

knowledge, website needs & desired level of control, flexibility & performance. 

Different models of web hosting are as under: - 
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Shared Hosting – Cost Effective, Easy to Use and Feature Rich 

 

Shared Hosting is the most common web hosting service in the market. In fact, a large 

majority of the websites one encounter online are running on this type of platform. 

Shared hosting is also called as conventional, regular or normal hosting. 

As the name implies, shared hosting is a service arrangement where you share 

bandwidth, disk space capacity and various network resources with other paying 

customers. The structure of this model equates into a low-cost solution that is 

typically easy to maintain for even the most inexperienced users. The economic value, 

simplicity and hassle-free aspect makes shared hosting a viable option for most 

individuals and small companies. 

 

Dedicated Hosting- The Utmost in Control, Flexibility, and Responsibility 

 

Dedicated web hosting is the exact opposite of the shared variety. Instead of sharing 

the server with other customers, the hardware is dedicated exclusively to your website 

needs. Since you are not forced to share resources, dedicated hosting can provide you 

with a superior level of control, flexibility and performance. This is an arrangement 

wherein you can choose your own operating system, install your own software 

applications, and incorporate the security mechanisms you feel will provide the server 

with the best protection. Unlike shared web hosting, dedicated hosting is not 

recommended for the inexperienced user. 

 

VPS Hosting – Immense Power and Great Performance 

 

A virtual private server, or VPS, represents a technology that is rapidly emerging in 

the web hosting industry. A VPS is created by software that partitions a single 

physical server to establish multiple virtual servers within it. Known as virtualization, 

this process results in a number of isolated environments with the ability to perform 

many of the same functions as an individual machine. 

A Virtual private server tends to provide more guaranteed resources, better 

performance and security than your typical shared platform at a price that is notably 
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less expensive than a dedicated server. With these factors in mind, many view a VPS 

as the perfect compromise between shared and dedicated web hosting. 

 

Managed Hosting – Hassle-Free but Costly 

 

In its most common application, managed hosting refers to the full servicing of a 

dedicated server. This service aims to alleviate the complexities and technical 

challenges of managing a web server. Though server management is the main feature, 

other options range from web application and database administration to monitoring 

and extensive support. Manage hosting services are geared towards customers who 

lack the technical abilities needed to handle a dedicated server, as well as those who 

do not have the time to fully immerse themselves in all the management aspects. 

Although cost efficient under the right circumstance, the biggest downside of 

managed hosting is its price tag, as it is considerable more expensive that other forms 

of web hosting. 

 

Reseller Hosting – Substantial Profit Potential 

 

Reseller hosting has emerged in recent time, providing entrepreneurs and small 

businesses with an opportunity to profit from the flourishing web hosting industry. As 

a reseller, you purchase a service plan from a hosting provider equipped with a certain 

amount of disk storage, bandwidth and feature. This gives you the ammunition you 

need to sell web hosting plans to customers looking to build their presence online. 

 

1.9 STEPS OF WEB HOSTING 

 

 

Prior to hosting a Website in the Cyber Space, one has to ensure that the Website to 

be hosted on the Web is properly designed.  To design proper Website it is 

recommended to hire a Web-designer.  Portfolio and skills of the Web-designer to be 

hired must be checked.  It must be ensured that a Web-designer knows how to use 

graphical programs such as Macromedia dreamweaver, flash, fireworks and 
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Abode Photoshop, Illustrator, Imageready, Indesign as well as knowledge of 

HTML, DHTML, CSS and Javascript.  If one has to carry on online transactions 

through his website, he has  to get a Web Designer  with knowledge of online  

Dastabases, PHP, MYSQL, perl, .net, HTML, Javascript and CSS. 

 

The first step towards his hosting a website is search for a Domain name 

(www.net4india.com).  The Domain name is an important part of one‘s website as 

this is the web address of his actual website.  One should not sign up the domain 

name until he finds a suitable hosting company.   

 

The next stage of web-hosting is signing up to Web-Hosting and Domain 

Company. At this stage, one should sign up to a Hosting Company which will also 

register his domain name.  Cost effectiveness is an important factor in signing up to a 

hosting company and one should look around and find the cheapest he can find.  One 

has to ensure also that the space offered by a hosting company at a reasonable cost 

can fit against his own website requirements. One should also explore at this stage as 

to whether a hosting company may give him a free domain name. After considering 

all these factors, a web hosting company is to be signed up and registration of domain 

name is to be done with the help of web hosting service. 

 

After signing up a hosting company and deciding about a hosting package, one has to 

upload the webpages of his website using a file transfer program, which can be 

downloaded for free or web hosting company may provide the same.  The web 

hosting company gives a user-name and password which one need to enter before he 

transfers the files online.  After transferring the files online, it takes about 24 hours 

before one‘s website is active and uploaded on the internet. 

 

The final stage in having a website is to advertise his website.  With this, the 

complete cycle of hosting of website is completed. 

 

It is not necessary that a website should professionally host. Sometimes people 

can host their website on the web themselves. It also allows the one‘s to save money 

and time. 
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In order to host a website on his own, one requires a computer & a high speed internet 

connection (DSL/Cable) and online 24/7 internet service provider. One has to follow 

the following steps to make his website available to users on the Internet. 

1. Installation of Web Server:- This is the first step in posting a website in cyber 

space. Most windows operating system either come with a web server or one 

can be downloaded free of cost depending on the version of windows. The 

web server is a program that runs in the background on one‘s computer 

listening to request from people on the internet. It is software that finds pages 

in one‘s computer and sends then the users requested him. 

2. Configuration of the web server:- In this step one has to tell his web server 

where to find his website i.e. sitting some where in his computer. 

3. Choice of a domain name. :- In this step one has to decide on the name that he 

want for his site and buy it from a service provider. A suitable domain name 

can be decided with the help of websites of the service provider. Domain 

names are usually cheap and one has to pay the fee only once a year. 

4. Configuration of DNS:- This step associate one‘s website name with the IP 

address of his computer so that users are transferred to his computer while 

typing the name of one‘s website. 

5. Configuration of Router:- One‘s router need to know about the computer that 

has the web page so as to know where to forward the users. This is being done 

by configuring the router. 

6. Dynamic IP Solution:- Mostly Internet Service Provider(ISP) gives a dynamic 

IP address. This means the IP address of one‘s computer might be change. 

This is a problem because DNS needs to know the IP address of the computer 

that people need to be forwarded while typing a domain name. There are 

applications that will automatically update DNS when one‘s IP changed 

without having to pay more money to the ISP. 

7. Securing your server:- This step to ensure that one‘s computer is protected 

from malicious programs on the Internet by having the necessary software 

installed and configured. 

8. Advertise your website: - The final step is to advertise your website. If one 

will not advertise his website then it will be invisible on the web. It is because 

of this reason one need to submit his website to search engine and ensure that 
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he has appropriate meta type keywords on his website and with in his content 

as this will attract the search engine to his website. One can also exchange his 

web links with other websites, this is called web exchange. One can also buy 

advertising space on selected websites. 

 

1.10  SUMMARY  

 

 

This unit begins with the brief introduction to the concept of web hosting. 

Differentiating Static and Dynamic websites, it deals with the purpose of hiring a web 

hosting company, components of web hosting environment, various database server 

softwares and factors to be considered while selecting a web hosting  company. It 

explains the task of DNS service. Domain Name is web hosting process. Different 

models of web hosting with their comparative advantages and disadvantages have 

also been discussed in this unit. This units ends with various steps to be followed in 

actual web hosting process. 

 

1.11  Self-check Exercise 

 

 

1) What is the difference between Static and Dynamic website? 

2) What do you understand by a ―Web Hosting Service‖? 

3) State the different types of ―Database Servers‖? 

4) What is the most important aspect while making choice for a Web Hosting 

company? 

5) What is the function of a Domain Name? 

6) State the basic functions of a DNS? 

7) Name the Conventional Web Hosting Model and its advantages over the 

Dedicated Hosting? 

8) State the factors to be considered at the time of signing up a Web Hosting & 

Domain Company? 
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UNIT 2  UPDATING WEBSITE & ARCHIVING WEB 

ELEMENTS 
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2.5.1.2 Search Engines 
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2.8 Keeping Track of Archiving 
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2.0 INTRODUCTION 

 

 Archiving is a process of moving the documents from one location in a 

computer Memory to another location in a compact format (or in a zip format).  

This helps in utilizing the active memory to store the currently active document 

in an organization .An Archive is a collection of computer files that have been 

packaged together for backup, to transport to some other location, for saving a 

way from the computer so that more hard disk storage can be made available. 

An Archive can include a simple list of files, or files organized under 

Directory. On personal computers with the Windows Operating System, 

winzip is a popular programme that allows one to create an Archive.  Winzip 

compresses the files that are Archive, but compression is not required to create 

an Archive.  A winzip Archive has the file name suffix ―Zip‖. In other words 

Archiving means to store important information for a long period of time in 

some recording media.  

Web Archiving aims to preserve selected sets of internet pages. Because 

the pages themselves are inherently impermanent – subject to degradation, 

obsolescence, malicious destruction, and inadvertent alteration or deletion, they 

are preserved by replication and by migration from outmoded formats to up-to-

date ones. The replicated pages are kept in entirely – with accompanying 

format files, graphic images, and the like – and are maintained on preservation 

computer servers in safe environments. Because no server or server 

environment can be made fully safe and because server storage is not costly, 

mirror sites are often used in widely separated geographic locations. Web 

archiving includes practices for the creation and maintenance of pages to be 

archived, an initial archiving snapshot of the entire web site, detection and 

downloading of pages as they change over time, and maintaining the servers on 

which pages are saved and insuring that multiple copies are saved. 
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2.1 OBJECTIVES 

 

After reading this unit, you will be able to:- 

- Get a clear concept of website updating. 

- Get acquainted with the website archiving. 

- Comprehend the wider understanding of selection for web archives. 

- Identify the selection process. 

- Get acquainted with the creating and maintenance of pages to be 

archived. 

- Get acquainted with the maintenance of the servers and keeping 

track of archiving.  

 

 

2.2 WEBSITE UPDATING 

 

 

In the process of making an archive up-to-date ness of the site is very 

important because if it is not up to date, it becomes obsolete. The process of 

updating the website is termed as ―Website Updating‖, but keeping the website 

up to date is a hard job. Updating your site by deleting or amending relevant 

information and adding new products is just as important as your initial 

website. 

If your site is not up to date it is out of date. Stale content is a major reason 

why visitors do not return to a site. Website updating is the thing that is usually 

given little thought in the rush to get a site live. Database driven and content 

managed sites are relatively straight forward to do. Simply make the required 

changes and the site is updated. But what about Flash sites. Flash has to be 
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'published' before it can be viewed over the web and these files cannot modify 

once published. A designer is needed to do the website updating. On standard 

HTML sites all the links throughout the site will need to be modified to include 

the new information or your visitors may not be able to find it making the 

whole process pointless. 

Websites are a complete representation of your business, project, 

promotion, or product. They are accessible 24 hours a day, 7 days a week. Out 

of all the promotional products and sales or promotion staffing available, 

websites are the one that works the hardest, and is the most directly controlled 

by the owner. With so many users able to access online websites from so many 

vantage points, such as handheld devices, providing up to date information 

ensures that they will bookmark YOUR site, and come back, again and again, 

because it is providing a valuable service for them. Even if they do not decide 

to buy, participate, sell, or contact you, the information you are providing to 

them about yourself has to be as up to date as possible. 

There is an expectation that websites will be constantly changing. If the 

content of your website remains static, users may not revisit it and you may 

lose opportunities to promote new products or services. Your website should 

look fresh and appealing, and promote an image of success and stability in 

order to attract and retain visitors. 

Keep the content as up to date as possible. If you have a news section or 

announcements about new products then it is vital that these remain current. 

User generated content can also help you understand what your customers want 

from your business. However, there are also some issues to consider - such as 

how you respond to negative feedback and the resources necessary to manage 

and monitor user content. 

If you have old news stories that you feel will be of interest to your visitors, 

then place them in an archive and allow this to be searched by interested 

parties. Ensure that all the photos on your site are recent and include only your 

current staff. 
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2.2.1 Notification for Updating Website 

 

 If updates to your website are intermittent, remember to change the 

notice on your website stating when the site was last updated. Consider also 

sending out an email alert to subscribers to let them know that updated content 

is available. Frequently updated content will encourage visitors to come back 

again. 

 

 

 

2.2.2 Reasons for Updating Website 

 

a) It shows that you are hands-on and directly involved in what you are 

representing on your site. 

b) Current information and up-to-date knowledge gives your audience 

something to look for on your site, and reminds them of what you represent 

every time they look through it. 

c) Awareness and adaptability go hand in hand. If you expect to be able to 

show what you are about in a constantly changing world, be prepared to be 

aware and adapt. 

Your website includes every aspect of the face of your business or project. The 

needs of your clientele will be varied, and your website provides knowledge to 

help them make a discriminating decision about your product or service. As 

your clientele's needs change, so should the content of your site; it shows you 

have a finger on the pulse of your industry and business. It demonstrates 

loyalty to the ever changing face of your clientele, and provides them a sure 

sense that you care about satisfying the constant demands you are meeting. 

If you are involved in a project or promotion, daily updates give your public 

news about what is happening, and will changing news, people like to talk 
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about what is new and upcoming; they are much more likely to share what they 

have seen if it is something that gives a new twist or look. A fresh perspective, 

even on facts and dates and times that have already been presented, gives your 

public's eyes and ears a mark they will not forget. Website is the most succinct 

and convenient method of public access to your information; why not capitalize 

on the power of word of mouth, which is the least expensive form of 

advertising? The reach or your message should never be underestimated. Once 

your site has caught someone's eye, you can be sure that they will be back to 

look at what is new! 

 

 

 

 

 

2.3 TOOLS FOR UPDATING WEBSITE 

 

 (i) Composer - an easy way to make changes to a web page  

The Composer is included with the SeaMonkey web browser (it 

used to be part of the Netscape and Mozilla web browsers) which can 

be downloaded for free to your computer from SeaMonkey. It is an 

easy-to-use HTML editor which lets you see the page pretty much as it 

will appear in a Browser while you make your changes. This is known 

as a WYSIWYG editor which stands for "What You See Is What You 

Get." If you plan to make simple changes to the text in your web page, 

then you can use Composer without even having to learn HTML. 

(2)FTP and FTP_commander - moving files to and from your site  
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In order to move files to and from your site with ease I 

recommend a program called FTP_commander which can easily be 

downloaded for free from the web. It gives you a windows explorer-

like interface to your site with two windows. The one on the left is 

your local computer and on the right is the web. You change directory 

to your local folder for your site on the left by clicking in the same 

way you are used to using with Windows Explorer. Click on C:/ and 

the the makeDir button above to make a new folder for your web site. 

You might call it by your website name. Then click on that folder and 

make another folder called by the date so Sept2010 for example. Do 

this each time you make a new backup. That way you have a history of 

what your site looked like.  

To set up FTP commander to access your site you need to know 

your username and password. Click on the new server button and enter 

your URL, username, and password in the appropriate little boxes on 

this window. Name it something you will remember like your actual 

site name. Then click OK. Once this is done, whenever you start up 

FTP_commander your site name will appear in the server list on the 

right. Now when you double click your site name, you will be 

connected to your site. After a pause of a few seconds, (note all the 

messages explaining what is happening on FTP_commander bottom 

bar) the filenames of all the files on your site will appear in the right 

window. Also if you have any subdirectories, those will appear with 

little manila folder icons just like they do in Windows Explorer. If you 

double click a folder, the right window will change and display the 

contents of that folder. To go back up to the main directory, double 

click the little up arrow icon at the top of the list of files. Note that if 

there is a folder called public_html or www that is where the files for 

your actual web site are located. 

http://www.internet-soft.com/ftpcomm.htm
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The first thing you want to do is to move a copy of all the files 

from your web site to your local pc. Highlight every file in the right 

window (hold the control key while you click on each one of them to 

do this) and then click the arrow that goes from the right to the left. To 

upload a file that you have changed, select it on the left and then click 

the arrow that points to the right. 

(3)XENU - checking all the links on your site  

One of the things you must do weekly (or monthly) is to check 

all the links on our site to make sure none are broken (e.g. clicking on 

them gets a 404 error or no response at all). Not only are broken links 

on your site annoying to your users, but they will cause search engines 

to downgrade your site, a very undesirable result. 

XENU is a free package to check all your links. Download it 

and use it regularly. When an internal link is broken, if you can't figure 

out easily how to fix it yourself, send me an email with the cut-and-

pasted XENU complaint about it. When an external link is broken, try 

to find the new site using Google or your own favorite search engine.  

 

(4)Adobe Photoshop and Photoshop Elements  

If you need to work with images, you probably want to have 

Adobe PhotoShop. Most serious web designers use the Professional 

version but Photoshop Elements has more than enough for the small-

time web site. The best feature of Elements for these purposes is the 

ability to save optimized images for the web in either GIF or JPEG 

formats. Note that GIF lets you use fewer colors which is an efficient 

way to save simple graphic images with a small number of colors. 

Photographs should usually be saved in optimized JPEG format. It 

http://home.snafu.de/tilman/xenulink.html
http://www.adobe.com/products/photoshopel/main.html
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even shows you the new and old sizes and expected download times 

on a high speed modem.  

(5)ThumbsPlus  

If you need to make photo album type pages of your images, my 

favorite tool is ThumbsPlus from cerious.com. It has a web page 

wizard that will make pages of your selected images where you can 

select the background colors and thumbnail sizes and create just the 

page you want. It also is a very nice way of looking at directories of 

photographs and has a tool to quickly rotate them (when you held your 

camera sideways) among other goodies.  

(6)HTML-kit, Arachnophilia - free text editors designed for HTML  

There are a number of good free HTML text editors available 

on the web. What they give you is the ability to modify the text and 

codes with the normal features of a word processor, buttons for bold 

and italic, search and replace, as well as buttons to help you make a 

link or insert an image easily. My preferred editor is HTML-kit which 

has a handy HTML code checker (F9) as well as buttons for most of 

the things I need. It even has a function called "Strip Surplus Tags in 

Word 2000 pages" which is very useful on converted documents.  

(7)Microsoft WORD - converting existing documents  

Microsoft WORD has the ability to edit HTML files, however it 

has the unfortunate tendency to redo the formatting and add extra 

codes. Therefore this is not the way I recommend working with 

existing web pages. It is however the way to convert word processor 

documents to web pages. 

http://www.cerious.com/
http://www.chami.com/html-kit/download/
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WORD documents can be saved as HTML from the WORD 

file menu "save as Web Page" (WORD 2000) function or "save as 

HTML" (earlier versions of WORD) function. This means that 

documents can be easily written out in HTML format from WORD.  

 

2.4 WEB ARCHIVING 

 

Web Archiving is a process of collecting portions of the World Wide 

Web and ensuring the preservation of collection in an archive for future 

researcher, historians and the public. Due to the massive size of the web, web 

archivists typically employ web crawlers for automated collections.  Web 

Archivist generally archive all types of web content including HTML, web 

pages, style sheets, java script, images and video.  They also archive Metadata 

about the collected resources such as access time, MIME Type and content 

length. This Metadata is useful in establishing authenticity and provenance of 

the archived collection. The most common web archiving techniques used is 

web crawlers to automate the process of collecting web pages.  Web crawlers 

typically view web pages in the same manner in which users with the browser 

to see the web and therefore provides a comparatively simple method of 

remotely harvesting web content. 

Web crawlers which are frequently used for web archiving includes:- 

 Automated Internet Sessions in biter scripting  

 Heritrix 

 HTTrack 

 Wget 

 

 

2.4.1 DEFINING A SELECTION POLICY 
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The selection phase is a key phase in Web Archiving. It takes place 

at the beginning of the entire cycle and has to be re-iterated on a regular 

basis. Preceding the capture phase for which it provides input and 

guidance, it comes just after the archiving and access phase ideally 

taking into account issues and necessary changes.  

The selection policy is the mark of each archiving institution. 

Choices made in this domain determine the type, extend and quality of 

the resulting institutions‘s collection. But simply applying method and 

practices developed for selection of printed material is not adequate. 

Web publishing is different enough from traditional publishing to 

require a wide revision of existing practices in this domain. 

Building collections of Web material requires, when it becomes a 

regular activity, a general guiding document that defines the collection 

development policy. The benefits of defining such a policy for 

archiving institution are the same as for printed material. 

- It reduces personal bias by setting individual selection decisions in 

the context of the aims of collection building practice; 

- It permits planning and identifies gaps in collection development 

and ensures continuity and consistency in selection and revision; 

- It helps in determining priorities and clarifying the purpose and 

scope of each individual collection, and allows selection decisions 

to be evaluated by, for example, identifying what proportion of in-

scope published material has been acquired; 

- It can serve as a basis for wider cooperation and resource sharing. 

 

2.4.1.1 TARGET AND COVERAGE 

A collection development policy should describe at a high level the 

goal driving the collection development. This comprises a description 
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of the context, the targeted audience, the type of access, and the 

expected use of the collection. 

The collection‘s target, that is, the content to be archived, should 

be described in this context in general terms. This can be refined by 

defining inclusion‘s and exclusion‘s criteria. These criteria can be on 

quality, subject, genre, publishers like in traditional selection. An 

importance difference to keep in mind for criteria adoption is their 

applicability on the web. 

 

2.4.1.2 LIMITATIONS 

Whereas traditional acquisition policy had mainly to deal with 

financial limitations (for acquisition, processing, or storage),  web 

archiving is also directly and permanently hindered by technical 

difficulties for capturing content. Different types of technology 

challenge current capture techniques: the hidden web, streaming 

content, highly interactive content etc. 

 

2.4.1.3 GATHERING PATTERNS 

Building web collection can either be done on a continuous basis 

or through campaign or snapshots. 

 

2.4.2 ISSUES AND CONCEPTS 

2.4.2.1  Manual vs. Automatic Selection 

A recurrent theme in the literature on web archiving is somehow 

simplistic opposition between manual selection and bulk automatic 

harvesting allegedly considered as unselective. The former is 

misleadingly supposed to be purely manual whereas the latter is 

similarly falsely considered as comprehensive. Web archiving always 
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implies some form of selectivity, even when it is done at large scale 

and using automatic tools. 

Manual Selection of Web documents rarely happens without 

requiring utilization of automatic discovery tools like search engines. 

And even in the case where discovery would entirely be done 

manually, capture is most of the time done with tools based on link 

extraction. 

 

 

2.5  SELECTION PROCESS 

 

Whatever criteria are used for manual or automatic selection, it is 

necessary to document carefully the selection process. Web archiving 

can only achieve sampling of instantiation of content. As time goes, the 

original context of the sample is lost and no clue will remain for 

researches to understand what the archive represents. To limit this, it is 

absolutely necessary to document each aspects of the selection process 

in order to provide elements of assessment for the future. This has to be 

done for the various phases (Preparation, discovery, and filtering). 

 

For the preparation phase, the main aspects to document are: 

- The target; 

- The capture policy and infrastructure (this comprises the 

technical capacity, software used, priority, politeness etc.); 

- The tools used (name, regularity and context of use, staff, etc.) 
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This Selection is a key issue for Web Archiving. Manual Selection 

can prove useful for a specific community and/or goal, where high-

level assessment of items is necessary. 

 

2.5.1 Preparation 

This phase is a key for the success of the whole process and should 

not be underestimated in terms of time as well as resources required to 

perform it successfully. The main objective of this phase is to define 

the collection target, the capture policy and the tools for implementing 

it. 

The preparation phase also requires defining which tools will be 

used during the discovery process. Four categories of tools can be used: 

 

2.5.1.1 Hubs 

 

Hubs can be global or topical directories, sites or even single pages 

with important links relevant to a given subject. These hubs are 

maintained by human, and often provide a valuable source for 

identification. Their reliability, freshness as well as their coverage has 

to be assessed on a periodic basis. When possible, direct contact with 

the person(s) in charge of a hub can be fruitful to better understand how 

their input can be used. Monitoring these hubs during the capture 

campaign as it necessary to ensure, they remain relevant and exploits 

their input. 

 

2.5.1.2 Search Engines 
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Search engines can facilitate discovery of relevant material as long 

as precise enough query terms can be defined. Utilization of specialized 

search engines, when possible, can greatly improve relevance as well 

as, sometime, freshness of results. When the topic is closely related to a 

specific event, one should expect search engines to find relevant 

information only with a certain delay, which limits their usefulness in 

this type of capture. 

 

 

2.5.1.3 Crawlers 

 

They can be used to extract links from already known material in a 

systematic manner.  

 

2.5.1.4 External Sources 

 

Non-Web sources can be anything from printed material to mailing 

lists etc. That can be monitored by the selection team. They should be 

used when possible as they often provide fresh resources as well as 

different directions for the collection. 

2.5.2 Discovery 

The main goal of this phase is to determine the list of entry points 

that will be used for the capture as well as the frequency and scope of 

this capture. It should be noted that there is a quite clear cut distinction 

between discovery and the crawl itself for collection done manually.For 

automatically built collections, this difference is blurred by the fact that 

most of the discovery occurs during the crawl itself by links extraction. 

2.5.3 Filtering 
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The filtering phase‘s main goal is to reduce the space opened by 

the discovery phase to the limits defined by the selection policy. 

Filtering can be done either manually or automatically. Manual 

Filtering is necessary when criteria used for the selection cannot be 

directly interpreted by automatic tools. This can be the case when high 

level characterization, subjective evaluation, and/or external knowledge 

is needed. 

It is also important to define the appropriate level at which manual 

filtering has to occur to avoid duplicate evaluation. 

Several evaluation axes can be used, alone or in combination, for 

manual selection: 

2.5.3.1 Quality 

This comprises an appraisal of authority and credibility for 

secondary resources and relevance and authenticity for primary 

resource. 

 

2.5.3.2 Subject 

A subject can be delimited along the traditional scholarship 

discipline e.g biology, geology, etc, or according to a specific event, 

person or organization, or any object in general, which will be 

envisaged form various points of view. Hence, primary as well as 

secondary websites are to be considered for inclusion in the selection 

policy. 

 

2.5.3.3 Genre 

Web genre is institutional website, blogs, personal pages, forums 

etc. This can either be the main selection criteria for genre studies or an 

additional criterion. 
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2.5.3.4 Publisher 

Traditionally publishers reputation or specialization have been 

used to guide selection of printed material. It is often difficult to 

determine the publisher of a website and only very regulated top-level 

domains TLDs offer homogeneity of publisher‘s type. 

 

2.6 CREATION AND MAINTENANCE OF PAGES TO BE 

ARCHIVED 

 

Best practices for pages to be archived should be able to cope with any 

valid code for internet pages. In practice, however, it is highly desirable for 

pages to observe standard practices for accessibility, for separation of content 

and presentation, for Meta tags to consistently describe contents, and for 

insuring content integrity. Formats and contents that hinder access by people 

with disabilities should be avoided.  The XHTML format is preferred to 

HTML. Formatting via linked style sheets is preferable to formatting by tables 

or other outmoded means. A full set of preservation meta tags should be 

present on each page. Policies should be written for assuring content integrity. 

Content management systems offer a relatively easy and effective means 

for creating and maintaining web site and the pages they contain. Because they 

foster consistency and adherence to standards, they have especial value where 

the pages are to be archived.  

A snapshot is the starting point for an ongoing web archiving program. 

Either manually or using a snapshot tool, the manager of a web site copies the 

entire site, preserves its organization and all contents, and transmits the 

resulting files to the web archive servers. A snapshot is thus simply a faithful 

replication of the site as it existed at a particular point in time. 



 

 
233 

Web archiving involves the detection, capture, and storage of all types 

of web content including HTML web pages, style sheets, javascript, images, 

and video. If meta tags for the pages are kept in separate files rather than in the 

pages themselves, they are included as well. Web archivists also create and 

store metadata about the collected resources including time and date of 

collection, extent of pages collected, and encoding protocols used for 

transmission. These meta tags help assure the authenticity and provenance of 

the archived collection. 

Although the pages to be archived can be manually saved and mirrored, 

it is best if the web archiving process is as automated as much as can be 

managed. The most common automated archiving is achieved by a process 

called web harvesting. Web harvesting software includes crawlers, intended for 

by large-scale operations such as the Internet Archive. 

 

2.7 MAINTENANCE OF THE SERVERS  

 

Servers are both hardware and software. The term encompasses the 

computers on which data files are stored, the operating systems of those 

computers, and the software for interacting with the data files. Server 

maintenance is mostly a matter of common sense. The server environment 

needs to be maintained as to the hardware and software. There should be a 

maintenance policy for regular surveys to assure that everything is working 

properly. Because the data files and the magnetic media that house them are 

inherently instable, web archives should be mirrored to at least one other site. 

Mirroring software can be used for automatic replication of web archives. 

Web archiving does not include the practice of backing up the code of 

web pages as they are created and updated, but it assumes that this backing up 

takes place. Preferably there should be two or more backup copies of the entire 

website as it is made and altered. The backups should not all be on the same 

computer; at least one should be on a portable hard drive, backup tape 
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cartridge, network-accessible server, or set of CD-ROM disks, and these 

external locations should be sustained in accordance with archival best 

practices.  

 

2.8 KEEPING TRACK OF ARCHIVING 

 

A Web archiving program should include documentation of policies, 

guidelines, and standards.  

Policies, procedures, guidelines, and standards can be formal or 

informal, published on a web site or kept in a notebook, maintained in draft or 

formally disseminated, but whatever form they take, they should be prepared. 

As with general archival policy statements, it is probably best to view them as 

works in progress, being constantly updated as time allows and circumstances 

dictate. 

 

2.9 SUMMARY 

 

This unit begins with the brief introduction to the concept of updating 

and archiving of website. It deals with the selection for web archives, 

defining a selection policy and issues and concepts. It explains the selection 

process such as preparation, discovery and filtering. Creation and 

maintenance of pages to be archived have also been discussed in this unit. 

The unit ends with keeping track of archiving. 

2.10 SELF-CHECK EXERCISE  

 

1. What do you understand by a website updating? 

2. What is web archiving? Explain the selection for web archives? 

3. Explain the selection process of web archiving? 

4. Writ short note on the following? 
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i) Creation and maintenance of pages to the archive. 

ii) Maintenance of the servers 

iii) Keeping track of archiving  

 

 

 

 

 


